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Appro val Routing  – Req  Subs id iary Forms  
This feature extends sequential approval and approval routing support for req subsidiary forms. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes ¨ No – requires specific conditions / configuration for visibility. 
þ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
þ Specific conditions required – see details below. 
¨ Configuration required – contact your CSC for implementation details. 

Feature Description 
Sequential approval with approval routing is now supported for Req subsidiary forms in 2xB as well as on mobile 
devices for 2x Mobile®.  

The following figure shows a sample approval section for a user adding/editing a req subsidiary form configured 
in Workbench for sequential approvals. 

 
To support this feature, a new Form Approval column appears in the req subsidiary form grid when viewing the 
form. The column appears regardless of whether sequential approval has been enabled or not, though it is 
empty when not enabled. 
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Users cannot delete a req sub form while it is pending approval. 

How Do Clients Get this Feature? 
This feature is controlled by Workbench req sub form attribute and 2x Mobile field settings in Workbench. 
Please contact your CSC or Certified Workbench User for more information. 

Workbench Self-Service Certified Users 
You enable approvals for a req sub form in Workbench via Edit form attributes, with an option to select 
sequential routing.  

You also configure the req subsidiary form fields that support approvals for mobile devices in Workbench, via 
Define mobile display fields. (Process is identical to candidate form field approval selection.) 

To enable approvals: 

1. Select Tools > Forms > Reqs > Req subsidiary forms > Add new form / [select form] Edit form 
attributes  
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2. Select Sequential, and Single per req (only Single per req forms are allowed with approval routing). 
3. Save the form. 
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4. Next, select Tools > Forms > Reqs > Req subsidiary forms > [select form] > Edit form approvals. 

 
 

5. Complete the approval options and save the form. 

To configure mobile device fields: 

1. Select Tools > Forms > Reqs > Req subsidiary forms > [select form] > Define mobile display fields. 
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2. On the Define Mobile Display screen, select fields to display for approvers from the active fields, and save.   
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Automation  Manager – Notifying  Recru ite r o r Hiring  
Manager 
Workbench Administrators can now select an auto-fill form field where the source is the standard req Recruiter 
or Hiring Manager field for Automation Manager (AM) trigger notification emails. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Automation Manager 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
New functionality allows the Workbench Administrator to select a an auto-fill form field where the source is the 
standard req Recruiter or Hiring Manager field for Automation Manager (AM) trigger notification emails. 

These fields are available for the following Automation Manager trigger types: 

• Assessments 
• Candidate HR Status - send Talent Record 
• Candidate HR Status Aging 
• Disposition Hired Candidates across all Requisitions 
• HR Status update - notify candidate 

For all other Automation Manager Trigger types, the field and field label and Select box are hidden. 

How Do Clients Get this Feature? 
This feature is enabled in Workbench. Please contact your CSC or certified Workbench Self-Service user for 
more information. 

Workbench Self-Service Certified Users 
To configure the Recruiter or Hiring Manager auto-fill form fields in Automation Manager: 

1. In WB Select Tools -> Automation Manager > Admin > Add new trigger/Edit Trigger > Configure 
Notification tab 
Where trigger type can be: 

o Assessments 
o Candidate HR Status - send Talent Record 
o Candidate HR Status Aging 
o Disposition Hired Candidates across all Requisitions 
o HR Status update - notify candidate 
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2. Select the Configure Notifications tab.  
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3. Select the Users selected in form fields… checkbox in the Select Recipients area and click Select >> .  
The Search for Form fields dialog box displays. 

 
 
4. Select the desired recipients. Automation Manager will send the communication to the user selected on the 

form with the auto-fill field. Any changes to the user on the form after being auto-filled will be picked up, so 
the most “current” user will be the one to receive the communication. 

5. Click Submit. 
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Accessing the Services  
This section describes the addresses for the services used by the Candidate API features. Clients need 
to be provided with a shared key that Kenexa creates. Your Kenexa consultant should submit a 
maintenance ticket s to the 2xB Integration team requesting the creation of the key. 

Message Router Addresses 
The message router addresses you need to invoke to get search results are as follows: 

Staging Environment: 
http://stagingimport.brassring.com/WebRouter/WebRouter.asmx 
 
Production Environment: 
http://Import.brassring.com/WebRouter/WebRouter.asmx 

Web Service Description Language Paths 
The Web Service Description Language (WSDL) paths for message router web services are as 
follows: 

Staging Environment: 
http://stagingimport.brassring.com/WebRouter/WebRouter.asmx?wsdl 
 
Production Environment: 
http://Import.brassring.com/WebRouter/WebRouter.asmx?wsdl 

 
 

Example XMLs 
This section provides examples of the full Encrypted and Decrypted Request XML along with specific 
request and result structure for the various defined methods. 

Sample Encrypted Request XML 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <!-- Valid id of an Enterprise (KRB) user.  To be provided by our implementation team --> 
  <Id>4873</Id> 
  <!-- Encrypted string to identify the client.  To be provided by our implementation team --> 
  <Credential>1sU9JELZ8z9tPsHw8FDjyw==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="data"> 
  <TransactId>11/17/2008</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
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 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData xmlns="http://www.w3.org/2001/04/xmlenc#" 
Type="http://www.w3.org/2001/04/xmlenc#Element" Encoding="utf-8"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <!-- KeyName to be supplied to client by our implementation team --> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <!-- CypherValue consists of 16 bytes of iv factor, plus AES encrypted string (Unit node in 
clear text example) --> 
    <CipherValue> 
eGNLQUd4dzB2UDgzWlJUbDIxWDFUdz09anY0Lzc5R2ZqUXpjemEra2FCc3FFZENPSVJkcXdMOWtER1Yvcj
V4TDdDVjRpOTJNeW1HVWlQNFYyRW4zSVUrdklLYUdwTFErcTduMU9aaEd0U1p6M3JldDZidDdrRVRFOXg
2STEvdlMvUEI5T3VEbU1WMmxPSTU0M1RCRmJ4dzRxRWtJNStCNElsQUlIcVVoTncvSlFacDJkZ05la083MS
8rbjkzNkoxSEFxMkdmZGxHeUVINzB3TVUxYXo1dWFTYWtIK2RwbERPcm5BQTBHU2dBeDE2YklpdUFiMXR
3Q1BlTjBWVEJBSnFMS3BYSElTaFRpUXplSHY2QjRnUU5nUnpYSjhtNldaVitzeU1TM1diU1VPa2s5L3BQNm5
LbnczczRMY2NIZDJYbkVrdDZ1RXd1S3dGS1A5YjZ2SFlwYnRmMUcwTEpKS1IwamthWkRENWpaejV1Y1Rsa
GhFS3NJOE5LU1lhNDRLVElUUzV5ajRtOW9UZWZmYitaYnpKQ2RTRU1Zc1pFM09ESithTWlNSVYzdUFRUT0
9</CipherValue> 
   </CipherData> 
  </EncryptedData> 
 </Unit> 
</Envelope> 

Sample Decrypted Request XML 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>10540</Id> 
  <Credential>11721</Credential> 
 </Sender> 
 <TransactInfo transactType="data" transactId="075cbfe6-b9dc-49f9-8f12-8eae62b62055"> 
  <TransactId>10/24/2008</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="AuthenticateTGUser"> 
  <Packet> 
   <PacketInfo packetType="data"> 
    <packetId>1</packetId> 
   </PacketInfo> 
   <Payload> 
    <InputString> 
     <ClientId></ClientId> 
     <SiteId></SiteId> 
     <Username></Username> 
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     <Password></Password> 
    </InputString> 
   </Payload> 
  </Packet> 
 </Unit> 
</Envelope> 

Full Encrypted Results XML 
<?xml version="1.0" encoding="utf-8"?> 
<!-- edited with XML Spy v3.5 NT (http://www.xmlspy.com) by  () --> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="c67f4099-52ba-4343-8daf-065b654abbef"> 
  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
   
 <CipherValue>R2syOUNqVGlHelpPM0ZWZUpLUW8rZz09MWNIaWd3eDlPOHhSTE1LaGNQSGZRUVN5
SmVPRUZORW1hTm1WOS8vSVFMdXRtWkk4TlZvU2hCUlo4RzA0dlFTcW9PQ2x0NUhGYVUwWVZlWkYwd
2YxcnRIZ01IcFNGNzEveG1zRExrM0RPbHhySFBFdytENDdBRUJzQnRiSW5tczc0eitWRXc0czFvVVg4aC94dF
dKSGdGM1liVUZwWkltQ2I2Y2hya1hIclRlWEk2RXlnaVJDM2FlUVpLMzBLZXF2d29EK0NneFpEQ055Z3NiTV
NSTU85d1BwTFZ3ZldKRDVSclArS0NndXFqZDZvY2NQd2hwalFpODloQTd1d25FQi9aWjN4cnMwVUp3KzVt
U3lUeXZ4R2hWYjVoUCtHL3ZsOVVJejBTQm5qbjRac1Jvcjd0MVVzVmQ5U1FRZ3p6Tmd5RVFhTGRreTBTen
dYWEpYalhQRVRZWjdHMXN2NVZ4UG1GaWw1Z3JsTHRFbzMxVndMUk1na3o2N2xWZjVnL0U2cEVOZ3N
LRWpKTXdsTFBlR1ZFTElVbElKb2xXckN0QVF5UEN3Y3JUMkREWG4rSUVMVXBJVWFrL0M0c0YxZ1oralowS
E0wSzRYOTB1YTlHOVRZY0hhb2RmOGZzblo3MWp0YkpNS1RpVCttZkRUTnB2WHNFVFN2M2dKd3NYY2w
2Z2RvMFMxSHBMRVZpNHJuc1NwaUxUOThyQk1na2JhbTNQTjlLYzloK0RLdlFYWDdtUWVMMHZCdUhMY
U5VZ2VLRkVEUnQxaWpIMm5XM3ptMHdBbUcrbHd5ZVFMaHVCZFlBdkluVkJFa0lta1NKd2QxN3JNaUE5O
TFLUUNsR2xJY1kyVmFHNW80RzJQQVBhdlE3Z2IrZEhML05nNjZYZ3dlYWRWTC9TUnJoZ2FpQUVXWjBGVz
Q5YlVBbVZQUE0wUGxlamJXUDM0SE5YYjlsb1A2V1hOME1rT2V6bjdKeUttbjJ2M1huejhCTko4QjRIUSt1U2
1wUlhTYTlzMlJ4UjU3SmtyZ2VrL0QzQ0RuWTcyaHkxU2o0a3JjcWJ0NmRtU0NGcWJmSXpqYVg5NFRlOHlQ
VkNPTHRmVlFOZ3IwUjVVMURIZ3hJUWlZRUZqVVd4QmVyWDhIeC82MzJUWjJmVWxZOStJQ2E3djZjdUh
WaWF6V3lvVlM2RkVzY1Rxc3dBZmh2SDV5YnZWbC9YSURwQ2VsWjdrcjFhMEF0aElMbkJWclFhSjZEVkZRb
k1Vd2Vudi9VQjk1WEl1bTFVeGFCdVJIUDdjVXhXOS80T1liNjVqanJhRVJlRVV3TU5iOTZjSGtTQmlWQUI5QXl
zbzdRajJGSWhncFZyR1NtTXY0Sm9hMFZPVWNCZlB1ZEFoeHVIVytoTHlpakkvZDRQWXpyb2V5azgvVFc5ZG
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hnOTFhRUVCZUVUakFGeXJheXNiNlo5ZmJ4MU9DZG9vcXl0dm15ZDNaR2tVZTV0QVVxRStiU3A3R1F3Qm
w2TVRUencvVHVUVE8xeEJXSXYvMGtLUjdDWFRTTzdrejNYVE5HQm9VTTB2L2k4SHc2UEdzWkFhWjhXWU
ZhcnJYSG92TnBLOURIQ1FUb3Nya2swVlQwVENhcldCTWpnbnlCV0hOTEYvTGlOb1NCZ3hSemN3bU5XUEF
FczhxS1JPNk1DOERUZWd1bTNNRmxuQWRkQWNndTh1MERIeE91c29BTHBvTXZZSmdwd1Q0YmlhZG0xR
WdYWG9wN2pWTjlRTk83VlcwUmwzcUZkWE5OYjAxWGhrY0d4SUNxMmNsdU50TDJ6OWtVTDdpdmdKb
EdwSVoyeEpnQTJuc0M5cktHU1NWUm1MN3hzYk5ScFRZWnM1UmI2TWU4NUtRM0hFazM3d1VMci9Mc
0VuZkJpcnd4OTJrZVMrMTFCTmRVT1VhcmkzeU5YbVI4WkhHd2JaaW9qWFk1bER0Wld4cDRFdDlBRWpm
NDhrTFh0Z3dhNEU5dDFFV1VlNlMvUUw3MXNQSlpGcDhRd0VFcjRrNHFwenRJRXhPZHZIWnduVzVkM3ZG
eGF2b2VVNlVwTTErVHJaS3dwM0NYQUMvUT09</CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 

Authenticate User XML 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>10540</Id> 
  <Credential>11721</Credential> 
 </Sender> 
 <TransactInfo transactType="data" transactId="075cbfe6-b9dc-49f9-8f12-8eae62b62055"> 
  <TransactId>10/24/2008</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="AuthenticateTGUser"> 
  <Packet> 
   <PacketInfo packetType="data"> 
    <packetId>1</packetId> 
   </PacketInfo> 
   <Payload> 
    <InputString> 
     <ClientId></ClientId> 
     <SiteId></SiteId> 
     <Username></Username> 
     <Password></Password> 
    </InputString> 
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   </Payload> 
  </Packet> 
 </Unit> 
</Envelope> 

SSO Support 
To Support SSO TGs, we are using existing API (Authenticate User) where user has to send the 
Client Id / Site Id / SSO ID and we will generate the new user at our end and then send the 
Authentication Token back to client. Client can use that token to access other APIs. 
Input String 
    <InputString> 
     <ClientId></ClientId> 
     <SiteId></SiteId> 
     <SSOID></SSOID> 
    </InputString> 
 
Business Rules: 
· For SSO support, we are using existing Authenticate User API with addition of new node 

called SSOSessionID, which will have valid SSO Session ID.  
· If we don’t find entries for that SSOSessionID in our system we will treate that as new user 

and create a new user and send Authentication Token which is used to access other API 
calls. 

Input to Candidate Web Service 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>10540</Id> 
  <Credential>11721</Credential> 
 </Sender> 
 <TransactInfo transactType="data" transactId="075cbfe6-b9dc-49f9-8f12-8eae62b62055"> 
  <TransactId>10/24/2008</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="AuthenticateTGUser"> 
  <Packet> 
   <PacketInfo packetType="data"> 
    <packetId>1</packetId> 
   </PacketInfo> 
   <Payload> 
    <InputString> 
     <ClientId></ClientId> 
     <SiteId></SiteId> 
     <SSOID></SSOID> 
    </InputString> 
   </Payload> 
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  </Packet> 
 </Unit> 
</Envelope> 
 
Final Output from Candidate Web Service 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>1364</Id> 
  <Credential>1sU9JELZ8z9tPsHw8FDjyw==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="2347cf88-3c8d-4f6c-ab51-bfa0679f2bbe"> 
  <TransactId>7/1/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-
8" xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-
cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="AuthenticateTGUser"> 
      <Packet> 
       <PacketInfo packetType="data" 
encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <ClientId></ClientId> 
         <SiteId></SiteId> 
         <SSOID></SSOID> 
        </InputString> 
        <ResultSet> 
        
 <AuthenticationStatus></AuthenticationStatus> 
        
 <AuthenticationToken></AuthenticationToken>       
  
        </ResultSet> 
       </Payload> 
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       <Status> 
        <Code>200</Code> 
       
 <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully 
processed without error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully 
processed without error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without 
errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 

New User Creation  
This API allows client to create a total new TG user and then use that to login to TG or access 
other APIs by requesting Authenticate Token. 
Input String 
 
    <InputString> 
     <ClientId></ClientId> 
     <SiteId></SiteId> 
     <Username></Username> 
     <Password></Password> 
     <SecurityQuestion></SecurityQuestion> 
     <SecurityQuestionAnswer></SecurityQuestionAnswer> 
    </InputString> 
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Input to Candidate Web Service 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>10540</Id> 
  <Credential>11721</Credential> 
 </Sender> 
 <TransactInfo transactType="data" transactId="075cbfe6-b9dc-49f9-8f12-8eae62b62055"> 
  <TransactId>10/24/2008</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="AuthenticateTGUser"> 
  <Packet> 
   <PacketInfo packetType="data"> 
    <packetId>1</packetId> 
   </PacketInfo> 
   <Payload> 
    <InputString> 
     <ClientId></ClientId> 
     <SiteId></SiteId> 
     <Username></Username> 
     <Password></Password> 
     <SecurityQuestion></SecurityQuestion> 
     <SecurityQuestionAnswer></SecurityQuestionAnswer> 
    </InputString> 
   </Payload> 
  </Packet> 
 </Unit> 
</Envelope> 
 
Business Rules: 
For new user creation we will follow the same rules and validation which we are following 
today when user creates new account in TG as we are using the same functions which TG uses 
today 
 
Final Output from Candidate Web Service 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>1364</Id> 
  <Credential>1sU9JELZ8z9tPsHw8FDjyw==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="2347cf88-3c8d-4f6c-ab51-bfa0679f2bbe"> 
  <TransactId>7/1/2011</TransactId> 
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  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-
8" xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-
cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="CreateUser"> 
      <Packet> 
       <PacketInfo packetType="data" 
encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <ClientId></ClientId> 
         <SiteId></SiteId> 
         <Username></Username> 
         <Password></Password> 
        
 <SecurityQuestion></SecurityQuestion> 
        
 <SecurityQuestionAnswer></SecurityQuestionAnswer> 
        </InputString> 
        <ResultSet> 
        
 <AuthenticationStatus>0</AuthenticationStatus> 
        
 <AuthenticationToken>3bbaa10e-e596-4f46-b772-624ae49475d6</AuthenticationToken> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
       
 <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully 
processed without error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
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       <LongDescription>Call was successfully 
processed without error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without 
errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 

Access Page Result XML 
Modified Input String 
<InputString> 
  <AuthenticationToken>fa7309b1-46f0-4176-891d-4d916f287d98</AuthenticationToken> 
  <DestinationPage>0</DestinationPage> 
  <!-- HomePage = 0,SearchOpenings = 1,EditProfile = 2,StatusCheck = 3,ResumeManager = 
4,AgentManager = 5,JobCart = 6,SavedDrafts = 7,Logout = 8,SubmitNow = 9 --> 
</InputString> 
 
 
Results XML 
<?xml version="1.0" encoding="utf-8"?> 
<!-- edited with XML Spy v3.5 NT (http://www.xmlspy.com) by  () --> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="bdd18f76-abb1-4097-ae60-9660e61ae85c"> 
  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
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  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="AccessTGPage"> 
      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
        </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>fa7309b1-46f0-4176-891d-
4d916f287d98</AuthenticationToken> 
         <DestinationPage>0</DestinationPage> 
         <!-- HomePage = 0,SearchOpenings = 1,EditProfile = 
2,StatusCheck = 3,ResumeManager = 4,AgentManager = 5,JobCart = 6,SavedDrafts = 7,Logout = 
8,SubmitNow = 9 --> 
        </InputString> 
        <ResultSet> 
         <RedirectURL>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZp3F%0d%0aJT54nO9%2bpxN2tUk%2f
Hc4zRMGhv18upixQGQ%2fW9bK2RnvpywSuHGs2FXqxhz9tqshrKyEiBvU%2bHJYx%0d%0axaDw5kPwosX
Vt3akng%3d%3d</RedirectURL> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without 
error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without 
error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
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  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 
 

Reset Password XML 
only required if authenticate user call returns code/message: 204: The login was successful, 
however a password reset is required to request any pages. 
Input String: 
<InputString> 
  <AuthenticationToken>fa7309b1-46f0-4176-891d-4d916f287d98</AuthenticationToken> 
  <OldPassword>password!</OldPassword> 
  <NewPassword>password@</NewPassword> 
</InputString> 
 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="2fbfb764-8dd2-4767-8842-6c07fac315a0"> 
  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="ResetTGPassword"> 
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      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>fa7309b1-46f0-4176-891d-
4d916f287d98</AuthenticationToken> 
         <OldPassword>password!</OldPassword> 
         <NewPassword>password@</NewPassword> 
        </InputString> 
        <ResultSet/> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without 
error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without 
error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 
 

API Results XML 
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Resumes – Method “GetResumeList” 
Uses input string:  
<InputString> 
 <AuthenticationToken>fa7309b1-46f0-4176-891d-4d916f287d98</AuthenticationToken> 
</InputString> 
 
 
<ResultSet> 
<Resumes> 
  <Resume Language="1"> 
 <ResumeId>1</ResumeId> 
 <ResumeDisplayName></ResumeDisplayName> 
 <ResumeLink></ResumeLink> 
 <ResumeRevised>MM/DD/YYYY</ResumeRevised>   
 <AppliedJobs> 
   <Job> 
     <JobID></JobID> 
   <JobTitle></JobTitle> 
   <JobLink></JobLink> 
     <CoverLetterID>1</CoverLetterID> 
     <CoverLetterName></CoverLetterName> 
    <DateSubmitted></DateSubmitted> 
   </Job> 
 </AppliedJobs> 
 </Resume> 
</Resumes> 
</ResultSet> 
 
Full Decrypted Results 
 
<?xml version="1.0" encoding="utf-8"?> 
<!-- edited with XML Spy v3.5 NT (http://www.xmlspy.com) by  () --> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="230d6ba9-6e79-4ecb-88b8-69bf8c650e02"> 
  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
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    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="GetResumeList"> 
      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>fa7309b1-46f0-4176-891d-
4d916f287d98</AuthenticationToken> 
        </InputString> 
        <ResultSet> 
         <resumes> 
          <resume> 
           <resumename>My resume/CV</resumename> 
           <resumeurl>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZnAw%0d%0aThw2eyinuHxQmmBq4oi
GqsWaOWko2C2JRFGYcP1In%2bpsL0le1D%2bAIHZs7dJTy2DajW4Xci93UvHZ%0d%0a8lErtzz3DIeu42Rd0
491U%2bYFEo4omkCC7xB8ckAyflRih67uFdYpGIS%2fzQUj</resumeurl> 
           <resumerevised>12/6/2010</resumerevised> 
           <defaultresume>true</defaultresume> 
           <jobs> 
            <job> 
            
 <jobrequisitionid>164BR</jobrequisitionid> 
             <jobstatus>Open</jobstatus> 
             <jobtitle>System 
Developer</jobtitle> 
             <url>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZjPA%0d%0aqbOfK3X79KwylBbfhWNT0
k4668eJ%2bmJWZR1TcT4TFrkoDLC2G4P6F8yKM3hdFlEldGMQxmLZOo8f%0d%0au5Q5YtFmG2PrfhiKVH
ARcwz29j86nND9LHue6IM%3d</url> 
             <datesubmitted>11/11/2010 
12:28:00 PM</datesubmitted> 
            </job> 
           </jobs> 
          </resume> 
          <resume> 
           <resumename>My 
resume/CV2</resumename> 
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           <resumeurl>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZnAw%0d%0aThw2eyinuHxQmmBq4oi
GqsWaOWko2C2JRFGYcP1In%2bpsL0le1D%2bAIHZs7dJTy2DajW4Xci93UvHZ%0d%0a8lErtzz7Nix1x9Fvnit
7yf07eJianxIs%2bpYybAa%2foHYFHjF16zg8Qnlelmj7</resumeurl> 
           <resumerevised>12/6/2010</resumerevised> 
           <defaultresume>false</defaultresume> 
           <jobs/> 
          </resume> 
          <resume> 
           <resumename>My 
resume/CV3</resumename> 
           <resumeurl>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZnAw%0d%0aThw2eyinuHxQmmBq4oi
GqsWaOWko2C2JRFGYcP1In%2bpsL0le1D%2bAIHZs7dJTy2DajW4Xci93UvHZ%0d%0a8lErtzz7Nix1x9Fvnk
oieVLH0zvG43FcNe%2brTkJIkBAQ19XjFA%3d%3d</resumeurl> 
           <resumerevised>12/6/2010</resumerevised> 
           <defaultresume>false</defaultresume> 
           <jobs/> 
          </resume> 
         </resumes> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without 
error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without 
error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
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 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 
 
 

Jobs in Job Cart – Method “GetJobCart” 
Uses input string:  
<InputString> 
 <AuthenticationToken>fa7309b1-46f0-4176-891d-4d916f287d98</AuthenticationToken> 
</InputString> 
 
 
<ResultSet> 
       <jobs> 
             <job> 
                    <jobrequisitionid></jobrequisitionid> 
                    <jobstatus> </jobstatus> 
                    <jobtitle> </jobtitle> 
                    <url></url> 
                    <dateadded></dateadded> 
             </job> 
       </jobs> 
</ResultSet> 
 
Full Decrypted Results 
 
<?xml version="1.0" encoding="utf-8"?> 
<!-- edited with XML Spy v3.5 NT (http://www.xmlspy.com) by  () --> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="6ffa59bf-6271-4dd9-b89f-5523c809d43b"> 
  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
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   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="GetJobCart"> 
      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>fa7309b1-46f0-4176-891d-
4d916f287d98</AuthenticationToken> 
        </InputString> 
        <ResultSet> 
         <jobs> 
          <job> 
           <jobrequisitionid>165BR</jobrequisitionid> 
           <jobstatus>Open</jobstatus> 
           <jobtitle>A&amp;E Writer &amp; Editor</jobtitle> 
           <url>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZjPA%0d%0aqbOfK3X79KwylBbfhWNT0
k4668eJ%2bmJWZR1TcT4TFrkoDLC2G4P6F8yKM3hdFqv9wZueKe0J0NSm%0d%0aRwhv7uEFalYeaFTfIXz
ml%2bP5LCRvubUw18RymiA%3d</url> 
           <dateadded>11/18/2010</dateadded> 
          </job> 
         </jobs> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
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   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 
 

Job Status – Method “GetStatusCheck” 
Uses input string:  
<InputString> 
 <AuthenticationToken>fa7309b1-46f0-4176-891d-4d916f287d98</AuthenticationToken> 
</InputString> 
 
 
<ResultSet> 
       <Jobs> 
             <Job> 
                    <Jobsubmissiondate></Jobsubmissiondate> 
                    <JobrequisitionID></JobrequisitionID> 
                    <Jobtitle> </Jobtitle> 
                    <jobstatus> </jobstatus> 
                    <Jobstatusdate></Jobstatusdate> 
                    <url></url> 
                    <HRstatus> </HRstatus> 
                    <HRstatusdate></HRstatusdate> 
             </Job> 
       </Jobs> 
</ResultSet> 
 
Full Decrypted Results 
 
<?xml version="1.0" encoding="utf-8"?> 
<!-- edited with XML Spy v3.5 NT (http://www.xmlspy.com) by  () --> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="3c54ee09-e0ee-4a6a-8227-1a3cc6522c4a"> 
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  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="GetStatusCheck"> 
      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>fa7309b1-46f0-4176-891d-
4d916f287d98</AuthenticationToken> 
        </InputString> 
        <ResultSet> 
         <jobs> 
          <job> 
           <jobsubmissiondate>11/11/2010</jobsubmissiondate> 
           <jobrequisitionid>164BR</jobrequisitionid> 
           <jobtitle>System Developer</jobtitle> 
           <jobstatus>Open</jobstatus> 
           <url>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SBeuHiNco
%2fAyx63VjjIb6TNzQe%2fAd517PnJSqyWxMyVy%2befTmM2x%0d%0aZuiU4cWzmgxB%2bUHoJh9GWO
WbO1rD0RaKcxxGTj9BBktYK2u2rUCxXCvvOTdi9oG4j%2bkCbUhBZjPA%0d%0aqbOfK3X79KwylBbfhWNT0
k4668eJ%2bmJWZR1TcT4TFrkoDLC2G4P6F8yKM3hdFqv9wZueKe0J0NSm%0d%0aRwhv7uEFalYeaFTfIXz
ml%2bP5LCRvubUw18RymiA%3d</url> 
           <jobstatusdate>03/08/2011</jobstatusdate> 
           <hrstatus>Phone Screen</hrstatus> 
           <hrstatusdate>11/11/2010</hrstatusdate> 
          </job> 
         </jobs> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without error.</LongDescription> 
       </Status> 
      </Packet> 
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      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 
 

Communications History – Method “GetCommunicationsHistory” 
 
Modified Input XML 
 
<Payload> 
 <InputString> 
   <AuthenticationToken/> 
       <PageNumber></PageNumber> 
           <ReturnMessagesCount></ReturnMessagesCount> 
  </InputString> 
</Payload> 
 
Results XML 
 
<ResultSet> 
<Messages> 
  <Message> 
    <CorrespondenceID>12345</CorrespondenceID> 
    <Date>MM/DD/YYYY</Date> 
    <JobID></JobID> 
    <JobTitle></JobTitle> 
    <From></From> 
    <TemplateName></TemplateName> 
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    <Type></Type> 
    <Subject></Subject> 
    <MessageLink></MessageLink> 
  </Message> 
 
Full Decrypted Results 
 
<?xml version="1.0" encoding="utf-8"?> 
<!-- edited with XML Spy v3.5 NT (http://www.xmlspy.com) by  () --> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>QE</Id> 
  <Credential>AXc9N72lF+3UhS8HUZq+FA==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="0b02e774-d6a2-4bab-a9a8-
466e9b8c2fdc"> 
  <TransactId>4/26/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="GetCommunicationHistory"> 
      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>3fe272e2-06e1-4266-b009-
f75a2998f92f</AuthenticationToken> 
         <PageNumber/> 
         <ReturnMessagesCount/> 
        </InputString> 
        <ResultSet> 
         <Messages> 
          <Message> 
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           <CorrespondenceID>423</CorrespondenceID> 
           <Date>02/11/2011</Date> 
           <Subject>KM Email Template - Subject</Subject> 
           <Type>1</Type> 
           <TemplateName>KM Email 
Template</TemplateName> 
           <From>McEachern, Kevin</From> 
           <JobID>92476</JobID> 
           <JobTitle>Test 4000 Characters in JD 2</JobTitle> 
           <MessageLink>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SB
euHiNcQ6R4O1vBGsJdh4ZzRXSEsrJYm%2f2SqUWQ2WM7IqU3Mf8Y%0d%0aqrbKFgPwNpDKlvQ
nu92TtVGV7GCVjiSjGu%2fuZE8yrszMnoFtLM0T4oFMifa2k4nQ4WqNULe0t4V6%0d%0acbnvVrj8
W5UTcnkzsKpCqg6e9zILtTShfgedWj3NUhS4vBfAAqiijbTZXCtsT98TaOsPFaNGD4Nf%0d%0aJcI4O
9rK8ymOBwdj7%2fRXJ4F8KcF1lqPBFYy9lFIUlen2v1RXjw%3d%3d</MessageLink> 
          </Message> 
          <Message> 
           <CorrespondenceID>422</CorrespondenceID> 
           <Date>02/11/2011</Date> 
           <Subject>Ad Hoc 170BR</Subject> 
           <Type>4</Type> 
           <TemplateName>Send candidate 
email</TemplateName> 
           <From>McEachern, Kevin</From> 
           <JobID>92476</JobID> 
           <JobTitle>Test 4000 Characters in JD 2</JobTitle> 
           <MessageLink>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SB
euHiNcQ6R4O1vBGsJdh4ZzRXSEsrJYm%2f2SqUWQ2WM7IqU3Mf8Y%0d%0aqrbKFgPwNpDKlvQ
nu92TtVGV7GCVjiSjGu%2fuZE8yrszMnoFtLM0T4oFMifa2k4nQ4WqNULe0t4V6%0d%0acbnvVrj8
W5UTcnkzsKpCqg6e9zILtTShfgedWj3NUhS4vBfAAqiijbTZXCtsT98TaOsPFaNGD4Nf%0d%0aJcI4O
9rK8ymOBwdj7%2fRXJ4F8KcF1lqPBFYy9lFL5aoBPbKMvnQ%3d%3d</MessageLink> 
          </Message> 
          <Message> 
           <CorrespondenceID>421</CorrespondenceID> 
           <Date>02/11/2011</Date> 
           <Subject/> 
           <Type>0</Type> 
           <TemplateName>KM Letter Temp 
2</TemplateName> 
           <From>McEachern, Kevin</From> 
           <JobID>92475</JobID> 
           <JobTitle>Test 4000 Characters in JD</JobTitle> 
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           <MessageLink>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SB
euHiNcQ6R4O1vBGsJdh4ZzRXSEsrJYm%2f2SqUWQ2WM7IqU3Mf8Y%0d%0aqrbKFgPwNpDKlvQ
nu92TtVGV7GCVjiSjGu%2fuZE8yrszMnoFtLM0T4oFMifa2k4nQ4WqNULe0t4V6%0d%0acbnvVrj8
W5UTcnkzsKpCqg6e9zILtTShfgedWj3NUhS4vBfAAqiijbTZXCtsT98TaOsPFaNGD4Nf%0d%0aJcI4O
9rK8ymOBwdj7%2fRXJ4F8KcF1lqPBFYy9lFK%2fxS%2bX7zrThg%3d%3d</MessageLink> 
          </Message> 
          <Message> 
           <CorrespondenceID>420</CorrespondenceID> 
           <Date>02/11/2011</Date> 
           <Subject>KM Email Template 2</Subject> 
           <Type>1</Type> 
           <TemplateName>KM Email Template 
2</TemplateName> 
           <From>McEachern, Kevin</From> 
           <JobID>92475</JobID> 
           <JobTitle>Test 4000 Characters in JD</JobTitle> 
           <MessageLink>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SB
euHiNcQ6R4O1vBGsJdh4ZzRXSEsrJYm%2f2SqUWQ2WM7IqU3Mf8Y%0d%0aqrbKFgPwNpDKlvQ
nu92TtVGV7GCVjiSjGu%2fuZE8yrszMnoFtLM0T4oFMifa2k4nQ4WqNULe0t4V6%0d%0acbnvVrj8
W5UTcnkzsKpCqg6e9zILtTShfgedWj3NUhS4vBfAAqiijbTZXCtsT98TaOsPFaNGD4Nf%0d%0aJcI4O
9rK8ymOBwdj7%2fRXJ4F8KcF1lqPBFYy9lFIWiKteCTmQAQ%3d%3d</MessageLink> 
          </Message> 
          <Message> 
           <CorrespondenceID>419</CorrespondenceID> 
           <Date>02/11/2011</Date> 
           <Subject>Ad Hoc 169BR 2</Subject> 
           <Type>4</Type> 
           <TemplateName>Send candidate 
email</TemplateName> 
           <From>McEachern, Kevin</From> 
           <JobID>92475</JobID> 
           <JobTitle>Test 4000 Characters in JD</JobTitle> 
           <MessageLink>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SB
euHiNcQ6R4O1vBGsJdh4ZzRXSEsrJYm%2f2SqUWQ2WM7IqU3Mf8Y%0d%0aqrbKFgPwNpDKlvQ
nu92TtVGV7GCVjiSjGu%2fuZE8yrszMnoFtLM0T4oFMifa2k4nQ4WqNULe0t4V6%0d%0acbnvVrj8
W5UTcnkzsKpCqg6e9zILtTShfgedWj3NUhS4vBfAAqiijbTZXCtsT98TaOsPFaNGD4Nf%0d%0aJcI4O
9rK8ymOBwdj7%2fRXJ4F8KcF1lqPBFYy9lFLEKfE2USWiXg%3d%3d</MessageLink> 
          </Message> 
          <Message> 
           <CorrespondenceID>418</CorrespondenceID> 
           <Date>02/11/2011</Date> 
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           <Subject/> 
           <Type>0</Type> 
           <TemplateName>KM Letter 
Template</TemplateName> 
           <From>McEachern, Kevin</From> 
           <JobID>92475</JobID> 
           <JobTitle>Test 4000 Characters in JD</JobTitle> 
           <MessageLink>https://sqa-tgweb-
01.brassring.com/1033/asp/tg/redirectcandidate.asp?q=%5eudzQFPVk94hM37MiZWaGjTn1SB
euHiNcQ6R4O1vBGsJdh4ZzRXSEsrJYm%2f2SqUWQ2WM7IqU3Mf8Y%0d%0aqrbKFgPwNpDKlvQ
nu92TtVGV7GCVjiSjGu%2fuZE8yrszMnoFtLM0T4oFMifa2k4nQ4WqNULe0t4V6%0d%0acbnvVrj8
W5UTcnkzsKpCqg6e9zILtTShfgedWj3NUhS4vBfAAqiijbTZXCtsT98TaOsPFaNGD4Nf%0d%0aJcI4O
9rK8ymOBwdj7%2fRXJ4F8KcF1lqPBFYy9lFJ0uHFzYupuMA%3d%3d</MessageLink> 
          </Message> 
         </Messages> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without 
error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without 
error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without 
errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
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  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 

Event Manager Search and Candidate Specific  – Method 
“GetEvents” 
Sample Request XML: 
<Payload> 
                <InputString> 
                                <AuthenticationToken></AuthenticationToken> 
                               <ClientID></ClientID> 

<Criteria> 
   <EventType> 
    <Value></Value> 
    <Value></Value> 
   </EventType> 

<Location> 
    <Value></Value> 
    <Value></Value> 

</Location> 
<City> 

<Value></Value> 
    <Value></Value> 

</City> 
<Region> 

<Value></Value> 
    <Value></Value> 

</Region> 
<PostalCode> 

<Value></Value> 
    <Value></Value> 

</PostalCode> 
<Country> 

<Value></Value> 
    <Value></Value> 

</Country> 
<Status> 

    <Value></Value> 
    <Value></Value> 
   </Status> 

<StartDate>yyyy/mm/dd hh:mm</StartDate> 
         <EndDate>yyyy/mm/dd hh:mm</EndDate> 

</Criteria> 
  </InputString> 

</Payload> 

 

38 of 318



 
 

©Kenexa® 2011. All Rights Reserved  27 
 

Business Rules: 
Ø If the Request XML does not include an authentication token then only public events will 

be returned in the results set. 
Ø If “Criteria” is not provided then the results set will not include any public events. 
Ø Any” Values” provided must match Event Manager data exactly to be considered a 

match and be returned in the results set. 
Ø Multiple “Values” may be provided for each criteria 
Ø If start date and/or end date is missing then the results set will default to returning the 

next 90 days worth of public events which match the search criteria entered. 
Ø Within an individual criteria the API will return results based on an ‘OR’ logic (Event 

Type = A OR B), across criteria the API will return results based on ‘AND’ logic (Event 
Type = X AND (Location = Y OR Z) 

 
Sample Response XML: 
<ResultSet> 
 <CandidateEvents> 

<Event> 
<Event ID></EventID> 
<EventTemplate></EventTemplate> 
<EventSeries></EventSeries> 
<EventInstance></EventInstance> 
<EventDateTime></EventDateTime> 
<EventLocation></EventLocation> 
<EventCity></EventCity> 
<EventRegion></EventRegion> 
<EventPostalCode></EventPostalCode> 
<EventCountry></EventCountry> 
<EventDescription></EventDescription> 
<CandidateStatus></CandidateStatus> 
<EventURL></EventURL> 

  <Reqs> 
<Req ID=”” AutoReqID=””> 
 <JobTitle/> 
</Req> 

<CustomFields> 
<Field> 

<Name></Name> 
<Value></Value> 

</Field> 
<Field> 

<Name></Name> 
<Value></Value> 

</Field> 
</CustomFields> 
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</Event> 
 </CandidateEvents> 
 <PublicEvents> 

<Event> 
<Event ID></EventID> 
<EventTemplate></EventTemplate> 
<EventSeries></EventSeries> 
< EventInstance></EventInstance> 
<Event Date></EventDate> 
<EventTime></EventTime> 
<EventTimeZone></EventTimeZone> 
<EventLocation></EventLocation> 
<EventCity></EventCity> 
<EventRegion></EventRegion> 
<EventPostalCode></EventPostalCode> 
<EventCountry></EventCountry> 
<EventDescription></EventDescription> 

  <CustomFields> 
<Field> 

<Name></Name> 
<Value></Value> 

</Field> 
<Field> 

<Name></Name> 
<Value></Value> 

</Field> 
</CustomFields> 

 </Event>  
 </PublicEvents> 
</ResultSet> 
 
Full Decrypted Results 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>1364</Id> 
  <Credential>1sU9JELZ8z9tPsHw8FDjyw==</Credential> 
 </Sender> 
 <Recipient/> 
 <TransactInfo transactType="response" transactId="e570c9cd-f86c-4e89-951c-e359dfaf23f3"> 
  <TransactId>6/1/2011</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="Decryptor"> 
  <EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element" encoding="utf-8" 
xmlns="http://www.w3.org/2001/04/xmlenc#"> 
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   <EncryptionMethod Algorithm="http://www.w3.org/2001/04/xmlenc#aes128-cbc"/> 
   <ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#"> 
    <ds:KeyName>Integration</ds:KeyName> 
   </ds:KeyInfo> 
   <CipherData> 
    <CipherValue> 
     <Unit UnitProcessor="GetEvents"> 
      <Packet> 
       <PacketInfo packetType="data" encrypted="yes"> 
        <packetId>1</packetId> 
       </PacketInfo> 
       <Payload> 
        <InputString> 
         <AuthenticationToken>763b477b-d70d-406b-a456-5997958a7300</AuthenticationToken> 
         <ClientId>11714</ClientId> 
         <Criteria> 
          <EventType> 
           <Value/> 
          </EventType> 
          <Location> 
           <Value/> 
          </Location> 
          <City> 
           <Value/> 
          </City> 
          <Region> 
           <Value/> 
          </Region> 
          <PostalCode> 
           <Value/> 
          </PostalCode> 
          <Country> 
           <Value/> 
          </Country> 
          <Status> 
           <Value/> 
          </Status> 
          <StartDate>2007/12/12 01:01</StartDate> 
          <EndDate>2011/12/12 01:01</EndDate> 
         </Criteria> 
        </InputString> 
        <ResultSet> 
         <CandidateEvents> 
          <Events> 
           <Event> 
            <EventID/> 
            <EventTemplate>KM Template 2 - Private Event</EventTemplate> 
            <EventSeries>KM Event 7 - Private -Series</EventSeries> 
            <EventInstance/> 
            <EventDateTime/> 
            <EventLocation/> 
            <EventCity/> 
            <EventRegion/> 
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            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription/> 
            <CandidateStatus>Invited</CandidateStatus> 
           
 <EventURL>https://qalabs1.brassring.com/satori2/eventmanager/register.aspx?BRUrlParams=bEJjZ01HU2VjK00
3WXdLMWV4eUM2anRnYmhiTDB2N1Y3UlZ2Z2tWTFgzalhIdDhySEdiZDBXMlNVa1lsWVJIeEttSVBDa3htcnlvMUZOd
XRGZU5CU0poNmNydXVNNHBXcEd6cXBraGR1aVdQeVY1elVaanJacjdYSG1ZV0N3WlNGbDlHdDBaWjAzZGJPYkVIdVl
mOHNYdzhLT3M3K29hblUyRzJRTlczb0dxdDBxL3lXWGl6YXFpZjZBSjRRdEhtS0ZxK0hpdXJmQnZoT0FreUhWY21WaXR
6cllkNnhJWCtaSmJvNWFGdHgyMzYzZzlERnA2NzZJdUFodWEwMWNrNHhHRWFSMU9GU21PM3R3Z29iVWIrbHlJZF
pjWFdhdjlEaVBsZ3N3Z0FRRGoydGo3RlNudVY4V2lGUFNjanBrdW00NWZoYUp1cCtCVFBjT2tBQVVPYmVPcmF6MFR
NamRyc2lyOHV3RzRLKzFveTVQM1psb2RqUFQ4SXNwb09KZ2tlT3h5WjhMUnN6U2RjODBIQXI3VFkxV0RWdkZTTGtiL
2hiV004Z0ZaeDFJditwUElEbC91WXJ3dmtjMFFmNWJFWmRSaUFsSUxHK1BZWk5FUGgvL2c4dzQwd1p0QnVJM01q0
</EventURL> 
            <CustomFields/> 
           </Event> 
          </Events> 
         </CandidateEvents> 
         <PublicEvents> 
          <Events> 
           <Event> 
            <EventID>7467</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries/> 
            <EventInstance>KM Event 1</EventInstance> 
            <EventDate>29 Apr 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Vizag</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field for KM Event 
1</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>KM Custom Field 1 - Text</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/22/2011 12:00:00 AM</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>KM Custom Field 2 - Text</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7527</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
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            <EventSeries>KM Event 10 - Public Series</EventSeries> 
            <EventInstance>KM Event 10 - Public Series</EventInstance> 
            <EventDate>01 May 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Burlington</EventLocation> 
            <EventCity>Burlington</EventCity> 
            <EventRegion>MA</EventRegion> 
            <EventPostalCode>01802</EventPostalCode> 
            <EventCountry>US</EventCountry> 
            <EventDescription>KM Event Template - Description field</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>Custom 1 slkjsd</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>Custom 2 aslkdjf</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/30/2011 12:00:00 AM</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7475</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries/> 
            <EventInstance>KM Event 2</EventInstance> 
            <EventDate>05 May 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Vizag</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field for KM Event 
1</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>KM Custom Field 1 - Text</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/22/2011 12:00:00 AM</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>KM Custom Field 2 - Text</Value> 
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             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7630</EventID> 
            <EventTemplate>KM Public Event Template</EventTemplate> 
            <EventSeries>sss</EventSeries> 
            <EventInstance>sss222</EventInstance> 
            <EventDate>24 May 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Pacific Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation/> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Public Event Template -</EventDescription> 
            <CustomFields/> 
           </Event> 
           <Event> 
            <EventID>7476</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries/> 
            <EventInstance>KM Event 3</EventInstance> 
            <EventDate>26 May 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Vizag</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field for KM Event 
1</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>KM Custom Field 1 - Text</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/22/2011 12:00:00 AM</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>KM Custom Field 2 - Text</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7545</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries/> 
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            <EventInstance>KM Event 11 - Public</EventInstance> 
            <EventDate>26 May 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Watertown</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>askdfjskdl</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>asdflkajsd</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>5/31/2011 12:00:00 AM</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7528</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries>KM Event 10 - Public Series</EventSeries> 
            <EventInstance>KM Event 10 - Public Series</EventInstance> 
            <EventDate>01 Jun 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Burlington</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>Custom 1 slkjsd</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>Custom 2 aslkdjf</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/30/2011 12:00:00 AM</Value> 
             </Field> 
            </CustomFields> 
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           </Event> 
           <Event> 
            <EventID>7506</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries/> 
            <EventInstance>KM Event 9 - Public</EventInstance> 
            <EventDate>30 Jun 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Greenwich Mean Time : Dublin, Edinburgh, Lisbon, 
London</EventTimeZone> 
            <EventLocation>Cambridge, MA</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>Custom Text 1 aasdfsd</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>6/29/2011 12:00:00 AM</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>Custom Text 2 asdpoifj</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7529</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries>KM Event 10 - Public Series</EventSeries> 
            <EventInstance>KM Event 10 - Public Series</EventInstance> 
            <EventDate>01 Jul 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Burlington</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>Custom 1 slkjsd</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>Custom 2 aslkdjf</Value> 
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             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/30/2011 12:00:00 AM</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
           <Event> 
            <EventID>7534</EventID> 
            <EventTemplate>KM Event Template with all</EventTemplate> 
            <EventSeries>KM Event 10 - Public Series</EventSeries> 
            <EventInstance>KM Event 10 - Public Series</EventInstance> 
            <EventDate>01 Dec 2011</EventDate> 
            <EventTime>9:00AM</EventTime> 
            <EventTimeZone>Eastern Time (US &amp; Canada)</EventTimeZone> 
            <EventLocation>Burlington</EventLocation> 
            <EventCity/> 
            <EventRegion/> 
            <EventPostalCode/> 
            <EventCountry/> 
            <EventDescription>KM Event Template - Description field</EventDescription> 
            <CustomFields> 
             <Field> 
              <Name>KM Custom Field 1</Name> 
              <Value>Custom 1 slkjsd</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Fiield 2</Name> 
              <Value>Custom 2 aslkdjf</Value> 
             </Field> 
             <Field> 
              <Name>KM Custom Field 3 Date</Name> 
              <Value>4/30/2011 12:00:00 AM</Value> 
             </Field> 
            </CustomFields> 
           </Event> 
          </Events> 
         </PublicEvents> 
        </ResultSet> 
       </Payload> 
       <Status> 
        <Code>200</Code> 
        <ShortDescription>Success</ShortDescription> 
        <LongDescription>Call was successfully processed without error.</LongDescription> 
       </Status> 
      </Packet> 
      <Status> 
       <Code>200</Code> 
       <ShortDescription>Success</ShortDescription> 
       <LongDescription>Call was successfully processed without error.</LongDescription> 
      </Status> 
     </Unit> 
    </CipherValue> 
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   </CipherData> 
  </EncryptedData> 
  <Status> 
   <Code>200</Code> 
   <ShortDescription>Message decrypted and processed without errors.</ShortDescription> 
   <LongDescription/> 
  </Status> 
 </Unit> 
 <Status> 
  <Code>200</Code> 
  <ShortDescription>Success</ShortDescription> 
  <LongDescription>All units are processed with success codes</LongDescription> 
 </Status> 
</Envelope> 
 
Business Rules: 
Ø The Response XML will list events by date sent, in ascending order. 
Ø Any custom field associated with the Event will be provided in the results set.  
Ø The PublicEvents results set will include only Events that are marked as public, 

regardless of whether the candidate has been invited or registered, these will also be 
included. 

Ø If an authentication token is provided in the request XML then both candidate specific 
events and public events will be provided in the results set. If the authentication token is 
missing then only the public events will be provided. 

Ø If there is no search criteria provided then no public events will be returned. 
Ø When a candidate has been invited/registered to an Event Instance, the following nodes 

are populated 
o  EventID  - Yes 
o EventTemplate - Yes 
o EventSeries - Yes 
o EventInstance  - Yes 
o EventDate/Time  – Yes 
o EventLocation – Yes 
o EventDescription – Yes 
o CandidateStatus – Yes 
o EventURL – Yes 
o Req – Yes (if available) 
o CustomFields - Yes 

Ø When a candidate is invited to an Event Series, the following nodes are populated 
o EventID  - Yes (available when candidate is registered, not available when 

invited) 
o EventTemplate - Yes 
o EventSeries - Yes 
o EventInstance  - No 
o EventDate/Time  – No 
o EventLocation – No 
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o EventDescription – No 
o CandidateStatus – Yes 
o EventURL – Yes 
o Req – Yes (if available) 
o CutomFields – No 

Ø When the candidate is invited to an EventTemplate, the following nodes are populated 
o EventID  - Yes (available when candidate is registered, not when invited) 
o EventTemplate - Yes 
o EventSeries - No 
o EventInstance  - No 
o EventDate/Time  – No 
o EventLocation – No 
o EventDescription – No 
o CandidateStatus – Yes 
o EventURL – Yes 
o Req – Yes (if available) 
o CutomFields – No 

Ø In the event the candidate is invited to “any scheduled event” only the candidate status, 
eventURL and Req data will be available. 

Ø Client “Best Practice”:  to present the Event “name” clients should use only one of the 3 
following nodes: EventInstance, EventSeries, or EventTemple, using whichever of the 
most granular is available. EventTemple is least granular, EventSeries has the next level 
of granularity, EventInstance is the most granular. 

 

API Error Messages 
 
Sr.No Candidate API Name Error 

Code 
Error Description 

 If Any unhandled Exception 
happens 

100 An unknown error has occurred. 

1.   
 
 
 
 
 
       AuthenticateUser 

210 ClientId cannot be empty. 
2.  206 ClientId node is missing from input. 
3.  211 SiteId cannot be empty 
4.  207 SiteId node is missing from input. 
5.  212 Username cannot be empty 
6.  208 Username node is missing from input. 
7.  213 Password cannot be empty 
8.  209 Password node is missing from input. 
9.  201 The site provided does not support logins. 
10.  202 Unable to find that email/password in the system. 
11.  203 The account has been locked out due to 

excessive invalid login attempts. 
12.  204 The login was successful, however a password 

reset is required to request any pages. 
13.  205 The site requested is inactive or does not exist. 
14.    
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15.   
 
AuthenticateUser - If SSOID 
is using for Authenticate User 

305 SSO Session ID cannot be empty 
16.  202 There was an error processing the login 
17.  321 Suspected replay attack - 2 - attempting relogin 

with the same link. 
18.  323 Gateway is not SSO enabled. 

    
19.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
          Create User 

210 ClientId cannot be empty. 
20.  206 ClientId node is missing from input. 
21.  211 SiteId cannot be empty 
22.  207 SiteId node is missing from input. 
23.  212 Username cannot be empty 
24.  305 Please remove the ' DOUBLE QUOTE (\") ' you 

have entered. 
25.  301 Security Questions cannot be empty 
26.  302 SecurityQuestions node is missing from input. 
27.  303 Please enter an answer to your security question. 
28.  304 The answer to your security question must be less 

than 50 characters. 
29.  305 SecurityQuestionsAnswer node is missing from 

input. 
30.  311 Your log in credentials cannot be validated. You 

may have created an account in the past, if so 
please click the 'forgot your password' link on the 
Welcome page to reset your password. 

31.  312 Your log in credentials cannot be validated. You 
may have created an account in the past, if so 
please click the 'forgot your password' link on the 
Welcome page to reset your password. 

32.  313 You can not use your email address as your 
password. 

33.  314 You can not use your username as your 
password. 

34.  315 Your password may not be the same as your login 
e-mail address. 

35.   316 Your password may not be the same as your 
username. 

36.  317 Your password must be a minimum of 6 and a 
maximum of 25 characters. 

37.  318 Your password may not contain spaces. 
38.  319 Your password must contain at least one of the 

following special characters: {}[],.<>;:'\"" + 
                                                
"?/|\\`~!@#$%^&*()_-+=. 

39.  320 Your password must be a minimum of 8 and a 
maximum of 25 characters. 

40.  322 Invalid Security Questions. 
41.  324 Please enter a valid e-mail address.Delete all the 

invalid characters, including spaces, from your e-
mail address. 

42.  325 The username must be less than 100 characters. 
43.  326 The username must not include any spaces. 
44.  327 The username must not include the following 

characters: < > 
45.  201 The site provided does not support logins. 
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46.  205 The site requested is inactive or does not exist. 
    

47.   
 
 
 
 
 
 
 
 
          AccessPage 

211 AuthenticationToken node cannot be empty. 
48.  209 AuthenticationToken node is missing from input. 
49.  210 DestinationPage node cannot be empty. 
50.  212 DestinationPage node is missing from input. 
51.  201 The token provided does not exist. 
52.  202 The token provided has expired. 
53.  203 The token provided must reset the password first. 
54.  204 The page requested is not supported by the 

authenticated site. 
55.  205 You have requested a page id that does not exist. 
56.  206 The session for this authentication token has been 

deleted. 
57.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
58.  208 The session for this authentication token has 

expired. 
59.  207 The authentication status is not valid for this 

request. 
    

60.   
 
 
 
          GetJobCart 

201 AuthenticationToken node cannot be empty. 
61.  202 AuthenticationToken node is missing from input. 
62.  217 No JobCart data found for this candidate. 
63.  215 The information requested is not supported by the 

authenticated site. 
64.  201 The token provided does not exist. 
65.  202 The token provided has expired. 
66.  206 The session for this authentication token has been 

deleted. 
67.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
68.    
69.   208 The session for this authentication token has  
70.   expired. 
71.  207 The authentication status is not valid for this 

request. 
    

72.   
 
 
 
 
 
 
      GetStatusCheck 

201 AuthenticationToken node cannot be empty. 
73.  202 AuthenticationToken node is missing from input. 
74.  216 No StatusCheck data found for this candidate. 
75.  215 The information requested is not supported by the 

authenticated site. 
76.  201 The token provided does not exist. 
77.  206 The session for this authentication token has been 

deleted. 
78.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
79.  208 The session for this authentication token has 

expired. 
80.  207 The authentication status is not valid for this 

request. 
    
  201 AuthenticationToken node cannot be empty. 
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81.   
 
 
 
     GetResumeList 

202 AuthenticationToken node is missing from input. 
82.  201 The token provided does not exist. 
83.  202 The token provided has expired. 
84.  206 The session for this authentication token has been 

deleted. 
85.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
86.  208 The session for this authentication token has 

expired. 
87.  207 The authentication status is not valid for this 

request. 
    

88.   
 
 
 
 
 
 
   GetCommunicationHistory 

201 AuthenticationToken node cannot be empty. 
89.  202 AuthenticationToken node is missing from input. 
90.  201 The token provided does not exist. 
91.  202 The token provided has expired. 
92.  206 The session for this authentication token has been 

deleted. 
93.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
94.  208 The session for this authentication token has 

expired. 
95.  207 The authentication status is not valid for this 

request. 
    

96.   
 
 
 
 
   ResetPassword 

201 AuthenticationToken node cannot be empty. 
97.  202 AuthenticationToken node is missing from input. 
98.  203 OldPassword node cannot be empty. 
99.  204 OldPassword node is missing from input. 
100.  205 NewPassword node cannot be empty. 
101.  206 NewPassword node is missing from input. 
102.  251 Password must be at least eight characters. 
103.  252 Your password must contain at least one of the 

following special characters: 
{}[],.<>;:'""?/|\`~!@#$%^&*()_-+=. 

104.   253 Your password may not be the same as any of the 
5 preceding passwords. 

105.  209 Password must be less than 25 characters. 
106.  210 Password must contain one of the following 

characters: -~`!@#$%^&*()_+={}[|<>,.:;'?\"\\] 
107.  211 Password cannot be one of the recent passwords 

used. 
108.  212 Password cannot be the same as the username. 
109.  213 Password cannot contain spaces. 
110.  214 The old password entry is incorrect. Please try 

again. 
111.  215 The information requested is not supported by the 

authenticated site. 
112.  201 The token provided does not exist. 
113.  202 The token provided has expired. 
114.  206 The session for this authentication token has been 

deleted. 
115.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
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116.  208 The session for this authentication token has 
expired. 

117.  207 The authentication status is not valid for this 
request. 

118.  208 Password must be at least six characters. 
    

119.   
 
 
 
 
      GetEvents 

301 ClientId node is missing from input. 
120.  205 The site requested is inactive or does not exist. 
121.  201 The token provided does not exist. 
122.  202 The token provided has expired. 
123.  206 The session for this authentication token has been 

deleted. 
124.  207 The user has logged out of the Talent Gateway.  

Please request a new AuthenticationToken. 
125.  208 The session for this authentication token has 

expired. 
126.  207 The authentication status is not valid for this 

request. 
 

 

Talent Gateway Web API -RSS 
Process for enabling RSS feeds in the simplest terms is: 

· Kenexa enables  a setting for the Talent Gateway on which the web search is performed (for 
the feed items): “Allow the Web service to query this gateway” 

· Kenexa sends the RSS.xml to CSC or Client. 
· Client creates an HTML page using this RSS.xml and sends us the link for that page with an 

image 
· We update the link/image on Talent Gateways. 

Having individual RSS feeds for candidates coming into their site requires the client to save the 
candidate’s search criteria, make the call to 2xB’s web service, save the results into an XML file, provide 
that link to the candidates for their RSS reader, and then update the XML file at appropriate intervals. 
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RSS Sample Input XML sent to the Web service 
To request all the featured jobs that appear on the TG: 
 
<?xml version="1.0" encoding="utf-8"?> 
<Envelope version="01.00"> 
 <Sender> 
  <Id>10540</Id> 
  <Credential>11721</Credential> 
 </Sender> 
 <TransactInfo transactType="response" transactId="827db146-c576-4b2b-b997-
9eb59a7ea7ec"> 
  <TransactId>10/24/2008</TransactId> 
  <TimeStamp>12:00:00 AM</TimeStamp> 
 </TransactInfo> 
 <Unit UnitProcessor="SearchAPI"> 
  <Packet> 
   <PacketInfo packetType="data"> 
    <packetId>1</packetId> 
   </PacketInfo> 
   <Payload> 
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    <InputString> 
     <ClientId>11721</ClientId> 
     <SiteId>6129</SiteId> 
     <PageNumber>1</PageNumber> 
     <OutputXMLFormat>1</OutputXMLFormat> 
     <AuthenticationToken/> 
     <HotJobs/> 
     <ProximitySearch> 
      <Distance/> 
      <Measurement/> 
      <Country></Country> 
      <State/> 
      <City/> 
      <zipCode/> 
     </ProximitySearch> 
     <JobMatchCriteriaText/> 
     <SelectedSearchLocaleId/> 
     <Questions> 
      <Question Sort="No" Sortorder="ASC"> 
       <Id>1323</Id> 
       <Value>TG_SEARCH_ALL</Value> 
      </Question> 
      <Question Sort="No" Sortorder="ASC"> 
       <Id>1304</Id> 
       <Value>TG_SEARCH_ALL</Value> 
      </Question> 
      <Question Sort="No" Sortorder="ASC"> 
       <Id>1292</Id> 
       <Value>TG_SEARCH_ALL</Value> 
      </Question> 
<![CDATA[TG_SEARCH_ALL]]></Value>  </Question>    </Questions>    
     </Questions> 
    </InputString> 
   </Payload> 
  </Packet> 
 </Unit> 
</Envelope> 

Description of  Tags  
· <Id>12345</Id> employee ID of an active 2xB user. (e.g.  12345 is the employee ID we have 

given to the TAS Ops user). This is available in WB > Tools > Users > Administer 2xB users > 
Edit user > Employee ID. 

· <Credential>25317</Credential>, <ClientId>25317</ClientId> these two tags are the 
partner id of the TG for which 2xB needs to perform the web search 

· <SiteId>5312</SiteId> is TG site ID 
· <OutputXMLFormat>2</OutputXMLFormat>-:  
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 The XML format, either:  
 0—XML 
 1—RSS 
 2—Link  
 This tag defines the output format that needs to be generated after performing the web 
search. Give 0 to get XML, 2 to get links.  
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Candida te  Form Fie lds  – Graphica l Options  
A new option attribute allows your organization to substitute configured graphical icons or colored text for plain 
text option values on panel displays. 

Product 
 

þ 2x BrassRing 
þ New UI 
þ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
You can now configure graphical icons or colored text to replace plain text option values stored in candidate 
forms. This makes it easier for users to quickly assess the value of the field across several candidates in panels 
and views. 
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Once configured, icons and colored text for candidate field options will display for: 

• Requisition folders (candidate grids) 

• Working folders (candidate grids, Active & Inactive) 

• Inbox (candidate grids) 

• My candidates views (Candidates | My Candidates | <HR statuses>) 

• Candidate Results panel 

They will not display for: 

• Candidate search results or Candidate quick search 
• Filter folder views (Req, Working, or Inbox) 
• Req grids or panels 

Other Limitations  
• Candidate forms – view mode 

Because forms can be elinked to candidates and other potential external users, the option Description will 
be shown in forms (add, edit and view modes). 

• eLinks are excluded 
Because icons or text color are not being represented in Candidate forms – eLinks are therefore excluded 
as well. 

• Auto-fill fields 
Auto-fill fields are out of scope because these field types are not outputtable to candidate grids or 
displayable in Candidate Results panels. 

• Export to Excel 
The Export to Excel function from the candidate grids and panels will export the option description value, not 
the icon 

• List administration in 2xB Admin > Admin + will not be able to change icon or Text color.   
Administration of option icon and/or Text color is in Workbench only. 

• Candidate form fields pulling lists of options from Requisition form fields 
• The configuration of graphical icons and text color on options is only designed for form fields that are 

MAINTAINED in candidate forms. 
• Candidate form fields pulling its list of options from a requisition form field options is out of scope. 
• Importing options 

The ability to upload the appropriate icon code or hex# has not been included. It is anticipated that this 
configuration will be done on fields with less than 10 options and would therefore not be a burden to 
configure manually. 

How Do Clients Get this Feature? 
This feature is controlled by new settings in candidate field option administration. Please contact your CSC or 
Certified Workbench User for more information. 

Workbench Self-Service Certified Users 
The configuration of the graphical indicators for options is in the “Administer field options” and “Add/Edit field 
options” screens for candidate forms.  

Tools > Forms > Candidate forms > Administer form fields [for selected form] > Administer field options 
[for selected field] > Add new option | Edit icon [for selected option] 

A new column on the listing of the field’s options displays the icons or text color for the option.  
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Administer field options > Edit option screen before and after  

 
To choose the icon or text color: 

1. Select Add new option, or the Edit icon for an existing option.  
• You can apply icons/colors only for Single-select and Radio button field types with a finite list of options. 

(Multi-select and Checkbox field types are not outputtable to views or panels, so configuration of 
icons/text colors is not allowed.  

• The icon or color represents the option Description (not Code) 
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2. On the Edit/Add field options page, click Choose icon 
–OR– 
Select click the color square beside Text Color. 

 
 
Enlarged view of icon set 

 
3. Click the desired icon or color, and click Save. 

View fie ld  op tions  

Candidate form fields pulling their list of options from a requisition form field will not display any graphical 
indicators or colors. 

When options are pulling from another candidate form field’s list of options, a click of the View binoculars icon 
launches the ‘view field options’ screen with a new ‘Icon/Text’ column displaying any icon or text color that has 
been configured for the options. 
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• If no icon or text color has been configured for the option, the option description displays in black text. 
• Candidate form fields pulling their list of options from a requisition form field will not display the ‘Icon/Text’ 

column (since no graphical indicators or colors can be configured for the source). 

Inac tiva te  and  De le te  

The Inactivate field option and Delete field option screens also show the Icon/color configured. You cannot 
delete an option that is in use on a form. 
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Candida te  Forms  – Save  as  Draft 
Candidate forms can now be saved in draft mode with a new “Save as draft” form attribute.  

 

Product 
 

þ 2x BrassRing 
þ New UI 
þ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
When you add candidate forms, you can now save them in draft mode if your user type is selected in a new 
“Save as draft” form attribute/privilege. This is especially helpful when you are working on longer candidate 
forms, discover you need more information, or when you need a form opened for a long period of time, for 
example to capture responses for a lengthy interview.  

To create a draft, you use the Add form functionality. If the form has the appropriate attributes set for your user 
type, you see a new button at the bottom of the form allowing you to save the draft.  Drafts are personal to the 
user.  They are not saved on the Talent Record until they are actually saved as a form.  

Saving  a  Draft 

To save a draft: 

1. Select the Add form action in 2xB (Candidates > Forms > Add Form).  
2. Select the form to be added and click Add form. 
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3. At any point in completing the form, you can save it as a draft by clicking Save as draft. (If you click Save 
instead, a draft is never created.)  

 
• Draft can be incomplete  

When saving a draft, you can leave required fields blank. You can provide partial sequential form data (such 
as approval information) out of sequence; any entered data will be saved along with the draft. However, you 
cannot send drafts for approval. 

• One draft per user per candidate per form 
Each user can have only one draft for each candidate, for each form type: single per candidate, single per 
candidate/req, multiple per candidate, multiple per candidate/req. For example, each user can have one 
draft Offer form for John Smith for Req 123BR. 

• Create only from Add form 
The Save as draft button is available only on the Add form page. It’s not on the View or Edit form pages 
because forms appearing there have already been saved (and are no longer drafts by definition). 

• Drafts are saved for six months 
Six months after last Date Edited, draft forms are automatically deleted. 
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4. After clicking Save as draft, you see a confirmation screen. Click Close to return to the screen where the 
draft/add form was initiated, or return to the draft in edit mode by clicking Return to draft. 

 

Acces s ing  Drafts   

You can access an existing draft to edit it in multiple ways: 

• Add form 
If a draft of that form type already exists for the candidate, the Add form function will automatically display 
your saved draft. 

• Candidates menu > Forms – my saved drafts  
If your user type has the Candidates ‘Forms – my drafts’ menu privilege, you can select Forms – my 
saved drafts from the Candidates menu to open the new Forms – my drafts page. 

 
 

• Quick Links > Forms – my drafts  
If the Forms – my drafts link is available on your New UI Quick Links panel, click the link to open the new 
Forms – my drafts page. (To add the link to the panel if it has been configured and you have the 
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Candidates ‘Forms – my drafts’ menu privilege, click Add > In My Candidates > Forms – my drafts.) 

 

Forms  – m y drafts  Page  

The new Forms – my drafts page lists all your draft forms for all candidates.  This page is accessed via Forms – 
my draft on the Candidates menu or a new quick link in the new UI panel. These will be visible if you have the 
Candidates Forms – my drafts menu privilege. 

 
You can view, edit, or delete your draft forms from this page. Drafts are automatically deleted six months after 
their Date edited date.  

65 of 318



   

 

 

Copyright Kenexa® 2011 Candidate Forms – Save as Draft | 5 

 

• To view the draft, click the Form name link. 
• To open the candidate’s Talent Record, click the Candidate name link. 
• To edit the draft, click its Edit form icon. 
• To delete the draft, click its Delete form icon. 

Editing  Drafts  

When you edit a draft, you can: 

• Save it as a draft again – click Save as draft 
The draft is saved with any changes and its Edited date is updated. 

• Save it as a form – click Save  
The draft is converted into a Form that is saved on the Talent Record, and the draft is deleted.  

You can edit a per-req form draft without being in the Req folder, since the req relationship is already 
established. 

For single per candidate and single per candidate/req form drafts: 

• If the form does not yet exist for the candidate and more than one user has a draft of the form, whoever first 
clicks Save successfully creates the form.  

• Once the form has been saved for that candidate, the next user who clicks the Save button after editing a 
draft would see the “form already exists…” message. They are returned to the form and can Save as draft 
instead (in case the other form gets deleted). 

Dele ting  d rafts  

On the Forms – my drafts screen, simply click the form’s Delete form icon to delete it. Click OK to confirm 
deletion. 

 

eLinks   

The Save as draft button is available for eLinks when recipients’ user type is selected for the Save as draft form 
attribute. The button is there for: 

• eLink blank form 
• eLink Talent Record with form to complete 

Clicking the eLink link will present the Add form page OR the Draft form if a draft of this form type exists for this 
user. 
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A re-click of the eLink in the email will launch the draft. 

Best Practice Recommendations 

• Review and possibly consider increasing eLink expiration security if any forms are going to be sent to eLink 
recipients and allowed to be saved as a draft.  The ONLY way for a eLink recipient to get access to their 
draft form is to re-click an eLink.    

• Be sure that a non-system user eLink recipient saves the email until that draft is converted to a form. If 
they lose or delete the email, there is no way to retrieve or resend the draft for that eLink recipient as drafts 
are personal to the ‘user’ and not ‘saved’ in the system in a general location for administrators to access and 
re-send. 

How Do Clients Get this Feature? 
This feature is controlled by a new user type privilege and new candidate form attribute, set for selected user 
types. A new link is also available for the Quick Links panel of the New UI. Please contact your CSC or Certified 
Workbench User for more information. 

Workbench Self-Service Certified Users 
Enable this feature by: 

• Setting the form attribute at form template level to allow a form to be saved as a draft when adding it 
• Granting the new user type privilege to access the saved drafts via a Candidates menu item 
• Configuring the Quick Links panel in the New UI to place the “Forms – my draft” quick link on the panel. 

Setting  Form Attribu te  

Set the Save as draft – Save / modify / delete my attribute to allow users to save a form as a draft when 
adding it. 

Tools > Forms > Candidate forms > Add new form | Edit form attributes [of selected form] 
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Selected user types on the multi-select list will have the “Save as draft” button available on the candidate form 
when initially adding the form. The selected user types must already be selected for the “Add/View/Modify my” 
attribute.  

Granting  Us e r Type  P rivilege  

To allow users to access their own saved draft forms (for all candidates) via the new Forms – my drafts item on 
the Candidates menu, give them the Candidates – ‘Forms – my drafts’ menu user type privilege.  

Tools > Users > User types > Edit type permissions > Candidate actions 3 
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Configuring  Quick Link 

Configure the Quick Links panel in the New UI to place the “Forms – my draft” quick link on the panel. 

Tools > Settings > Panel configurations > Quick links > Administer configuration > Add new 
configuration | Edit [selected configuration] 

5. Click List> to search for the link to add. 
6. Drag the Forms – my drafts link to the Selected side and click Submit. 
7. Click Save to save the configuration. 
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User types without the Candidate actions 3 “Candidates – ‘Forms – my drafts’ men” privilege will not see the 
‘Forms – my draft’ quick link, even though it is in the master configuration of the Quick Links panel. 

70 of 318



 

 

Candida te  Forms  – View in  Us er Language  
This feature provides the ability to view candidate forms in the 2xB user’s base language when the forms have 
been created in a different language by the candidate.  

 

Product 
 

þ 2x BrassRing 
¨ New UI 
þ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
þ Specific conditions required – see details below. 
¨ Configuration required – contact your CSC for implementation details. 

Feature Description 
With this feature, 2xB users can now read a version of candidate forms that have been created by candidates in 
a different language. For example, if a candidate fills out a form in Spanish, an English user can view a version 
in English. The user simply clicks a link to see a version of the form in the user’s own language. 

This requires that a new form attribute called Enable Language Toggle be set for the form in Workbench.  

• If this setting is checked, an additional link is displayed at the top right corner of the form when the form is in 
a language different from the user’s.  
Clicking the link displays a translated version of the form in the user’s base language. Only fields that are 
translated are displayed, that is, the form template must be translated in the user’s base language. Text 
responses are displayed as entered by the candidate. 
The link applies only while a user is viewing the candidate form. 

• If this setting is unchecked then no link is displayed. 

2xB User Experience 
When the 2xB user views a candidate form (with the attribute set) completed by a candidate in a different 
language, a toggle link for the user’s base language is available. Clicking the link shows the responses in the 
user’s language. 
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Candidate form with toggle button for language 

 

How Do Clients Get this Feature? 
This feature is controlled by a new form attribute. Please contact your CSC or Certified Workbench User for 
more information. 

Workbench Self-Service Certified Users 

Enable  Language  Toggle  

Set the form attribute in Workbench to allow the form to display the language toggle link functionality in 2xB. 

Tools -> Forms -> Candidate Forms -> Add new form | Edit Form Attributes [for selected form] 
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• If this setting is checked, an additional link is displayed at the top right corner of the form when the form is in 

a language different from the user’s.  
Clicking the link displays a translated version of the form in the user’s base language. Only fields that are 
translated are displayed, that is, the form template must also be translated in the user’s base language. Text 
responses are displayed as entered by the candidate. 
The link applies only while a user is viewing the candidate form. 

• If this setting is unchecked then no link is displayed. 

Trans la te  Forms  

Forms must be available in the user’s base language. The following path provides a convenient way to translate 
the fields (this is existing functionality): 

Tools -> Forms -> Candidate Forms -> Add new form | Administer Form Fields [for selected form] -> 
Translate fields 
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Candida tes  – J ob  Res pons e  Scores  
Candidate scores for Talent Gateway, Gateway Questionnaire, and Job Response Form questions are now 
static. They will remain unchanged if scoring on the posting is adjusted or if the question is removed from the 
posting. 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes ¨ No – requires specific conditions / configuration for visibility. 
þ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

þ Automatic – see details below. 
¨ Specific conditions required – see details below. 
¨ Configuration required – contact your CSC for implementation details. 

Feature Description 
Candidate scores for TG/GQ/Job Response Form questions are now static. They will remain unchanged if 
scoring on the posting is adjusted or if the question is removed from the posting. The score will be stored with 
the candidate on the response forms. 

Previously when a requisition was posted to a Talent Gateway and the questions were scored, the question 
scoring for the candidate – on the Talent Gateway form and Job Response Form (response forms) – was 
calculated dynamically based on the current scoring in the posting. The following scenarios could occur when a 
candidate had already received a “score”:  

• Old behavior: When the question was removed from the posting, the question and response still 
appeared on the response forms, but the scoring was removed. 
New behavior: Question, response, and score all still appear on the response forms. Total score 
remains the same, and the individual response form scores add up to that total. 

• Old behavior: When the scoring on the posting changed (edited via Edit site questions), the 
candidate’s score changed as well for that posting, for that question on the response forms. 
New behavior: Question, response, and score remain unchanged on the response forms. Total score 
remains the same, and the individual response form scores add up to that total. 

For example: 

Question A is posted to the TG; Option 1 is scored 30 

John Smith submits on 1/30/2011 and answers Question A with Option 1 

Job Response Form shows Question A; Option 1; score of 30 

On 2/15/2011, Question A is removed from the posting 

John Smith’s JRF for 1/30/2011 continues to show Question A; Option 1 with score of 30 (previously 
would have shown Option 1, but with no score) 

Candidate’s Total score (for all questions) has always been static, so Total score does not change. Now the 
JRF & TG response forms are also static and remain unchanged (previously they would not add up to the 
total after a change). 

Gateway Questionnaire response form question scores were always static – no change has been made to the 
behavior there. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. 
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Candida tes  – Limiting  Number Manually Filed  to  Req  
This feature allows you to limit the number of candidates that can be manually filed, moved or copied into a 
requisition folder. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
þ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
Your organization can limit the number of candidates that can be manually filed, moved or copied into a 
requisition folder. When enabled, the limitation of candidates being manually added to req folders is done on a 
requisition template level. 2xB users can set the specific Candidate Limit number when adding or editing the 
requisition, so each position could have a different limit.  

When a limit is set, the system allows candidates to be filed, moved or copied into a req when: 

• Number of candidates currently in the requisition folder is less than the Candidate Limit  

AND  

• Number of candidates selected to be filed, moved or copied into the folder is less than or equal to the 
difference.   

After each file, move or copy attempt, 2xB re-checks the number of candidates currently in the requisition folder 
against the Candidate Limit number.  When they are equal, the pre-designated field called Candidate Limit 
Status changes from ‘Unfilled’ to ‘Filled’. The field can be configured for search and output. 
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2xB does not consider these settings when filing candidates into requisition folders by Auto-file or Insta-file, 
Candidate import integrations, Saved Overnight searches, filing to a folder as a result of Rules Automation 
Manager or other custom triggers. 

File /Move/Copy Candida te  in  2xB 

When a 2xB user attempts to file, move, or copy one or candidates to a req where the candidate limit has been 
filled: 

 
They see a message similar to this one informing them they have exceeded the candidate limit: 

 

77 of 318



   

 

 

Copyright Kenexa® 2011 Candidates - Limiting Number Manually Filed to Req | 3 

 

Or this message when moving or copying one or more candidates to multiple reqs:  

I 

Sea rch  

If the Candidate Limit field is configured as a searchable field, 2xB users can search for requisitions that have 
available capacity. Use the Reqs > Search reqs functionality with the Candidate Limit Status field as a criteria.  
Users can search for requisitions that have capacity (Candidate Limit Status = Unfilled) or for requisitions that no 
longer have capacity (Candidate Limit Status = Filled). 

Limitations  
The system does not limit the number of candidates that an individual user can manually file/move/copy into a 
requisition folder if it is within the limits of the Candidate Limit. 

How Do Clients Get this Feature? 
This feature is controlled by a new client setting, and a new req template setting. Please contact your CSC for 
more information about enabling this feature.  

Workbench Self-Service Certified Users 
Once the client setting is enabled, this new req template setting and numeric limit field become available in 
Tools > Forms > Reqs > Req forms > Edit form attributes [for selected template]: 

• Limit # of candidates allowed to be manual filed/moved/copied into req folder 
• Candidate Limit field (numeric) 
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Click the Yes radio button to place the Candidate Limit field on the req, then select the field from the list of active 
numeric fields on the req template. 
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Candida tes  – Search  Privilege  Res tric tions  
New user type privileges provide restrictions for candidate search functions. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes ¨ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
¨ Configuration required – contact your CSC for implementation details. 

Feature Description 
You can restrict candidate search to allow users Quick Search only, and only of their own candidates. Another 
privilege can hide Filter Folder functionality by user type.  

Quick Search  Only (My Candida tes  Only) 

User types with the new Quick Search Only (My Candidates Only) privilege have no search capability other 
than Quick Search, which they can use to search by first and/or last name of their own candidates only.  

Searchable candidates will include: 

• Candidates in Req folders with which the user has a My Reqs relationship. The search will only be run on 
Reqs in Open, On Hold, or Closed statuses. 

• Candidates in the user’s working folders (both active and inactive) and Inbox. 

User types with this restriction will not be able to use full-function searches in 2xB, including: 

• Candidates > Search (both new UI and classic) 
• Candidates > Saved Search (both new UI and classic) 
• Candidates > My Candidates > Find (both new UI and classic) 

Hide  Filte r Fo lder 

User types with the new Hide Filter Folder restriction will not be able to filter folder results or set filter options 
on any 2xB pages, including: 

• Candidates in Req > Filter (new UI) 
• MyCandidates > Filter (new UI) 
• Req Folder (all Req statuses) > Set Quick Filters (classic) 
• ReqFolder > Filter this Folder (classic) 
• Candidates > My Folders > My Open Reqs (classic and new UI) 
• Candidates > My Folders > Inbox (classic and new UI) 
• Candidates > My Folders > Working (classic and new UI) 
• Candidates >My Folders > Inactive (classic and new UI) 
• Quick Search results > Set quick filters 

How Do Clients Get this Feature? 
This feature is controlled by new user type privileges. Please contact your CSC or Certified Workbench User for 
more information. 
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Workbench Self-Service Certified Users 
Set the new search restrictions in Tools > Users > User types > Edit type permissions > Search 

• To make Filter Folder and Set Quick Filters options unavailable to the user type, check the Search privilege: 
Hide Filter Folder 

• To restrict search functionality to Quick Search of user’s own candidates, check the Search privilege:  
Quick Search Only (My Candidates Only). 

 
There are no dependencies on other settings for either of these privileges. 
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Communica tion  His to ry – Sens itive  Attachments  
This feature enforces sensitive attachment privileges for the Talent Record Communication History.  

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes ¨ No – requires specific conditions / configuration for visibility. 
þ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
þ Specific conditions required – see details below. 
¨ Configuration required – contact your CSC for implementation details. 

Feature Description 
When sensitive attachments (attachment or document with “Sensitive” category) are uploaded to a candidate’s 
Talent Record, they are not visible on the Attachments tab of the Talent Record to users without viewing 
privileges. However, when stored communication history is configured, links to these attachments previously 
could be viewed, via the Communications tab. This occurred if a user (with privileges to view stored 
communication history) selected an Email template or Document Packet template communication that included 
a sensitive attachment. The attachment could be viewed by clicking its link. 

With this feature, this loophole is corrected. Restrictions on viewing sensitive attachments are now enforced on 
the Communications tab (classic) and Communications Action Log (New UI). Users without privileges to view 
sensitive attachments will no longer see links to those attachments in the attachment section of the saved 
communication. Instead they will see the attachment name as plain text only. 
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How Do Clients Get this Feature? 
This feature is available automatically without configuration if stored communication history has been enabled 
for your organization. It affects users who have privileges to view communications as links, specifically when 
sensitive attachments are in use. 

Workbench Self-Service Certified Users 
In order for a user to view communications as links, one of the following privileges must be selected in  
Tools > Users > User Types > Edit type permissions > Candidate Actions 2: 

• “View all stored communication history” allows user to view stored communication history for all candidates.  
• “View stored communication history for my reqs only” allows user to view stored communication history for 

those communications generated from req folders in which they are a req team member. 

This feature affects sensitive attachments and documents: 

• Sensitive attachments are those for which the Attachment Category has the attribute “Sensitive attachment 
category” set to “Yes” in Workbench: 
Settings > Attachment Categories > Add new attachment category | Edit > Sensitive attachment 
category  

• Documents can also be sensitive attachments, when generated from a “sensitive” document template and 
emailed/uploaded to the Talent Record. A sensitive document template is one created with Sensitive set for 
the “Select attachment category for generated documents” setting (in the 2xB Admin module). 

Sensitive attachment file names will be shown in the communication text as plain text, rather than as links, for 
users without appropriate sensitive attachment privileges, also set in: 
Tools > Users > User Types > Edit type permissions > Candidate Actions 2 

• “Attachments  – Sensitive attachments in my reqs only” privilege. Users will see link only when viewing a 
candidate filed to their own req, otherwise they will see the file name in plain text. 

• “Attachments  –Sensitive attachments – all” privilege. Users with this privilege will see links for all 
attachments, including sensitive attachments. 

2x BrassRing Admin/Admin+ Users 
In order for an email message to display as a link on the Communication history section of the Talent Record, 
the Email Template being used should have the “Save copy of correspondence” set to Yes in: 
2xB > Admin> Communications > Add/Edit email template page. 

“Sensitive” documents are generated from document templates created with Sensitive selected for the “Select 
attachment category for generated documents” setting in: 
2xB > Admin> Document Templates> Add | Edit Document Template 

2x BrassRing Users  
The sensitive attachments affected by this feature can be uploaded by 2xB users: 

2xB > Navigate to Candidate Talent Record > Attachments > Upload attachment > Select category that 
has been configured as sensitive. 

The following figures show a Talent Record that had a sensitive attachment uploaded via Upload attachment or 
via Create document from a document template with the Sensitive attachment category. The figures show the 
view of the Talent Record from within a Req folder in which the user does not have the appropriate “View 
Sensitive attachment” privilege, therefore the attachment name (yellow indicator) is in plain text. 
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View email communication pop up (Classic): Talent Record>Communications tab>Communication link for email 
“Type”>Communication pop up 
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View email template (New UI): Talent Record>Action Log>Filter by “Communications> Name/Type link for Action “Communication 
– email”>Communication pop up 

 
 

The following figures show a Talent Record that had a sensitive document attachment posted to a Candidate 
Portal, and then attached via Send communication>Document Packet template. The figures show the Talent 
Record viewed from within a Req folder for which the user does not have the appropriate “View Sensitive 
attachment” privilege. 
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View Document Packet (Classic): Talent Record>Communications tab>Communication link for Document Packet 
“Type”>Communication pop up 
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View Document Packet (New UI): Talent Record>Action Log>Filter by “Communications> Name/Type link for Action 
“Communication – Document Packet posted”>Communication pop up 
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Communica tions  – Acces s  to  HTML Source  Code  Editor 
This feature gives template administrators who are skilled in html coding direct control over the source code for 
their blurbs, document templates, and email templates. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
For organizations using html intensively to apply formatting styles and branding to their templates, access to the 
HTML Source Code Editor is extremely helpful. Once this feature is enabled, template administrators can 
access the HTML source code view of the HTML editor for: 

• Add | Edit blurb 
• Add | Edit document template 
• Add | Edit email template 
• Add | Edit document packet 
• Add | Edit System email template 
• Create document 
• Send communication (document packet, email, agency contact) 

To use the HTML source editor, simply click Source or the source icon in the editing ribbon for the HTML tab on 
one of the above pages. 
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HTML source editor for Create document (Create document action on the Talent Record) 

 
HTML source editor for Communications templates and blurbs (Admin > Communications > Add/Edit document template | email 
template | blurbs | document packet template | system email template) 

 

89 of 318



   

 

 

Copyright Kenexa® 2011 Communications - Access to HTML Source Code Editor | 3 

 

YUI Editor’s HTML Source Code Icon (shown for Add blurb) 

 
YUI Editor’s HTML Source Code Icon (shown for Admin+ > Add system email template) 

 

 
Users may still be restricted in the HTML tags they can enter into the source code 
editor unless the “Allow restricted HTML in approved fields” client setting is also 
enabled. 
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Examples  

Clicking Source here: 

 
Shows following screen in the source code editor: 

 

How Do Clients Get this Feature? 
This feature is controlled by a client setting. Please contact your CSC for more information about enabling this 
feature.  
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Communica tions  – Date  Fie ld  Format Options  
Communications template administrators in 2xB can choose formatting options when inserting a date merge 
field in communication templates. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
This feature provides a variety of date formatting options primarily appropriate for US and UK locales (with more 
locales to be added in future phases), as well as the official ISO format yyyy-mm-dd, the official date format for 
many governments. These options can be overlaid on the date format that comes from the system. Template 
administrators can now specify the formatting for date merge fields when inserting them on the following pages: 

• Add | Edit blurb 

• Add | Edit document template 

• Add | Edit email template 

To add a date merge field with formatting: 

1. On the Admin > Communications > Add/Edit document template | email template | blurbs pages, 
position the cursor and select the variable group and date merge field. 
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2. To use default formatting (current functionality) click <<Add. 
–OR– 
To select formatting options (new functionality), click <<Add date field with formatting. The pop-up Add 
formatting to date field window opens. 

 
 

3. Select the desired format and click Add. The date merge token with the selected formatting is inserted into 
the main body of the blurb, document template, or email template. 

4. Complete and save the template or blurb. 

Best Practice Recommendations 
Users should select a date format option appropriate to their locale.  

Limitations and Known Issues 
• Date format options using month name spelled out are in English only in Phase I. 
• Date formats are literal – they do not detect a change in candidate locale. 
• Date field formatting is not supported for letter templates, document packet templates, or system email 

templates. 

How Do Clients Get this Feature? 
This feature is controlled by a new client setting. Please contact your CSC for more information about enabling 
this feature.  
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Communica tions  – Numeric  Fie ld  Format Options  
Communications template administrators in 2xB can choose formatting options when inserting a numeric merge 
field in communication templates. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Various numeric fields available in both Req and Candidate forms can be used as merge fields in 
Communications templates. Template administrators can now specify the formatting for numeric merge fields 
when adding them. 

To add numeric merge field: 

1. On the Admin > Communications > Add/Edit document template | email template | blurbs pages, 
position the cursor and select the variable group and numeric merge field. 

 
2. To use default formatting (current functionality) click <<Add. 

–OR– 
To select formatting options (new functionality), click <<Add numeric field with formatting. The pop-up 
Add formatting to numeric field window opens. 
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3. Select the desired format and click Add. 
4. Complete and save the template or blurb. 

This is supported for  

• document templates 
• email templates 
• blurbs  

Limitations and Known Issues 
Numeric field formatting is not supported for letter templates, document packet templates, or system email 
templates. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. 
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Communica tions  – Req  Tokens  fo r Email Subjec t Line 
Email template administrators can manually enter existing req ID and req title merge tokens in the subject line of 
email templates. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Template administrators can manually enter tokens for two standard Req fields into the subject line of email 
templates. The tokens are: 

• [#RequisitionStd:Auto req ID#] (or customized name) 
An existing token that executes on either Auto Req ID or Optional Req ID, depending on your ‘Req 
Trigger’client setting, which can be set to ‘Auto’ or ‘Optional’. 

• [#RequisitionStd:Title#] (or customized name) 
An existing token for the Standard Req field, ‘Title’ 

Tokens reflect any customization of the field names. You can use the tokens in user-initiated, automated 
(Automation Manager/Rules Automation Manager), and Agency email templates. Template type can be “Manual 
Send”, “Auto Send,” and” Auto and Manual Send” (set in lower right panel of Add/Edit email templates). 

 

Ad d/Edit Em ail Templa te  

You must manually enter the token(s) into the subject line; you cannot select and insert them from the Merge 
fields control. 

Admin > Communications > Add | Edit email template 
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This tool-tip is available below the subject line field as a quick reminder of the token format: 

“E-mail subject line - You can enter the following tokens (or the customized equivalent) manually 
[#RequisitionStd:Auto req ID#] (for Auto OR Optional Req ID) and [#RequisitionStd:Title#] into this field.” 

At email generation time, the Req ID and Job title are automatically evaluated and instantiated with the correct 
values. 

 
Enter tokens exactly, and be sure to use the customized equivalent if the field has been customized. The email 
shows what you entered if a token does not resolve correctly.  
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Sending  Email Outs id e  o f Req  Fo lder  

When sending emails to candidates, if a 2xB user selects an email template containing one or both tokens in the 
subject line from outside of a Req folder, the following message displays. 

“This email template requires Req Form fields. Please request the template from a req folder.” 

 

Limitations and Known Issues 
• User cannot select the merge field from the Merge fields combo box - merge field token code must be 

entered  manually into the E-mail template subject line. 
• Merge field token code will reflect the customized name of the field. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. 
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Data  Ins igh t Tool – Attachment Counts  
New output field allows reporting on attachment counts for both req and candidate attachments. 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
þ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes ¨ No – contact your CSC for implementation details. 
þ Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
þ Specific conditions required – see details below. 
¨ Configuration required – see details below. 

Feature Description 
This enhancement provides the ability to report on attachment counts for both req and candidate attachments. 
Users with access to manage Data Insight templates can now select the following new Filter, Security, and 
Output fields. They are available for Requisitions, Candidate, and Job Application reports.   

New Fie lds  Requis itions  Candida te  J ob  App lica tion  

Attachment name – name of the attachment 
associated with … 

req candidate job submission for a 
candidate 

Attachment category – type of attachment 
associated with … 

req candidate a job and candidate 

Added on – date and time the attachment 
was…  

added to a 
requisition 

uploaded added 

Added by – name of the user who… added the 
attachment 

uploaded the 
attachment 

added the attachment 

Total attachment count (not available for 
Security User Role filtering) – total number 
associated with… 

req candidate (may 
or may not be 
associated with 
a requisition) 

job application (job 
and candidate) 

 

To add the output field: 

1. In 2xB, select Reports > Data Insight Tool > Manage templates. 
2. Select Create New Template.   

–OR– 
Click Edit Template for a selected template. 

3. Select Output Worksheet. 
4. Expand the desired section: Candidate, Job Application, or Requisitions (for multi-language reqs, 

attachments will display for the req based on the 2xB user’s locale) 
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5. Expand Attachments and check desired report fields.  
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6. For Attachment category, select the desired options: 

 
 
Name  (the default) – output is the attachment category name and count of attachments (in that category) 
Name-count – output is the attachment category name, count of attachments (in that category) and names 
of attachments in that category 
 

7. Complete and save the worksheet. 

 
In the Filters Worksheet in the User Role or Template Wizard, clicking the inverted triangle will add 
the field to the worksheet. 

 

 

Sample  Outpu t (Name-co unt) 

Req  Number Tota l 
a ttachment 

count 

Attachm ent 
name  

Attachm ent 
ca tegory 

Ad ded  on  Ad ded  b y 

10BR 1 Offer letter Offer documents 4/21/2011 1:01 Crusoe, Dian 

20BR 2 Application test Test results 4/21/2011 14:56 Crusoe, Dian 

30BR 3 References 
Reference 
Documents 5/3/2011 12:02 

Crusoe, Dian 

If the “Total attachment count” and the count for the “Attachment Category” are zero, Data Insight returns a zero 
(0) as a result instead of leaving the field blank. 

Attachm ents  b y Locale   

Attachments will display in the 2xB user’s locale. For example: 

• Your organization has three locales: English, French, German.   
• Users create a req in all three languages. Each language could have different attachments, or no 

attachments, for that req.  In this example, the French req version has no attachments. 
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• For the output the English user will see English attachments only, German user will see German 
attachments only, and the French user will not see any attachments. 

• For each language one record will be saved in the table. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. Data Insight template administrators can add the 
fields to templates as desired. 
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Data  Ins igh t Tool – Candida te  Type  for Manual Files  
New output field allows reporting on candidate type history. 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
þ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes ¨ No – contact your CSC for implementation details. 
þ Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

þ Automatic – see details below. 
¨ Specific conditions required – see details below. 
¨ Configuration required – see details below. 

Feature Description 
Previously source of hire reports included candidate type at the time candidates were filed to a req only for 
candidates who applied directly to a req. When a candidate was manually filed to a req, their candidate type at 
the time of application did not display in the output field (Job Application > General > Candidate Type from 
the Output Worksheet).  

This has changed so that candidate type will be available at any time a candidate gets filed to a requisition, both 
when the candidate applies directly and when candidate is filed to the req manually. No user interface changes 
are required. This change is effective if Candidate Type (in the Job Application > General > Candidate Type 
section of the Output Worksheet) is selected in 2xB Reports > Data Insight Tool > Manage templates. 

 
 

Candidate type data: 

• Will now be available at the time a candidate gets filed to a requisition 
• Is the most recent or last candidate type for the candidate 
• Captures any changes made to the candidate type 
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Important things to remember about this feature: 

• The output field section will allow the output relationship to work between a candidate and a req (which is 
the ”Job Application”)   

• When a candidate is manually filed to a req, the candidate type will now display in the output field: 
Job Application->General->Candidate Type   

• When a candidate applied directly to a req, this field is populated with the candidate type at the time they 
applied. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration.  
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Data  Ins igh t Tool – Candida te  Type  His to ry 
New output field allows reporting on candidate type history. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
This enhancement provides the ability to report on candidate type history, so you can capture the transition as a 
candidate type changes through the hiring process. Users with access to manage Data Insight templates can 
now select the new History category added under Candidate -> Candidate Type for Output fields.  

The History category includes these new output fields: 

• Candidate Type 
Displays all candidate types listed for that candidate 

• Updated On 
Displays the update history date and time for that candidate type 

• Updated By 
Displays the historical list of users who updated that candidate type, or “Kenexa 2x BrassRing system 
update” if record is updated by system, or is blank if no user ID is found. 

To add the output field: 

1. In 2xB, select Reports > Data Insight Tool > Manage templates. 
2. Select Create New Template.   

–OR– 
Click Edit Template for a selected template. 

3. Select Output Worksheet. 
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4. Expand the desired section: Candidate > Candidate Type >History and check desired report fields. 

 
 

5. Two options are available for output selection:  
Comma-delimited shows all the records (even if same user updated the candidate type multiple times in 
the same day) in one row, separated by commas. This is the default selection for each. 
Multiple rows report will not show any of the duplicate records. It displays in multiple rows with each row 
representing a different candidate type. 

 
 
You can select only one option for all three fields (selection of different option for each column triggers an 
error message). 
Naming format in comma-delimited file will follow Data Insight standards (resembles [LastName, Firstname] 
and then comma separated). For example:  
[Kenexa 2x BrassRing system update], [Keesha, Venkat], [Hink, David] 

6. Complete and save the worksheet. 
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How Do Clients Get this Feature? 
This feature is available automatically without configuration. Data Insight template administrators can add the 
fields to templates as desired. 
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Data  Ins igh t Tool – Databas e  Fie ld  Names  
You can now display the database field names for custom fields as well as the labels in filter, security, and 
output settings. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
A new client setting allows you to display the database field names for custom fields as well as (or instead of) 
the labels in Filter, Security, and Output settings. This allows Data Insight users to distinguish between form 
fields with the same labels/display names, avoiding inefficient, repetitive report generation formerly needed 
sometimes to identify required fields. Options include: 

• Display name and Database name 
Displays name and the database name in brackets for that form field 
Example: Academic or Work Status [WorkStatus] 

• Display name  
Displays full display name for that form field 
Example: Academic or Work Status  

• Database name 
Displays database name in brackets for that form field 
Example: [WorkStatus] 

This setting applies to custom fields only, not standard fields, and is available for all forms that contain custom 
fields:  

Forms 

• Forms->Form fields->select form->form field displays  

Requisition 

• Requisition>Subsidiary Forms>select form>form field displays 
• Requisition>Addendum Forms>select form>form field displays 
• Requisition>Custom> select form>form field displays  
• Requisition>Shared> select form>form field displays  

All of Data Insight Tool user interface and the reports themselves will show the chosen format for the labels:  

• Filters 
• Output fields 
• Role filters 
• Column headers in the worksheets in Data Insight  
• Column headers in the Data Insight Results.  

Your organization can also make no changes and continue with the default of “Display name.” 
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When a user selects “New Name” on the Output Worksheet, the client setting option is 
overwritten and “New Name” value is displayed in the report, allowing overrides where 
necessary. 

Samples  

 

How Do Clients Get this Feature? 
This feature is controlled by a new client setting. Please contact your CSC for more information about enabling 
this feature.  
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Data  Ins igh t Tool – Event Manager 
For clients with Event Manager, Data Insight can now report on Event Manager events and candidates in those 
events.   

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Event Manager 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
For clients using Event Manager, Data Insight can now report on Event Manager data, including information 
about events and candidates scheduled for those events.  

Users with access to manage Data Insight templates can now select the new fields in Filter and Output 
Worksheets. The fields are found in Reports > Data Insight Tool > Manage templates > Create New 
Template| Edit Template in the trees under the new Event Manager category, and include the fields shown in 
the following figure. 

 
 

110 of 318



   

 

 

Copyright Kenexa® 2011 Data Insight - Event Manager | 2 

 

For complete information on Event Manager and the fields used, see the Event Manager User Guide and Event 
Manager Administrator Guide in this Product Update Guide and on the User Resource Center (available after 
mid-August 2011). 

How Do Clients Get this Feature? 
This feature is available automatically without configuration for clients with Event Manager configured. 
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Data  Ins igh t Tool – Next Approver 
New output field allows reporting on the next approver for pending requisitions with 2xB sequential approval 
process. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
For clients using a sequential approval process, this enhancement provides the ability to report on the next 
approver when the req status is “Pending approval.” This allows you to identify any users not approving in a 
timely manner in the approval process, or simply report on which requisitions are in a pending approval state.   

Users with access to manage Data Insight templates can now select the new Next approver output field added 
under Requisitions > Approval Information.  

To add the output field: 

1. In 2xB, select Reports > Data Insight Tool > Manage templates. 
2. Select Create New Template.   

–OR– 
Click Edit Template for a selected template. 

3. Select Output Worksheet. 
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4. Expand the desired section: Requisitions > Approval Information and check Next approver. 

 
 

5. Complete and save the worksheet. 

All Data Insight users have access to the new field. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. Data Insight template administrators can add the 
field to templates as desired. 
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Data  Ins igh t Tool – Previous  Week Date  Option  
A new option on date filters is available: Previous week. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
Data Insight Tool users will now see a new option on date and date-time filters in the Filter Selection Tool: 
Previous week. The option filters the data for that date field to bring over information from the previous Sunday 
through Saturday. This option is available for all users a 

Reports > Data Insight Tool > Manage templates > Create New Template| Edit Template > Template 
Identity > Template Workshop > Filter Worksheet. 

 

How Do Clients Get this Feature? 
This option is available automatically without configuration.  
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Data  Ins igh t Tool – Req  Subs id iary Form Appro val 
Data Insight now can report on approval data for req subsidiary form approvals with sequential approval 
process.   

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
For clients using a sequential approval process enabled for req subsidiary forms, this enhancement provides the 
ability to report on approval data for the forms.  

Users with access to manage Data Insight templates can now select the new fields in Filter, Security User Role, 
and Output Worksheets. The fields are found in Reports > Data Insight Tool > Manage templates > Create 
New Template| Edit Template in the trees under Requisitions > Subsidiary Forms > Approval Information 
and include the following. 

Filter Output User Role 

Approver name Approver name Approver name 

Approver email address Approver email address Approver email address 

Approver role Approver role Approver role 

Approver status Approver comment Approver status 

Approver status updated on Approver status updated on Approver status updated on 

Next approver 

Approver Status Pipeline > Pending 

Approver Status Pipeline > Approved 

Approver Status Pipeline > Declined 

Where: 

Approver name is the name of the user/approver who approved the req subsidiary form 

Approver email address is email address of the user/approver who approved the req subsidiary form 

Approver role is the approver’s role 

Approver status is the current status of the req subsidiary formn: pending, approved or declined  

Approver status updated on is the date a req subsidiary form was approved/declined 

Approver comment is the approver’s comment, if any 
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Next approver is the name of the next person whose approval is needed 

The three Approver Status Pipeline fields have Date and Duration (days) options 

• Date returns the date the form became Pending, was Approved, or was Declined  

• Duration (days) returns the length of time the form has been in its status 

Approver Status Pipeline > Pending returns data for the form if the approver action is pending 

Approver Status Pipeline > Approved returns data for the form if the approver action is approved 

Approver Status Pipeline > Declined returns data for the form if the approver action is declined 

 
The “Approval information” category does not display if no req subsidiary forms have sequential approval 
enabled. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration when req subsidiary forms have sequential approval 
routing configured. Please contact your CSC or Certified Workbench User for more information. 
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Workbench Self-Service Certified Users 
Approval information is only available in Data Insight if Req subsidiary forms have approval routing configured.  

Set up sequential approval by selecting Sequential as the Approval process in Tools > Forms > Reqs > Req 
subsidiary forms > Edit form attributes 

 
Configure the approval requirements and routing in Tools > Forms > Reqs > Req subsidiary forms > Edit 
form approvals. 
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Data  Ins igh t Tool – Reqs  Pos ted  to  Agenc ies  
New output field allows reporting on which individual Agency Managers (AMs) have submitted candidates for 
particular requisitions over a period of time. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
Data Insight Tool users will now be able to report on which individual Agency Managers (AMs) have submitted 
candidates for particular requisitions over a period of time, including:  

• All the agencies a req was posted to. 
• Which agencies failed to provide candidates  
• Historical req data at the agency level. 

Users will see a new category and several new fields in Reports > Data Insight Tool > Manage templates > 
Create new template| Edit template. A new AM category field, Agency Posting Details, and its subfields 
appear under the category Agency Manager. The new fields will be available in Filter, Security User Role and 
Output Worksheets. 

Fields include: 

Field Definition Paths 

Agency Posting Details provides posting information 
about the req that was posted 
to an individual agency 

Agency Manager 

Agency manager name Agency Manager name Agency Manager > Agency 
Posting Details 

Date req posted date the req was posted to the 
Agency 

Agency Manager > Agency 
Posting Details 

Date req removed date the req will be removed 
from the individual Agencies 

Agency Manager > Agency 
Posting Details 
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To add the output field: 

1. In 2xB, select Reports > Data Insight Tool > Manage templates. 
2. Select Create New Template.   

–OR– 
Click Edit Template for a selected template. 

3. Select Output Worksheet. 
4. Expand the desired section: Agency  Manager > Agency Posting Details. 
5. Check desired report fields.  
6. Select the desired options 
7. Complete and save the worksheet. 

 
In the Filters Worksheet in the User Role or Template Wizard, clicking the inverted triangle will add 
the field to the worksheet. 

 

For historical req posting activity between multiple Agency Managers, select Job Application > Site Name.  

• Data in this category indicates your organization has Agency Managers configured and has reqs posted to 
individual agencies(e.g.,  Agency Manager 1) 

• Agency > General > Agency Name is the actual name of the individual Agencies that the req is posted 
to.(e.g.,Taylor Associates) 

Previously, historical data was captured in 2xB at the Agency Manager site level only, not for individual 
agencies. Data Insight reports could identify if a req was posted to Agency Manager (because that information is 
stored at the site level), but would export the agency's name only if that agency had submitted a candidate. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. Data Insight template administrators can add the 
fields to templates as desired. 
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Data  Ins igh t Tool – Talen t Gateways  Scores  
New filter and output field allows reporting on Talent Gateway scores for Gateway Questionnaires. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
For clients with the existing client settings “Gateway Questionnaires” and “TG Score” enabled, Talent Gateway 
(TG) scores can be shown in 2xB. Now Data Insight Tool can also report on the total TG score. That score is a 
combination of the scores for Gateway Questionnaires (GQs) and Job Specific Questions (JSQs ).  

All Data Insight template administrators will now see Talent Gateway Score Security (User Roles), Filter, and 
Output field options. These options appear on the Output and Filter Worksheets in Reports > Data Insight Tool 
> Manage templates > Create New Template| Edit Template, under Job Application > General.  
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To select restricted field for a user role, go to Reports > Data Insight Tool > Manage user and roles > User 
Role Library > Create a new role| Edit [an existing Role] > User Role Identity > User Role Workshop > 
User. When you set the options for the score, all existing business rules apply for the date range and numeric 
dialog boxes. 

  
 “Talent Gateway Score” is displayed on the User Role Summary page under the “Restrictions” section, with 
“Accessible Data” displaying the numeric criteria selected by the user.  
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How Do Clients Get this Feature? 
This feature is available automatically without configuration for clients with the ““Gateway Questionnaires” and 
“TG Score” client settings enabled. Data Insight template administrators can add the fields to templates as 
desired. 
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Duplica te  S tacking  – Pres e rving  Candida te  S tacking  Fie ld  
Values   
Users can select which stacking field value to retain when manually stacking duplicate candidates. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Previously, when a 2xB user performed a manual stacking action and the application merged the candidate 
information into one record, the desired candidate stacking field was potentially overwritten. Users can now 
select which stacking field value to retain when manually stacking duplicate candidates. A new “Keep this 
stacking field value” checkbox appears on the Candidate overview page when the candidate stacking is 
available for one or both of the records. 
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2xB Us er Exp erience  

When a 2xB user selects two candidates from a candidate grid and clicks Stack duplicates, a pop-up window 
opens to toggle-display the Candidate overview for both candidates.  

Stacking fields empty for both: 

There is no change in the current workflow or appearance of the pages.  

Stacking field values present/shown for one candidate only: 

• For the candidate with the stacking field value, value is shown and new checkbox is checked by default and 
shown grayed out (uneditable). That stacking field value is retained regardless of which candidate is kept.  

• For the candidate without a value, new checkbox in not visible. 

• If you keep the candidate without the stacking field (by clicking Keep this candidate for that candidate), the 
confirmation message includes the text shown in bold font: 
“Please note that by clicking 'OK', the system will keep the overview information for this record. The 
overview of the previous record will be deleted, and all other data will be merged into this record. 
Stacking field value of <Record #:2> will be retained.”  
where <Record #:2> is either LastName, FirstName 1:2 or LastName, FirstName 2:2, based on the 
selection. 

Stacking field values present for both:  

• Stacking field values and new checkbox (checked by default) are shown for both candidates. 

• If you leave the checkbox checked for Candidate 1 when you click Keep this candidate, the confirmation 
will indicate you kept the stacking field value of Candidate 1’s record: 
“Stacking field value of LastName, FirstName 1:2 will be retained.” 
–OR– 
If you uncheck the checkbox option before you click Keep this candidate, the confirmation will indicate you 
kept the stacking field value of Candidate 2’s record: 
“Stacking field value of LastName, FirstName 2:2 will be retained. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. 
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eLink Authen tica tion  – Req  Subs id iary Forms  
For clients with eLink authentication enabled, req subsidiary form eLinks will now be authenticated. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
For clients with eLink authentication enabled, req subsidiary form eLinks will now be authenticated. This affects 
the sending and forwarding of req subsidiary form eLinks as follows: 

• Users cannot send eLinks to non-system users. This is pre-existing functioning for 2xB eLink authentication, 
now extended to req subsidiary form eLinks. 

• If an eLink is sent to a system user (either logged in or not), when the user clicks the eLink or copies and 
pastes the eLink URL into a browser address bar, eLink authentication starts. The user is presented with the 
2x BrassRing login screen. 

• If a user forwards the eLink email to system users or non-system users, when the recipient clicks the eLink 
or copies and pastes the eLink URL into a browser address bar, eLink authentication starts. The user is 
presented with the 2x BrassRing login screen. System users will be able to log in; non-system users will not. 

There is no change in the workflow for clients without eLink authentication.. 

How Do Clients Get this Feature? 
The eLink authentication feature is controlled by a client setting. Please contact your CSC for more information 
about enabling this feature.  
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eLinks  – Inc lude  Req  Info  with  Talen t Record  or Form 
When eLinking a form or Talent Record from within a Req folder, users can now include a link to req details 
within the email. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Users eLinking a form or Talent Record from within a Req folder can now include a link to req details within the 
email.  

On the screens for eLinking the form or Talent Record, a new option is available: Include Req information. 

Req folder -> Select candidate -> Send eLink  
Req folder -> Select candidate -> Display Talent Record > Send eLink | eLink form  
Req folder -> Select candidate -> Add form > eLink blank form 
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This checkbox is shown only if the eLink is sent from within a req folder.  

Sending the eLink with this checkbox checked includes a hyperlink in the email, similar to what is shown in the 
following figure.  

 
The recipient simply clicks the hyperlink to open the Req details in a new window, in read-only mode. (The 
recipient requires appropriate user type privileges to view the req, both for secured and non-secured reqs.  For 
non-system user, Quick Start user privileges apply.)   

Limitations and Known Issues 
This project is specific to eLink Talent Record, eLink blank form and eLink Form only, from within a Req folder 
only. All other eLinks are out of scope.  

How Do Clients Get this Feature? 
This feature is available automatically without configuration. 
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Event Manager – Enhancements  
The following list outlines new features integrated into the Event Manager application from release 12.4 Build 0 
to release 12.5. All of these new features are covered in two newly-released Event Manager Guides, the Event 
Manager Administrator’s Guide and the Event Manager User’s Guide, posted on the User Resource Center 
(URC).  

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
þ Event Manager 

Visible Changes ¨ No – requires specific conditions / configuration for visibility. 
þ Yes – details in Visible Changes document sent for each release build.  

How do I get 
these features? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

New Features 
New Event Manager features provide a more integrated experience for 2xB users. Event Manager functionality 
includes more advanced configuration features for administrators and a more streamlined experience for 
candidates self registering with Event Manager. 

KRB users with Super User and User privileges will see these changes if your organization uses Event Manager 
to associate and then invite candidates to events. 

Features List 
The following list is an introduction to Event Manager features released in 12.5. Following the list is a brief 
description of each feature including abbreviated configuration instructions. Most new features are controlled by 
new client settings. Please contact your Client Service Consultant (CSC) for more information about enabling 
these features. 

Workbench Self-Service Certified Users can refer to the brief configuration instructions following each feature or 
to the Workbench Self Service help for detailed configuration instructions. 

Talent Gateway 

• Talent Gateway Enhancements 
• New Event Invitation Rules 

Event Manager 

• New Event Roster Page 
• New Event Summary and Enhanced Outcomes 
• Event Manager Invitation Enhancements 
• Candidate Overbooking 
• Remote Event Scheduling 
• Event Batch 
• Candidate Facing Event Forms 
• Internal Event Forms 
• Candidate Registration Pages Customization 
• iCalendar Files 
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Talen t Gateway 

Talent Gateway (TG) Enhancements 
The Talent Gateway and Event Manager integration now includes links to the candidate’s current event 
invitations and registrations on a candidate’s talent gateway page. The Event Manager Talent Gateway Page 
displays links to current invitations and registrations. Candidates can choose to follow the current invitations link 
to register for upcoming events or the current registrations link to view or change their present registration 
status. 

This feature is hidden by default and enabled in Workbench. 

How Do Clients Get this Feature? 
Customization of the invitations and registration links on the candidate Event Manager Talent Gateway is 
controlled by a new client setting. Please contact your CSC for more information about enabling this feature. 

Workbench (WB) Self-Service 
Who does this: Certified Workbench User 

Text Cus tomiza tions   

Workbench configuration allows you to customize invitations and registration links on the candidate Event 
Manager Talent Gateway. 

On the WB TG Page: 

1. Go to Tools > Talent Gateway > Text Customization > [Selected Gateway]. 
2. Click Landing Logged In Tab. 
3. Enter Event Invitation text in the Event Manager page link text box. 
4. (Optional) Select the Hide on Gateway checkbox to hide Event Manager information on the Gateway. 

The Event Manager Talent Gateway page is hidden by default. 
5. Enter Summary text in the Event Manager page summary text box. 

 

 
6. Click Save. 

Event invitation information now displays on the Event Manager Talent Gateway page. 
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When a candidate clicks on the Event Invitations on their Event Manager Talent Gateway Page, event 
invitations display as shown below:  

 

New Event Invitation Rules 
The Talent Gateway and Event Manager now integration now includes new invitation rules and additional 
configuration options for the Event Manager Talent Gateway  

How Do Clients Get this Feature? 
Customization of the invitations and registration links on the candidate Event Manager Talent Gateway is 
controlled by a new client setting. Please contact your CSC for more information about enabling this feature. 

Workbench Self-Service 
Who does this: Certified Workbench User 

New Event Invita tion  Rules  

Workbench configuration allows you to customize invitations and registration links on the candidate Event 
Manager Talent Gateway and enable these new event invitations rules.  
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On the WB TG Page: 

1. Go to Event Manager Tab. 
2. Enter Event Invitation text in the Event Manager page link text box. 
3. (Optional) Select the Hide on Gateway checkbox to hide Event Manager information on the Gateway. 

The Event Manager Talent Gateway page is hidden by default. 
4. Enter Summary text in the Event Manager page summary text box. 

  
The following table described configuration choices available on the Event Manager Talent Gateway Page. You 
can use these configuration fields to customize your Event Manager Invitation Page. 

 

Event Manager Options Descriptions 

Event Manager Page Text This is the client configurable message shown on the Event Invitations 
Page.  A candidate will view this when they open the Event Invitation 
Page. 

Event Manager Page Text for No 
Available Registration 

This message displays when no event registrations are available. 

Event Manager Page-Req Folder 
Label 

Configurable Req label. Use the hyperlinked Show Me button to view 
label. display 

Event Manager Page-Req Folder  Use the Radio button to choose what displays on the Req Folder. 
Choices are: Req ID, Job Title, Both 

Event Manager Page Text – 
Processing Page 

This text displays when candidate’s registration is being processed. 

Event Manager Page Text – System 
is Busy Page 

This text displays when the system experiences a delay. 

Processing Threshold Enter number of seconds. Valid value range is: 
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Event Manager 

New Event Roster Page 
Event Manager’s Event Roster page now provides detailed information on candidates scheduled for events and 
also offers candidate management tools. The Event Roster’s default display date is dynamically set to display 
today’s date but is configurable using the Filter > Date Range option on the Actions/Filter/Display access bar as 
shown below. 

 
 

Users can access and change a candidate’s outcome on the Event Roster page and can simultaneously update 
all candidates by using the new Select All option checkbox. Users can click the Select All checkbox (in the 
column heading next to the Candidate Status) to select all candidates. Refer to the following figure. The 
outcome feature is introduced in this document in the Enhanced Outcome section.  

 
There are two new columns available on the Event Roster Page, Arrival and Requisition. Configuration of the 
Arrival column is enabled by the Arrival Timestamp on the Admin: New Outcome page. The Requisition Column 
is a default setting and displays the Requisition associated with the Event Invitation.  

To enable the Arrival Time Stamp in Event Manager, refer to the Event Manager Administrator’s Guide for 
detailed configuration information. 
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Two additional features on the Event Roster Page are Internal Event Form information and View Candidate 
page. You can mouse over a candidate’s name to view candidate information completed on the Internal Event 
Form. You can also click on the candidate’s name to access the View Candidate page. Refer to the following 
two figures. 

 
For detailed information on the Event Roster page, refer to Event Manager User’s Guide.  

How Do Clients Get this Feature? 
Almost all of the Event Roster page enhancements are available to all Event Manager Users without 
configuration. The exception is the “Arrival” timestamp which must be enabled on the Admin: New Outcome 
page by an Event Manager Administrator. If you are an Event Manager Administrator please use the instructions 
that follow. If you are not, please contact your CSC for more information about enabling this feature. 

For detailed information on the Event Roster page, refer to Event Manager User’s Guide.  
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Workbench Self-Service 
Who does this: Certified Workbench User 

Event Manager Administrator 
Who does this: Event Manager Administrator configures the Arrival Timestamp and Editing of Event Display 
Columns. Users may edit column display dependant on user privileges. 

Enabling  the  Event Ros te r Arriva l Times tamp  

Use the following procedure to enable this setting. 

1. In Event Manager go to Admin > List Maintenance > Outcomes on the Menu Access Bar. 
. 

2. In the Actions Menu, click New.  
The New Outcome screen displays. 
 

 
 

3. Choose the arrival timestamp for each outcome you are defining.  
Choices are Update, Undo, Neither.  
If update is chosen and Candidate has no timestamp, the timestamp is updated. If Candidate has a 
timestamp, no change is made.  
If undo is chosen and the candidate has a timestamp, it is removed.  
If neither is chosen, the original timestamp is not changed. 

4. Click Save. 

Editing  Event Ros te r Dis p lay Column s  

Columns display may now be edited on the Event Roster Page. Use the following procedure to enable this 
setting. 

1. In Event Manager on the Event Roster screen, access the Actions/Filter/Display menu. 
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2. Click on the Display drop-down menu to access the Edit Columns option. 

 

 
The Edit Columns dialog box displays. Selected columns are the currently displayed columns. 

 
3. Drag and drop column selections from the Available to the Selected Columns.  
4. Click Save. 
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Editing  Event Ros te r Dis p lay Column s  

Time Zone can now adjust the time zone used to display the date/timestamps on the Event Roster Page. 
Date/Timestamps are stored in the database in Universal Time. Event Time Zone is the default (all 
date/timestamps are adjusted to the time zone assigned to the event). Use the following procedure to enable 
this setting. 

1. In Event Manager on the Event Roster screen, access the Actions/Filter/Display menu. 
2.  

 
 

3. Click on the Display drop-down menu to access the Edit Time Zone option. 
 

 
4. Scroll to Click to choose the Time Zone.  

The Event Roster Screen refreshes and the new time zone is saved as the user’s preference and applied to all 
pages that allow time zone display in effect (Event Roster, Event Summary, History tab of Event Manager 
Candidate record).  

New Event Summary Page and Enhanced Outcomes 
Event Manager’s Event Summary page now provides detailed information on events within a set default time 
frame. Users can view events details (date, time, location) and a range of information about candidate 
participation at those events. The Actions/Filter/Display Menu on the Event Summary page allows users to 
configure new events or use existing events as template for new events, use a number of filtering options on the 
Filter Menu, or change the display options on the Display Menu. Users can view event schedules by clicking on 
a hyperlinked event name in the Event Name column. 
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Event Manager Enhanced Outcome 
Event Manager Enhanced Outcomes are outcomes defined by Event Manager Administrators and serve many 
purposes within Event Manager. Valid Outcomes can be assigned to events and used to track candidate 
participation in those events. For example, you can use identifiers such as registration, reschedule, and 
cancellation as valid outcomes and associate those outcomes with candidate actions. In addition, valid 
outcomes can be used in event invitations and event batches. 

In this release, there are three new settings for Outcomes that can display on the Event Summary page. The 
three settings are Display totals by default, Display Short Name, and Count As. These new settings are defined 
in the Outcomes Table. 

The Count As Outcome setting can be used to track candidate participation. For example, if a Valid Outcome 
has the Count As setting enabled, a user can assign that Valid Outcome to both an event and a candidate. The 
Valid Outcome automatically displays that candidate’s participation (or non-participation) in that event. In the 
following Event Summary example, the two valid outcomes, Attended and Absent, display candidate 
participation for each event. 

 
Outcomes can also be mapped to 2xB HR statuses. Outcomes are disabled by default and must be enabled 
and defined. 

To view detailed information about Event Summary functionality, refer to the Event Manager User’s Guide on 
the User Resource Center (URC). For detailed information on Event Manager Administrator functions, refer to 
the Event Manager Administrator’s Guide on the URC. 

How Do Clients Get this Feature? 
Almost all of the Event Summary page enhancements are available to all Event Manager Users without 
configuration. Event Manager Administrator’s must enable Outcome Display and variable options. If you are an 
Event Manager Administrator please use the instructions that follow. If you are not, please contact your CSC for 
more information about enabling this feature. 
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Event Manager Administrator 
Who does this: Event Manager Administrator 

Enabling  the  Outcome  Dis p lay 

Use the following procedure to enable and define outcomes which can then be set to display in the Event 
Summary page.  

In Event Manager go to Admin > Systems > General setting on the Menu Access Bar. 
 

 
 
The Systems > General page displays. 
 

 
 

5. Use the radio button to Select Yes to enable Enhanced Outcomes. 
6. Click Save.  

Defin ing  the  Valid  Outco mes  

1. In Event Manager, Go to Admin > List Maintenance > Outcomes on the Menu Access Bar. 
. 
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The Admin: New Outcome page displays. 
 

 
 

2. Enter the required information in the New Outcomes fields for each new Valid Outcomes. The following 
table describes the available choices. 
Be sure to Select Yes to choose Valid outcomes by default. Valid outcomes are the only outcomes that can 
be assigned to candidates in the event.  

New Outcome Fields Description 

Outcome name Enter the outcome name. 

Description Enter the outcome description. 

HR Status Use the drop-down list box to select a pre-defined HR status. 
Choosing an HR status maps the defined outcome to the status.  
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New Outcome Fields Description 

Message Template Use the drop-down menu to select a message template to associate 
with this particular outcome.  

Ordinal position Select an ordinal position. The ordinal position controls the position of 
the outcome display in the drop-down field on the Scoring tab of the 
EM Candidate Record. 

Display totals by default* Options are Yes or No. If client wishes to see a particular outcome 
total on the Event Summary screen, choose Yes. 

Display Short Name* Use this field to shorten the Outcome column heading in Event 
Summary only. A short heading allows a more detailed information 
display. 

Counts as* Choices are Attended, Absent, Neither.  
This field can be used for tracking candidate outcomes both during 
and after events. If you want to track Attended or Absent total on the 
Event Summary screen, choose the appropriate option. 

Arrival timestamp on roster Choices are Update, Undo, Neither.  
Event Roster displays the timestamp field. Candidates get one arrival 
timestamp per event. 
If update is chosen and Candidate has no timestamp, the timestamp 
is updated. If Candidate has a timestamp, no change is made.  
If undo is chosen and the candidate has a timestamp, it is removed.  
If neither is chosen, the original timestamp is not changed.  

Valid outcome by default If Enhanced Outcomes are enabled in Systems > General settings, 
this field displays.  
If yes, this outcome applies to all and is selected by default on the 
Valid Outcomes tab for an event template or an event created without 
an event template. Use this option to make it available to most events. 
If no, it is not valid.  

Active Active vs. Non-active. Click the check box if you want this location to 
be active and viewed by users. If you wish to save a draft of this 
location, do not check this box. The system saves the location as 
inactive.  

•   * These three fields are the newly added outcome fields in this release.  

3. Click Save. 

The following two examples show where Event Manager users might access and use their Valid Outcomes.  

Example  1: 

In this example, an Event Manager user is editing an event template and wants to assign Valid Outcomes to that 
template.  
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The Valid Outcomes in the Selected Outcomes column appear in the edited template. 

Example  2:  

In this example, an Event Manager user is sending an event invitation and wants to assign Valid Outcomes to 
that invitation.  

 
If the user chooses Registration as one the Valid Outcomes and the candidate registers, the outcome will 
update the candidate’s HR status.  

Event Manager Event Invitation Enhancements 
Event Manager Administrators can now enable restrictions on event invitations. Those event invitation rules 
include: 

• registration link expiration 
• candidate reschedule restrictions 
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• restriction settings for event invitations 
• enable past event schedules (into future events) 

When these event invitation enhancements are enabled, users can then access and use them when sending 
event invitations. Users can then expire registration links sent in email invitations, set reschedule limitations, 
restrict number of visible events, and allow candidate to reschedule out of past events into future events,  

How Do Clients Get this Feature? 
Event Manager Administrators enable event invitation enhancements. Users then can access and use these 
event invitation enhancements. If you are not an Event Manager Administrator, please contact your CSC for 
more information about enabling this feature. 

Event Manager Administrator 
Who does this: Event Manager Administrator 

Enabling  Event Manager Even t Invita tion  Enhancements  

Use the following procedure to enable event invitation enhancements: 

4. In Event Manager go to Admin > Systems > Scheduling setting on the Menu Access Bar. 
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The Systems > Scheduling page displays. 
5. Use the radio button to Select Yes to enable Registration Link Expiration and Enable Past Event 

Reschedules.  
 

 
 

 
 
6. Click Save.  
With the new Event Invitation Rules enabled, users can now access these options and apply their restrictions.  

Us ing  Event Manager Even t Invita tion  Enhancemen ts  

Use the following procedure to use the event invitation enhancements: 

1. In Event Manager go to Candidate > Unscheduled Candidates.  
2. Select a Candidate using the checkbox next to a candidate’s name.  

Use the checkbox next to the Name field in the Candidate list to Select All candidates. 
 

 
 

3.  Click Send invitation in the Actions menu.  
The Send Message screen displays. 
. 
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4. In the Send Message screen you identify each of the fields to include in the email message. Use the 
following table to complete each field in the Send Message screen.  

The new event invitation enhancements fields in the Send message screen are:  

• Restrict the number of event visible to the candidate by 
• Expire invitation eLink in 
• Maximum online reschedules 

Message Field* Description 

Select message template for 
invitation 

Use the drop-down list box to select a message template. Click Edit 
Message to edit the message.  Refer to Editing Messages. 

Invite to: Use the radio button in combination with the drop-down list box to 
choose: 
 Any scheduled event All events 
 An event type              Type of event 
 An event series         Series of Events 
 An event instance     One time, one date event 
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Message Field* Description 

Restrict the number of event visible 
to the candidate by: 
If enabled by Event Manager 
Administrators, this field is visible.  

This option controls how often and when a candidate is invited to 
event. For recurring events, you can restrict a candidate’s registration 
options by using either the number of event occurrences or time 
frame. For example, if the event occurs every Monday through Friday, 
they may want to restrict the candidate options to just the next two 
weeks’ worth of events or restrict the candidate to the next ten 
available events. 
Use the radio button (in combination with text boxes if necessary) to 
choose: 
 Do not restrict   No restrictions enabled 
 Number of event occurrences Invites candidate to a specific 
     number of events (recurring) 
 Time Frame   Days/Weeks/Months 
 
Use the text box to choose number of events. Only available if you 
choose the Time Frame option.  
 Minimum number of events to display 
Only available if you select Time Frame.  It allows you to prevent 
situations where the timeframe you picked does not have any or 
enough available options 

Expire invitation eLink in 
If enabled by Event Manager 
Administrators, this field is visible. 

This field controls how many days after sending the invitation the link 
remains active (not expired)  
Enter any number of days, valid values 1 through 365. The link is no 
longer active after the specified number of days.  For example, if you 
enter 10 days, the link remains active for 10 days from the date the 
invitation is sent, after which time it expires. 

Maximum online reschedules 
If enabled by Event Manager 
Administrators, this field is visible. 

Use the drop-down list box to set the number of allowed reschedules. 
If a candidate reaches the maximum number of allowable 
reschedules, the system displays a configuration error and does not 
allow the candidate to reschedule. 

Outcomes 
If enabled by Event Manager 
Administrators, this field is visible. 

Outcomes can be used to track a candidate status throughout the 
recruiting process and can be associated with 2xB HR statuses. 
Candidate statuses display in Event Display Information screens. 
Event Manager administrators define and configure outcomes. 

Select outcome for Invited status Displays Invited status 

Select outcome for Registered invite 
status 

Displays Registered status 

Select outcome for Cancelled status Displays Cancelled status 

Select outcome for Rescheduled 
status 

Displays Rescheduled status 
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Message Field* Description 

Upon Registration Use the radio button to select the move or copy option.  
Copy candidate to event:  Makes duplicate of candidate record 
    and moves to event 
Move candidate to event Moves candidate record to event they 
    are registered for 
 
 

Select message template for 
confirmation 

Use the drop-down list box to select a confirmation template. Click 
Edit Message to edit the message.  Refer to Editing Messages. 

Select message template for 
reminder 

Use the drop-down list box to select a reminder template. Click Edit 
Message to edit the message.  Refer to Editing Messages. 

Send Before Event Use the drop-down list box to select the number of days before event 
you want this invitation to be sent.  

5. Click Send. 

Candidate Overbooking Limits 
Candidate Overbooking Limits is a new feature that allows Event Manager users to “overbook” candidates when 
time slot maximums have been reached. Candidates can register until the maximum Candidate levels is 
reached, but Event Manager Users and Team members can overbook time slots. Event Team members can 
better manage time slots using overbooking as it allows for reschedules and cancellations.  

On Event Information Displays, maximum column displays only show maximum Candidate values but Time Slot 
Remaining can register negative values indicating the number of candidates overbooked.  

How Do Clients Get this Feature? 
Candidate overbooking must be enabled by Event Manager Administrators in Event Manager System settings. 
Once enabled, Event Manager users can access this feature. Please contact your CSC for more information 
about enabling this feature. 

Event Manager Administrator 
Who does this: Event Manager Administrator 

Candida te  Overbooking  

Use the following procedure to enable candidate overbooking: 

1. In Event Manager go to Admin > Systems > Scheduling setting on the Menu Access Bar. 
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The Systems > Scheduling page displays. 
 

2. Use the radio button to Select Yes to enable Candidate Overbooking. 
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3. Click Save.  

With overbooking enabled, when a candidates is moved to an overbooked event, the Time slot field displays a 
negative number representing the number of candidates exceeding the overbook limit.  

 
Event Information Time Slot column displays also show negative numbers representing the number of 
candidates exceeding the overbook limit.  

 

Remote Event Scheduling 
Remote event scheduling is now available in Event Manager. Users can schedule Remote Events using the 
event location field set to a remote location allowing the available time slots to display in the remote location’s 
time zone. Events can also be configured without room locations, useful for phone screens. 

How Do Clients Get this Feature? 
Event Manager Administrator must enable remote event location option. Please contact your CSC for more 
information about enabling this feature. 

Event Manager Administrator 
Who does this: Event Manager Administrator. 

Enabling  Remote  Loca tio n  

Use the following procedure to enable remote locations. 

4. In Event Manager go to Admin > Systems > Scheduling setting on the Menu Access Bar. 
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The Systems > Scheduling page displays. 

5. Use the radio button to Select Yes to enable Remote Event Location Option. 
 

 
 
6. Click Save.  
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Event Batch 
Event Batch is an Event Manager function that allows users to configure event-specific automatic responses to 
candidates. Administrators create an event batch and an associated event batch sequence workflow. The event 
batch workflow defines what occurs when a candidate’s HR status triggers a Rules Automation Manager (RAM) 
change. For example, a candidate’s HR status changes to Qualified and triggers the RAM to send an event 
invitation. The event invitation is automatically sent and the candidate self-registers for the event. 

By associating an event batch sequence with an HR status, administrators can use the HR status to automate 
the content and timing of email invitations, registrations, confirmations, and reminder messages generated to 
candidates at different stages in the recruitment process. Because Event Batch uses a candidate’s HR status, it 
needs to be configured in Event Manager, Workbench, and 2xBrassRing. 

How Do Clients Get this Feature? 
Configuration of Event Batch in Event Manager requires configuration in Event Manager, Workbench and 
2xBrassRing. Please contact your CSC for more information about enabling this feature. 

Event Manager Administrator 
Who does this: Event Manager Administrator must enable the Event Batch. 

Workbench – Kenexa CSC 
Who does this: Kenexa CSC are the only ones who can set this RAM trigger. Contact your CSC. 

Workbench Self-Service – Certified Workbench User 
Who does this: Certified Workbench user or Kenexa CSC 

In order for 2xB users to assign an event batch when posting a req, they must have the Posting - 
select/deselect Event Batch user type privilege. Without the privilege, users do not see the Event Batch 
column displayed on the 2xB Posting Options page. 

Use the following procedure: 

1. In Workbench, select Tools > Users > User types > Edit type permissions [for selected type] 
2. Click Set privileges icon for Talent Gateways function. 
3. Check Posting - select/deselect Event Batch. 
4. Click Done, and Save. 

2xBrassRing User 
Who does this:  2xBrassRing user must assign the Event Batch to a Requisition. 

Configuring  Event Batches  

Use the following procedure to configure Event Batches. 

In Event Manager: Access List Maintenance > Event Batch to configure the Event Batch, and assign it a name. 
Refer to the Event Manager Administrator’s Guide for detailed configuration instructions. 

In Workbench:  CSC must configure: 

1. Set a RAM trigger for EACH HR status you intend to use for your Event Batch and associate a RAM trigger 
for each HR status. For each HR status, there must be a corresponding RAM trigger. 

2. Set the RAM trigger rule with the action of “Call Event Batch.” 
3. Customize the Requisition Form by adding the Event Batch field to the Requisition Postings Form. This 

allows recruiters to assign an Event Batch to a requisition form. 
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In 2xBrassRing: 

There are two ways to assign Event Batches to Requisitions.  

For candidates who are moved, copied, or filed to a requisition by a 2xB user, assign the Event Batch to the 
Custom Req Field on the Requisition Form. When a candidate is associated with this req, he/she will be in 
line to be “triggered” according to their HR status. When the HR status reaches the RAM HR status trigger, 
the Event Batch sequence initiates.  

  
For candidates who apply to the Requisition via the Talent Gateway, assign the Event Batch to the req at 
posting time. You must have the Talent Gateway > Posting - select/deselect Event Batch user type privilege 
to do so. 

Open the Posting Options page: 

1. Select a Gateway. 
2. Select the Select Event Batch column to assign the Event Batch. 
3. Click Save.  

 
When candidates apply to the specified requisition and when their HR status reaches the RAM HR status 
trigger, the Event Batch sequence initiates.  

Candidate Facing Event Forms 
Candidate Facing Event Forms are forms presented to candidates during registration. Users can customize 
text fields on these forms and then set the forms to automatically generate when a candidate registers. For 
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example, if a candidate registers for a phone event, you can request their primary and alternate phone 
numbers during registration.  
When a candidate registers and completes the Candidate Facing Form fields, mousing over that candidate’s 
name on the Event Roster displays the candidate’s response. Refer to Event Roster, Candidate Preview. 

 

How Do Clients Get this Feature? 
Configuration of Candidate Facing Event Forms requires new client settings in Workbench and Event Manager. 
If you are creating a new candidate form, contact your CSC for more information about enabling this feature. If 
you are editing an existing candidate form and have Workbench Self-Service permissions, use the following 
instructions.  

Event Manager Administrator 
Who does this: Event Manager Administrator must enable the Candidate Response Form. 

Workbench – Kenexa CSC  
Who does this: Only Kenexa CSC have permissions to create new Candidate Forms in Workbench. 

Workbench – Self-Service  
Who does this: Certified Workbench Users can only edit existing Candidate Forms. 

Configuring  Candida te  Fac ing  Event Forms : 

Use the following procedure to configure Event Batches. 

To configure Candidate Facing Forms: 

In Event Manager: 

1. Access the System > General settings. Select the radio button to enable Candidate Facing Event Forms. 

 
 

In Workbench: 

2. Create the candidate forms you want to use as candidate facing forms and enable the Candidate Facing 
Event Forms attribute “Event Manager Candidate Facing Form” on the candidate form. Enabling this 
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attribute automatically adds two form fields to the form which are automatically populated from the Database 
Field Names, EM_Phone_Number and EM_Alternate_Phone, in the candidate’s record. You can edit the 
form display labels for these fields or delete them from the form. If you choose to edit or delete the fields on 
the form, do not change the Database Fieldnames. 

For example, if you are inviting a candidate to a lunch and want to screen for dietary restrictions, you could 
use one of the Candidate Facing Form fields to request dietary restriction information. In this example, 
dietary information is more pertinent than phone numbers. 

In Event Manager: 

3. Access List Maintenance > Registration Pages; use the drop-down list box to select the Candidate 
Response Form. Events using this registration page enabling this feature. 
 

 
 

4. Access Admin > Templates > Event Templates and open your event template. Use the drop-down list box to 
select the Registration Page. This step links the candidate response form to the event. 

 
 

5. Click Save to save the new template setting. 

Internal Facing Event Forms 
Internal Facing Forms are system generated forms created automatically by the system at the time of a 
candidate’s registration. The internal facing form contains the candidate’s name, the event name and date, and 
the time slot start time. The Internal Facing Event Forms is not visible to candidates. The internal form is 
intended to be used as follow up or feedback form for internal employees (assessors or interviewers).  
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How Do Clients Get this Feature? 
Configuration of Internal Facing Event Forms requires new client settings in Workbench and Event Manager. If 
you are creating a new internal form contact your CSC for more information about enabling this feature. If you 
are editing an existing internal form and have Workbench Self-Service permissions, use the following 
instructions.  

Workbench – Kenexa CSC  
Who does this: Only Kenexa CSC have permissions to create new Internal Facing Event Forms. 

Workbench – Self-Service  
Who does this: Certified Workbench Users can only edit existing Internal Facing Event Forms. 

Event Manager Administrator 
Who does this: Event Manager Administrator must enable the Internal Event Form. 

Configuring  In te rna l Fac ing  Event Forms : 

Use the following procedure to configure Internal Facing Event Forms: 

In Event Manager: 

1. Access the System > General setting on the Menu Access Bar.  
2. Use the radio button to Select Enable Internal Event Forms.  

 

 
In Workbench:  

3. Create the internal facing forms you want to use as internal facing forms and ensure that those forms have 
the Event Manager Internal Event Facing Form attribute set to Yes. The Yes setting enables the Internal 
Event Form. This automatically adds four form fields to the form, candidate name, event name, event date, 
and time slot start time. In Workbench, you can only edit these four internal facing form field’s labels. For 
example, you can change the “Time Slot Start” label to “Interview Time.” These four automatically created 
form fields cannot be deleted. 

You can also add additional form fields to the internal event form. For example, if you are using the internal 
event form in conjunction with an assessment process, you can create new form fields which enable the 
assessor to record a candidate’s performance during an event assessment. Manually created form fields are 
not auto-populated but are completed by event assessors.  
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In Event Manager: 

4. Access Admin > Templates > Event Templates on the Menu Access Bar and open your event template. Use 
the drop-down list box to select the Internal Candidate Form.  
 

 
 

5. Click Save. 

Candidate Registration Pages Customization 
Event Manager Administrators can now customize Registration Pages messages viewed by candidates during 
the registration process. Customization of display messages allows administrators to define different event 
registration responses for different event types and situations. For example, for candidates who register for 
unavailable events, administrators can customize the message to refer candidates to other events, contact 
sources or any number of options.  

How Do Clients Get this Feature? 
Event Manager Administrators configure customized Registration Pages.  

Event Manager Administrator 
Who does this: Event Manager Administrator. 

Configuring  Candida te  Regis tra tion  Pages  Cus to miza tion  

Use the following procedure to customize Registration Pages: 

In Event Manager: 

1. Access the Admin > List Maintenance > Registration Pages to access Registration Pages.    
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2. Click New to add a new Registration Page or use the radio button to select an existing Registration Page 
and Click Edit. . 

 
 

3. Click the Edit Messages button. 
4. The Admin: Registration Pages Messages screen displays. 
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You can edit one, all, or none of these message fields.  
5. Click Save to save the edited Registration Page messages. 
6. Click Save if this is a New Registration Page. If not, return to main Registration Page. 

The New Admin: Registration Pages displays the new Registration Page in the List. 

iCalendar Files 
Event Manager now offers the ability to include iCalendars (iCS) files with candidate or assessor confirmation 
and reminder email related to specific event instances. iCalendar files display as email attachments and contain 
calendar information. Double-clicking on iCS file attachment and saving the file imports the calendar data into 
the recipient’s calendar. 

Event Manager administrators can create, edit, or remove existing iCS files.  To use iCS files, refer to the Event 
Manager User’s Guide on the User Resource Center (URC). For more detailed information about iCS files, refer 
to the Event Manager Administrator’s Guide on the URC. 

How Do Clients Get this Feature? 
Event Manager Administrators have to enable and configure iCS files.   

Event Manager Administrator 
Who does this: Event Manager Administrator.  

Enabling  iCalenda r (iCS) Files       

Use the following procedure to enable iCS files:  
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1. In Event Manager go to Admin > List Maintenance > iCalendar on the Menu Access Bar. 
 

 
 

The Admin: iCalendar screen displays and lists currently configured iCalendar files.  
 

 
 

2. Click New in the Actions Menu.  
The Admin: iCalendar File Configuration screen displays. 
 

 
 
Here you identify and customize all the email fields in the iCalendar attachment. The following table outlines 
the available choices to include on a message template. 

Email Message Field* Description 

iCalendar File Configuration Name Enter name of iCalendar file. 

Description Enter a description of file contents. . 
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Email Message Field* Description 

Create iCalendar files for: Each iCalendar file sends a specific information set. Use the radio 
button to choose: 
 
 Individual Activities 
 
 Activity Name, Room Location, Event Date, Start and End 
 Time of Activity. 
 
 Individual Time Slots 
 
 Event Name, Event Location, Event Date, Start and End Time 
 of Time Slot 
  
 Entire Event 
  
 Event Name, Event Location, Event Date, Start and End Time 
 of Event 

  Active Active vs. Non-active. Click the check box if you want this competency 
to be active and viewed by users. If you wish to save a draft of this 
competency, do not check this box. The system saves the 
competency as inactive.  

Email body (tokens) Tokens are used to automatically generate event related information. 
As each token type generates a particular piece of information, follow 
the guidelines outlined below for each token type. 
These tokens can be selected and dragged as well. 

Use these tokens for event specific 
email communications only. Using 
these tokens for general email 
communications does not generate 
any content. 
 
As a recommended practice, be 
sure to include the 
[em_self_reg_link] token on 
invitation messages to ensure that 
the registration link is in the 
invitation message.  Include the 
[em_recip_schedule] token on the 
confirmation and reminder 
messages so that the candidate can 
see his/her schedule once he/she 
has registered.  

[em_event_template_name] Event template name 
[em_event_name] Event name 
[em_event_description] Event description 
[em_event_date] Event date 
[em_event_location] Event location 
[em_event_owner_name] Event owner name 
[em_event_recruiter_name] Event recruiter name 
[em_event_schedule] Event schedule 
[em_self_reg_link]- Self registration link 

Use this token for assessors 
already scheduled for an event 

[em_assessor_schedule] Assessor’s schedule 

Use this token to represent the 
number of days before an event an 
invitation expires. Best used within 
an invitation message. 

[em_expiration_days] Number of days 

Use this token to indicate a specific [em_expiration_date] Specific date 
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Email Message Field* Description 
invitation expiration date. Best used 
within an invitation message. 

Use this token to represent exactly 
where message attachments 
display 

[em_attachments] Name of attached document  

Use this token to represent a 
sender’s email address 

[em_sender_email] Sender’s email address 

Use these tokens to specify 
recipient and sender information in 
an email.  

[em_sender_firstname] Sender’s first name 
[em_sender_lastname] Sender’s last name 
[em_sender_fullname] Sender’s full name 
[em_sender_email] Sender’s email address 
[em_recip_firstname] Recipient’s first name 
[em_recip_lastname] Recipient’s last name 
[em_recip_fullname] Recipient’s full name 

Use this token for registered 
candidates only. Best used in 
candidate confirmation and 
reminder messages. 

[em_recip_schedule] Recipient’s schedule 
 

 
3. Click Save to save the iCS configuration file. 
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Exports  – Communica tion  His to ry API 
Clients using web services and Kenexa’s authentication Application Programming Interface (API) can query 
candidate specific communications history data. The Summary Communication API provides a means to 
request multiple data elements related to a candidate’s communication (similar to the Communications History 
grid in 2xB). The request can be for either a specific number of records or All records. 

Please contact your CSC for more information about this feature. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 API and Web Services 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 
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Exports  – Outs tand ing  Event and  Activity In vita tions  API 
Clients using Event Manager, web services, and Kenexa’s authentication Application Programming Interface 
(API) can query candidate-specific Events as well as Public Events, which can then be presented on a client-
hosted candidate portal. 

Please contact your CSC for more information about this feature. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 API and Web Services 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 
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Exports  – Res umes  and  J obs  Applied  To  
Clients using web services and Kenexa’s authentication Application Programming Interface (API) can query for 
jobs saved to the candidate’s cart after authenticating the login. Kenexa exports the jobs to the client, who can 
then display as desired on their side and even allow the candidate to drill into the gateway itself to view the job 
details and apply. 

Please contact your CSC for more information about this feature. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 API and Web Services 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 
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Gateway Ques tionnaires  – Filte r Options  
This feature provides a means to filter or limit which options are presented to a candidate during a Gateway 
Questionnaire application. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Gateway Questionnaire (GQ) administrators can designate which options associated with a question widget 
should be hidden from candidates on the GQ.  

Limitations and Known Issues 
• Questions used via the Job Specific Questions (JSQ) widget will not have any filter capability. 
• There is no upload functionality; the options filtering must be manually administered. 

How Do Clients Get this Feature? 
This feature is controlled by new option attributes for GQ question widgets. Please contact your CSC or Certified 
Workbench User for more information. 

Workbench Self-Service Certified Users 
A new checkbox is available for each option associated with a question widget to indicate whether the option 
should be hidden on the GQ. Workbench Self-Service users with access to Gateway Questionnaire (GQ) 
configuration administer this feature in: 

Tools > Gateway Questionnaires > Administer Sections/Pages > Administer Widgets > Add/Edit widget 

Check the option to hide it on the GQ, or check All to hide all options. 
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Checked options will be hidden from the candidate applying to a job using the GQ. For example, the following 
figure shows that only the two unchecked options (above) appear for the candidate; the others were all hidden. 
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Gateway Ques tionnaires  – J SQ Widget 
The existing JSQ (job-specific question) widget is often used to filter candidates out of the applicant pool if 
minimum qualification questions are not met. A new JSQ Group allows for more than one JSQ widget to be 
defined. For example, you can include a set of preferred qualification questions to identify the more qualified 
candidates that are in the applicant pool. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
þ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
¨ Other 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
A new JSQ Group feature allows you to have more than one widget of job-specific questions (JSQ) for a 
Gateway Questionnaire (GQ). A score for the JSQs Scores is displayed along with the candidates once they are 
in the applicant pool for review. 

For example, you may wish to include minimum qualification questions that let you filter candidates out of the 
applicant pool if not met, and preferred qualification questions that let you identify the more qualified candidates 
in the applicant pool. Minimum qualification questions disqualify candidates based on a minimum score, while 
preferred qualification questions provide a reference score for differentiating among qualifying candidates within 
your applicant pool. 

2xB User Experience 
Since more than one group of job-specific questions (via JSQ widget) is now supported, users must differentiate 
which questions go with which group. On the Edit site questions page (for any req posting page with questions 
available), you select from the Group Name list that appears for each question to associate the question with a 
JSQ widget.  
Edit Site Questions Group Association  

 
The Group name column does not appear if no active JSQ groups are configured. The default group is None 
(unless populated with another value by imported job code default data for questions/scoring. 

How Do Clients Get this Feature? 
This feature is controlled by an optional new Workbench setting for JSQ Groups as well as enhanced JSQ 
widgets in Workbench Self-Service. Please contact your CSC or Certified Workbench User for more information.  
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Workbench Self-Service Certified Users 
JSQ widget configuration has been enhanced to support more than one JSQ widget. You define these job-
specific question widgets on the GQ.  This allows for two sets of questions (such as minimum qualification 
questions and preferred qualification questions) to be used jointly, but scored independently. The widgets can 
be used on different pages of the GQ. 

When you define the JSQ widget, you can define which JSQ Group the question set belongs to. Both groups 
can have their own scoring, but only one of the group scores is available to 2xB users via the candidate grid and 
for searching. Only one response form will continue to be populated, and it will contain all question answers.  
Furthermore, each JSQ widget can be defined to be included in other posting default criteria.  

Setting  Up New Widget Options  fo r J SQ Group  As s oc ia tion  fo r Ques tions  an d  Res u lts : 

You set the widgets up in: 

Tools -> Gateway Questionnaires -> Administer Sections/Pages [for selected GQ] -> Administer widgets 
[for selected page]. 

Ques tions  

To set the JSQ Group association and additional attributes for job-specific questions: 

1. Select Add new/Edit widget  
2. Select Complex Widgets, Job specific questions and branching option. 
3. Select JSQ group to be associated with this widget. Default is None. JSQ groups can have one or more 

JSQ questions associated with them, and can be used for multiple GQ’s and/or Talent Gateways. However, 
no more than one instance of each Job specific questions widget of the same JSQ Group is allowed per 
GQ. 
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4. Select a checkbox for the scoring option. (Once saved, the selection cannot be changed for an active GQ.) 
Note: To preserve previous behavior (before this new functionality was introduced), leave 
Associated JSQ Group value as None and check all four of the following boxes. 

• Use this JSQ Widget for candidate grid scoring – use for overall score settings, including the 
following: 
Outputable TG Score field 
Job specific questions score on job response form 
Total score on job response form (as in the example shown here): 
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This means that the questions within this JSQ widget (and any others where this box is checked) are 
used to calculate the TG Score field, which can be output on the candidate grid. On the job response 
form, the JSQ score and Total Score will reflect accurately based on which JSQ Widget and associated 
questions have this checkbox set 

• Use this JSQ Widget for minimum score – use for minimum qualification settings on the posting 
page, including the following: 
*Min Score Required on posting page 
HR status pass on posting page 
HR status fail on posting page 

• Use this JSQ Widget for preferred candidate – use for preferred qualification settings on the posting 
page, including the following: 
*Preferred candidate target score on posting page 
*Notify the following users when a candidate meets or exceeds preferred candidate target on 
posting page 
*Notify the following non-system users when a candidate meets or exceeds preferred candidate 
target on posting page 

• Use this JSQ Widget for minimum score to administer assessment – use for *Minimum score to 
administer assessment setting on the posting page 

If more than one JSQ widget has the same setting checked, then the aggregate of the questions across all 
of the JSQ widgets will be used. 

Res ults  

The next step is to set the JSQ Group association for the JSQ results widget. For any path, a Job specific 
questions - results details widget must be preceded by a Job specific questions widget of the same JSQ 
Group. 

To set the JSQ Group association for results: 

1. Select Add new/Edit widget  

171 of 318



   

 

 

Copyright Kenexa® 2011  Gateway Questionnaires - JSQ Widget | 5 

 

2. Select Complex Widgets and Job specific questions – results details.. 

 
3. Select JSQ group to be associated with this widget. Default is None. JSQ groups can have one or more 

JSQ questions associated with them, and can be used for multiple GQ’s and/or Talent Gateways. However, 
no more than one instance of each Job specific questions widget of the same JSQ Group is allowed. 

4. Activate the GQ. 
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HR Sta tus  – Manual Filing  per Req  Setting  
This feature provides a new req form setting in Workbench to configure the starting HR status when “restricted” 
users are manually filing candidates to a folder. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
A new req form setting can configure the starting HR status when “restricted” users are manually filing 
candidates to a folder. Restricted users are those with the “Restrict start HR status when filing to Req” 
privilege/restriction. The req template setting is Manually file candidate to Req folder by HR status, and it 
works with the user type restriction to control the HR status when candidates are manually filed, moved or 
copied into a req folder. 

To accommodate different HR Status tracking logic flows, clients can set the HR Status to which candidates 
should be filed per requisition template. Clients can also restrict (by user type privilege) the choices of HR 
Statuses when a 2xB user manually performs the “File to Req folder” action. The system checks the Candidate 
actions 3 Restrict start HR status when filing to Req user privilege first. If it is checked, then the system does 
not present the list of available HR Statuses in the File candidates to req screen. Instead, the system presents 
a message: “Initial HR status is automatically selected based on the Req form setting.” 
File to Req folder for restricted user 
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When the user clicks File, 2xB files the candidate to the HR Status selected in the requisition template. If the 
Requisition template’s Manually file candidate to Req folder by HR Status value = ‘None’, then the candidate 
will be filed to 0-Filed. 

For unrestricted users (the user privilege is not checked), current functionality prevails and they choose from a 
list of HR statuses.  
File to Req for unrestricted user 

 

Move/Copy to  Req  Fo lde r 

When a restricted 2xB user performs a Move or Copy to Req action, however, 2xB presents the same radio 
button options, to retain or not retain HR status data, that unrestricted users have. 
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Move or Copy to Req Folder for Restricted AND Unrestricted Users 

 
The following table summarizes how the how candidates will be filed depending on which radio button is 
selected. 

 Req template 
setting = 
None 

Req template 
setting = Start 
status 

User privilege unchecked 
&  
HR Status Options = Retain the HR status data (including 
history) of all candidates in this folder when entered into the 
destination req. 

Filed into 
Current status  

Filed into 
Current status  

User privilege unchecked 
& 
HR Status Options = Do not retain any HR Status data for 
these candidates from this folder in the destination req  

Filed into 0-
Filed  

Filed into 0-
Filed 

User privilege CHECKED 
& 
HR Status Options = Retain the HR status data (including 
history) of all candidates in this folder when entered into the 
destination req. 

Filed into 
Current status  

Filed into 
Current status  

User privilege CHECKED 
& 
HR Status Options = Do not retain any HR Status data for 
these candidates from this folder in the destination req  

Filed into 0-
Filed  

Filed into status 
configured in 
Req template 
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Previously a single requisition template setting (Automatically file candidate to Req 
folder by HR Status through insta-file) controlled initial HR status when candidates 
were filed by Insta or Autofiler as well as when they were being manually filed, moved 
or copied into a req by a user. This project added a second requisition template setting 
that would control the HR status when candidates were being manually filed, moved or 
copied. 

How Do Clients Get this Feature? 
This feature is controlled by a new Requisition template/form level setting. Please contact your CSC or Certified 
Workbench User for more information. 

Workbench Self-Service Certified Users 
The new Manually file candidate to Req folder by HR Status req setting is available for use when adding or 
editing a Req form template.  

Tools > Forms > Reqs > Req forms > Edit form attributes 

 
User types with Restrict start HR status when filing to Req checked can only file candidates into a particular 
initial HR status when filing candidates to requisition folders. If ‘None’ then current functionality of filing to the 
folder manually will be respected (i.e., 0-Filed and all HR statuses that have no pre-requisite). 
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HR Sta tus  Undo  – Res tric t by Us er Type  
This feature provides additional control over the HR Statuses that user types are permitted to “undo.”  

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
A new Workbench administrative setting provides additional control over the HR Statuses that user types are 
permitted to “undo.” For each user type, your organization can choose specific HR Statuses that cannot be 
undone by that user type. When configured, users who have the existing privilege to update HR Status will not 
be able to undo those particular HR Statuses. 

When the current status of the candidate is one of the restricted “undo” statuses, then the “Undo Status” button 
is disabled for the user trying to update it for a candidate in a Req or working folder or Inbox.  

 
In this case, hover text for the disabled button indicates: “You do not have permission to Undo this HR status.”  
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Users still require either the Candidate Actions “HR status - add/update in my reqs/my 
folders/my inbox” or “HR status – add/update in all reqs/all folders/my inbox” privilege 
to update or undo an HR Status. 

How Do Clients Get this Feature? 
This feature is controlled by an administrative user type setting in Workbench. Please contact your CSC for 
more information about enabling this feature.  
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HR Sta tus  Update  – Block on  Count o f Forms  
Clients previously could prevent 2x BrassRing users from updating a candidate to one or more designated HR 
statuses when the specified candidate form(s) don’t exist or haven’t been approved. This was supported only for 
single per candidate or single per candidate per req forms. Support is now extended to multiple per candidate 
and multiple per candidate per req forms. In addition, the number of forms needed can be specified for these 
types of forms. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Your organization may require certain information to be on file for candidates prior to moving them forward in the 
hiring process (for example, an application, background screening, or assessments) and into an HR Status that 
will trigger a candidate export. An HR Status attribute is available that causes the system to block an update to 
the status if required forms are not present.  

Previously, the status update could only be blocked for single per candidate or single per candidate per req 
forms. With this enhancement, you can also block the update to the HR status for specified forms that are 
multiple per candidate and multiple per candidate per req forms. The number of instances can be counted and 
HR status blocked. 

The feature also allows for the number of forms across a req to be considered, with the target candidate’s HR 
status change blocked if the required minimum number of candidates in the req do not have the form. The 
system checks configured “counts” of forms, and blocks the status change if the counts are not met. Counts that 
can be configured are “Within Candidate” (requirement is a certain number per candidate) or “Across 
Candidates” (requirement is a minimum number reached by considering the whole set of selected candidates in 
the req). Your CSC will set the counts based on your specific needs. 

The overall feature does not allow the recruiter or hiring manager to update a candidate’s HR status unless the 
applicable form(s) and associated counts are available. The available configured error message still applies.  No 
other visible changes are present.   

Updating  Candida tes  in  2xB  

2xB users have several ways to update HR Statuses for one or multiple candidates in both the new UI and 
classic 2xB. 
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From a folder in New UI 

 
From a folder in classic 2xB 
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From the New UI Talent Record 

 
From the Talent Record in classic 2xB 

 
With the “Block update” attribute (and perhaps approval requirement enabled), the following rules apply 
everywhere that 2xB users can update the HR status for a single candidate:  

When updating, the Update status window displays with the selected candidate. The system checks whether: 

• Required forms (according to the HR status setup) are attached. 
• Any forms requiring approval have an approval status of Approved (if that requirement has been set for the 

form). 

If the status update is blocked, users see a message similar to the one in the following figure. 
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How Do Clients Get this Feature? 
This feature is controlled by an option on the HR Status attribute Block HR Status update when selected 
form(s) are not attached. Please contact your CSC for more information about enabling this feature. 
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In tegra tions  – Socia l Media  
Kenexa’s integration with social media streamlines job posting to social media sites such as LinkedIn, 
Facebook, and Twitter. It extends candidate and recruiter social media touch points, enriching the candidate 
experience while providing a low-cost prospect pipeline.  

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Social Media Integration 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Kenexa’s integration with social media extends candidate and recruiter social media touch points, enriching the 
candidate experience while allowing 2xB users to: 

• Streamline job posting to social media sites such as LinkedIn, Facebook, and Twitter  
• Locate top talent and create an ‘in-house’ prospect pipeline 
• Reduce recruitment costs through cost-effective sourcing  
• Manage and track social media impact and communication across the recruitment lifecycle from sourcing to 

hire. 

Candidates too can leverage their social networks: 

• Share their social networking profiles 
• Post jobs of interest to their social networks, sharing opportunities  
• Import profile and contact information from their social networks to their Talent Gateway profiles 

Recruiter/2xB User Experience 
Recruiters and 2xB users can leverage the social networks integration to: 

• Post jobs to their homepage on the configured social networks. 

• Access candidates’ social network information from the Talent Record. 

These two tasks are described in the following sections. 

Recru ite r Expe rience  – Pos ting  J obs  

Posting an open req to your social networks is done in a similar way to posting a req to a Talent Gateway. 
However, the req must already be posted to at least one Talent Gateway. Secure reqs cannot be posted to 
social networks. 

To post an open req to your social networks 

1. From a list of open reqs (Reqs > View all reqs > Open, Reqs > View my reqs > Open, or Req search 
results), select an open req. It must already be posted to at least one Talent Gateway. Secure reqs are not 
eligible for posting to your social networks.  
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2. Click the Post to my Social Networks action. The Post to my Social Networks window pops up. 

 
 

3. Select the desired Posting TG from the list of Talent Gateways to which the req is actively posted (they are 
ordered by posting expiration date, with the TG on which the posting expires soonest at the bottom of the 
list).  

4. The text area is auto-populated with the editable string that will label your posting:  
Job vacancy at <ClientName> for <JobTitle>  
Change this text as desired. 

5. Each authorized social network icon is checked by default – uncheck any to which you do not wish to post 
this req. (Authorized social media site icons are clickable hyperlinks to your public profile on that site.) 

 
6. To post to a site you have not yet authorized, click the Authorize link beneath its icon. On the resulting pop-

up, log in to the desired account (personal or company), and click the appropriate button to authorize 2x 
BrassRing to access your account/information.  
For example: 
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LinkedIn site has an "Ok, I'll allow it" button to authorize access 

 
Twitter has “Authorize app” button 

 
The social media pop-up should close after authorization. 
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7. Click Share to post the content of the text area to the checked social network sites. The message text will 
be posted with a Click to View/Apply hyperlink appended. (When a candidate clicks the hyperlink, it takes 
the candidate to the Job details page at the job apply URL for the TG selected.)   

8. A confirmation window shows the icons of the social network sites to which you have successfully posted. 
To open a pop-up window showing the home page of a site, you can click the corresponding icon.  
To close the confirmation click OK. 

 

 
You can post to more than one account for a social media site, for example, to both 
your personal account and to your company account. To do so, you currently have to: 

1. Authorize a site with user ID and password for the first account and post to the first 
account. 

2. Begin the posting process again and “unauthorize” the first account. 

3. Authorize with user ID and password for the second account and post to the 
second account. 
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You can also open the Post to my Social Networks page to post by clicking the Post to 
my Social Networks button from: 

Open req 
confirmation 
and Edit 
postings 
confirmation 
pages 

 

View req 
detail page 

 

eLink > 
View  req 
page 
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Recru ite r Expe rience  – Acces s ing  So cia l Networking  In formation  from the  Talen t Record  

For candidates who have authorized access to their social networking site profile information, clickable icons 
appear on their Talent Records (TRs) in 2xB.  
New TR with ribbon item added/configured 

 
Classic TR 

 
 

Click an icon to open the candidate’s public profile of the corresponding social network in a new window. (This is 
the social networking site’s page, not a 2xB page.) 
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Candidate Experience 
Candidates can also leverage their social networks with this 2xB integration. They can: 

• Post jobs of interest to their social networks, sharing opportunities and thereby helping you increase the 
number of prospective candidates 

• Share their social networking profiles for efficiency and impact . 

Candida te  Expe rience  – Sharing  J ob  Pos tings  

Candidates viewing postings on your organization’s Talent Gateways can share jobs of interest with their social 
network contacts. The process is essentially the same as for 2xB users. Candidates simply click the Post to my 
Social Networks button when viewing a selected job’s details on the TG. 
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Candidates can add to or change the message, and share the posting to their authorized network sites. They 
authorize sites in the same way described previously for 2xB users. 

 
Once they have shared the job, people with access to view their profile can see the job description and access 
the link to apply to it. 

Candida te  Expe rience  – Sharing  P rofile  In formation  

Candidates can share the information via their Talent Record, or use their social network profiles as the source 
for their TG profile. 

Talent Record 

In order for 2xB users to access a candidate’s social media profile(s) for viewing from the Talent Record, the 
candidate has to authorize the links that appear there. They do this from Talent Gateways with the Social Media 
Integration setting configured. The TG’s Resume/CV profile information section includes a Social networking 
information button. 
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Clicking the button takes them to an authorization page where they can authorize sites for viewing by 2xB users 
from the Talent Record (or remove authorization previously given). 

 
Profile Source 

Candidates now have their social network profiles available to use for their profile (when creating a profile for 
submitting job applications through your Talent Gateway). Configured options can be selected on the Profile 
source page. 
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After clicking Continue, the candidate is redirected to the social media site to authorize use of that profile 
source, if necessary. 
Sample FaceBook Authorization 

 
Once authorized, candidate proceeds to the Gateway Questionnaire, or to the Upload resume/CV page (if no 
Gateway Questionnaire). Contact, education, experience, and resume information will be automatically imported 
from their profile on the selected social network site.  

Limitations and Known Issues 
• We support this social media integration only on desktop, not on Mobile. 
• Once a job is filled, postings are not automatically removed from your social media sites. You must log in 

and delete the posting manually. 
• Candidate source is currently tracked by the TG rather than the individual social media sites. 
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How Do Clients Get this Feature? 
This feature is controlled by: 

• New client setting in Workbench (set by your Kenexa consultant): Enable Social Media integration  
• New Talent Gateway setting (set by your Kenexa consultant): Social Media Integration 
• New ribbon item for New UI Talent Record (can be set in Workbench Self-Service): [Panel Standard] 

Social Networks 

Please contact your CSC for more information about enabling this feature.  

Workbench Self-Service Certified Users 
A new ribbon item is available for adding social networks to New UI Talent Records. 

To enable the new ribbon item: 

In Tools > Users > User types>[select User type with active panel mapping] > Screen display defaults 
[action] 

Click “Select field” to add the new ribbon item: [Panel Standard] Social Networks. 

 
 

Once set, if the candidate has authorized access to his or her social networking information, the icons appear in 
the ribbon. 
New Talent Record 
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In tegra tions  – GreenJ obIn terview  
GreenJobInterview.com is a Kenexa integration partner that provides virtual interviewing services – video 
interviews. The integration with 2xB adds the ability to schedule a video interview and capture the status in the 
candidate’s 2xB Talent Record. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
þ Integrations – Video Interviewing 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
GreenJobInterview.com is a Kenexa integration partner that provides virtual interviewing services – video 
interviews. They use secure, browser-based technology and support services, allowing your organization to 
interact face-to-face (virtually) with candidates. This minimizes time and travel costs associated with early stage 
interviews, thereby also reducing environmental impact.  

You can schedule the video interview via 2xB and capture status in the candidate’s 2xB Talent Record. 

2xB Us er Exp erience   

The process of scheduling the interview is triggered when the 2xB user updates a candidate to the “designated” 
HR Status, from within a req folder for a “designated” req template. (Both req template and HR Status are 
designated in the configuration setup for the GreenJobInterview candidate export subscription.) 

The system requests the video interview for the candidate, then authenticates and redirects the 2xB user 
automatically to the GreenJobInterview user interface in a separate window. 

The system also passes the available candidate information to GreenJobInterview (which is possible through 
the mapping configuration done at implementation time). 
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You schedule the interview by stepping through the screens, and log out to return to 2xB. 

The basic status and results are updated within the configured 2xB standard candidate form once 
GreenJobInterview returns them. The candidate form will include a hyperlink with text, “Click here to view the 
results.”  Click the hyperlink to see the order information in edit mode or in view mode (depending upon when 

you click the hyperlink): 

• Before the actual date-time of the interview, the order form opens in edit mode 

• After the actual date-time of the interview, it opens in view mode. 

Interview completion is indicated in the 2xB “Results” form for the video interview activity, but no details of the 
interview are provided. 

More  In formation  

You can visit the GreenJobInterview website for more information or a demonstration at: 

http://www.greenjobinterview.com/ 

How Do Clients Get this Feature? 
This feature is controlled by a client setting and subscription setup in Workbench. Please contact your CSC for 
more information about enabling this feature.  
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 Order NumberOrder Status 

'Scheduled'Techcheck CompleteInterview Complete

AccountUser name 
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In tegra tions  – In terview Builder Enhancements  
For clients with integrated Kenexa Interview Builder, several enhancements improve usability.  

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Kenexa Interview Builder 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Enhancements to integrated Kenexa Interview Builder (KIB) include: 

• Three new fields on results form for lifespan expiration date, lifespan range, and interview name 
• Auto-fill support for results form 
• Req team user information is transferred to KIB for both the Print/Send Interview and Score Interview 

actions.  

New Fields on Results Form  
2xB users with Interview Builder privileges will see three additional standard fields on the Interview Builder 
Results form (when viewing that form for a candidate). 

New fields: 

Field DB Name Field Display Name Type, Sequence 

LifespanExpDate Lifespan Expiration Date Date, 16 

LifespanRange Lifespan Range Text, 17 

KIBInterviewName Interview Name Text, 18 

Previously the Results form included 15 standard fields; now it includes 18. 

Auto-fill Support for Results Form 
Additional custom fields can also be created on the Interview Builder Results Form for your organization. This 
includes auto-fill fields. When the form is automatically created or updated through integration imports, those 
auto-fill fields are now populated with the value contained in their source fields. 

Req Team Info Transferred in XML Web Service Calls 
2xB will now transfer Req team user information to KIB for both the Print/Email Interview and Score Interview 
actions. (This is done via behind-the-scenes web service calls.) The improvement allows the information to be 
used to add new users within KIB should the member of the req team not be a current user in KIB. Each time a 
web service call is made for the Print/Email Interview and Score Interview action in 2xB, each user on the req 
team will be sent, as well as their user details. This occurs whether the actions are initiated both from the 
Print/Email Interview and Score Interview Candidate actions in 2xB, or initiated from candidate HR Status 
update in 2xB (if configured). 
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Limitations and Known Issues 
The Job Description will no longer be transferred to KIB with the Print/Email Interview action, as the field is 
currently limited to a maximum of 2000 characters in KIB. This limit may be increased in future, at which point 
the field might again become transferable. 

How Do Clients Get this Feature? 
This feature is available for sites with integrated Kenexa Interview Builder. New form fields and auto-fill field 
types can be configured in Workbench Self-Service or by your Kenexa consultant. Please contact your CSC for 
more information or assistance for integration imports.  

Workbench Self-Service Certified Users 
The new Results Form fields will be available in Workbench Self-Service: 

Tools > Forms > Candidate forms > Administer form fields for InterviewBuilderResults form 

In addition, auto-fill fields that are added to the Interview Builder Results Form in Workbench will now autofill 
when the form is created or updated through integration imports. For example, the following figures show an 
auto-fill field configured in Workbench and how it appears when the 2xB user views it after import.  
Auto-fill field on InterviewBuilderResults form 
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Auto-fill fields display in 2xB (in this case, source had no value for the Market auto-fill field) 

 

Support for IB Req Fields 
RFA supports the req selection of interviews as children for Workbench RFA Import and XML RFA Import.  This   
applies to all 5 req Interview Title fields:  

• Interview Title 1 
• Interview Title 2 
• Interview Title 3 
• Interview Title 4 
• Interview Title 5 

This is applicable to both spreadsheet uploads in WB as well as XML async integrations.  
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In tegra tions  – Kenexa  2x Bras s Ring  Socia l Source™ 
Kenexa 2x BrassRing Social Source™ is a sourcing and candidate relationship management solution that offers 
powerful integration with the 2x BrassRing® talent acquisition solution. 2xB Social Source allows recruiters to 
manage candidate sourcing from a wide range of sources from social media streams. Those streams range 
from Facebook, and Twitter to email, phone and SMS text messaging. Quality candidates can be sourced 
directly from within the hiring workflow, and you can easily engage leads and track them all the way through 
hire. 2xB Social Source offers: 

• Powerful social media search capabilities 
• Status update tools 
• Ability for recruiters to run job campaigns via direct mail and SMS/text messaging 
• Publication of openings, events and overall organizational messaging to multiple social media streams 
• Direct job posting to your organization’s social media job board through a single interface during job creation 

Refer to the Kenexa 2x BrassRing® Social Source™ Integration User Guide in this Product Update Guide for 
complete information. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Integrations 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

How Do Clients Get this Feature? 
This feature is controlled by a new client setting. Please contact your CSC for more information about enabling 
this feature.  

Workbench Self-Service Certified Users 
Self-service users can perform some ongoing setup tasks after Social Source has been implemented for your 
organization: 

• Manage user type privileges used with Social Source 
• Map the CRM panel for New UI users 
• Add the CRM Record field to the Talent Record Ribbon 

Manage  Us er Type  P rivileges  

Three user type privileges are managed in: 

Tools > Users > User types > Edit type permissions [for selected user type] > Integration 

The privileges are: 

• CRM – copy candidates to CRM 
• CRM – general search 
• CRM – manage campaigns/source from campaign 
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Map New UI Panel 

Tier 4 certified users can map the CRM panel for New UI users: 

Tools > Users > User types > [select user type] > User type panel mapping 

 
Choose desired options and Save the mapping. 

Update  New UI Ribbon  Configura tion  

You can add the CRM Record field to the New UI Talent Record: 

1. Select Tools > Users > User Types > [Select User type] > Screen display defaults. 

2. For the Ribbon in the Talent Record section, locate the pane to which you want to add the CRM Record 
field – maximum of four per pane.  
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3. Click Select field.  
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4. Choose Panel standard CRM Record field, click Add. 
5. Click Submit. 
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In tegra tions  – Kenexa  As s es s ments  
Ease-of-use features have been added to improve the integration of Kenexa Assessments (also referred to as 
Searchable KAS) with Kenexa 2x BrassRing. The latest enhancements include: 

• Candidate exemptions from job-required assessments for candidates who meet certain criteria  
• Easier manual entry of assessment responses. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Kenexa Assessments 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
The integration of Kenexa Assessments (KAS) with 2xB includes enhancements in the following areas: 

• Candidate exemptions from job-required assessments for candidates who meet certain criteria  
• Easier manual entry of assessment responses. 

Candida te  Exemptions  

Candidates can be exempted from job-required assessments if they meet configured exemption rules. Rules: 

• Are defined at the assessment batch level (by your CSC)  
• Include one candidate form field and one req form field  
• Exempt candidates who match the rule.  

Candidates are exempt when a rule’s two form fields have at least one value in common. For example, if the 
candidate form language field indicates the candidate speaks English, Spanish and French, and the Req form 
language field requires English, it’s a match and the candidate is exempt. 

When exemption rules are defined for an assessment batch, the system determines whether a candidate meets 
any of the exemption criteria at the time of application. If so, then the candidate is not required to take the 
assessment batch attached to the requisition. The application process for the exempt candidate ends once the 
candidate clicks Submit. Both the KAS Assessment and KAS Overall Results forms are added to the 
candidate’s record and flagged as “Exempt.” There will be one KAS Assessment form for each assessment 
included in the batch.  
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KAS Assessment Form (Candidate Talent Record > Forms) 

 
For an exempt candidate note that the “Elapsed Time”, “Questions Correct”, “Link to Assessment Summary 
Page”, “T score”, Z score” and “Raw score” fields are blank since there are no results. 
KAS Overall Result Form 
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The Overall Batch Score field will be null on the Overall Result form. 

The exemption process applies only to the Talent Gateway/Gateway Questionnaire workflow. All other 
workflows – Run Assessment, Retake Assessment, or Send communication (automated and manual) – bypass 
the exemption check. This allows recruiters the flexibility to require a candidate to take the test(s) in 
circumstances where the exemption rules should be overridden.  

• If a candidate is “Exempt” for the same req for which a 2xB user initiates the Run Assessment action, 
the user is alerted that results are already on file for that assessment. In order to bypass the exemption 
rules, the user can use Retake Assessment. 

• If the candidate subsequently applies to a different requisition that requires the same assessment but 
does not have the exemption rules defined, or the candidate does not meet the exemption criteria, then 
the candidate is required to take the assessment.  The exemption status only pertains to the specific 
requisition for which the candidate meets the exemption criteria. 

Manual Entry o f As s es s m ent Res pons es  

A new user type privilege, “Assessment – manual entry,” enables an option on the Run Assessment screen for 
privileged 2xB users. They can select the option to manually enter responses for individual behavioral 
assessments (type = Behavioral) on behalf of a candidate who has completed a paper assessment. When the 
option is selected, the user is re-directed to the manual entry screen in the KAS system, and enters the 
responses on a single page. This expedites the data entry and improves accuracy by letting you review the data 
easily prior to submission. 

To manually enter Behavioral assessment responses: 

1. From a req folder or Talent Record, select the Run assessment action. The Run assessment page 
appears. 
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2. Select Manual entry, then click Run/Send.  
3. You are re-directed to the KAS manual entry screen when there is only a single outstanding assessment. 

 
 
When multiple assessments are selected, you are first brought to the Pending Assessment page hosted by 
the Talent Gateway.  

 
 
There you click the link of the desired assessment, and are then redirected to the KAS manual entry screen. 

 
Manual entry is not available for Skills type assessments, nor for assessment batches. 
If an assessment batch is selected, “Manual entry” is disabled and “eLink to the 
candidate” is selected 

Best Practice Recommendations 

How Do Clients Get this Feature? 
The manual entry of assessment responses is enabled by a new user type privilege, which certified Workbench 
users can set. Contact your Kenexa consultant for help with this feature. 

Workbench Self-Service 
All self-service tasks are included here for your convenience. New information is indicated with this 
orange font color. 
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Who does this: Certified Workbench User, Tier 1 and above 

Certified Workbench users can perform these tasks as necessary (generally, if changes or additions are 
needed), but Kenexa Service Consultants will assist with initial KAS setup. 

• Assign assessments-related user type privileges 
• Add custom req fields to req forms  
• Configure candidate forms 
• Customize Talent Gateway text (including the Pending Asessments page title) 
• Add assessment widget to Gateway Questionnaire(s) 

Us er Type  Privileg es  

You can set the following assessments privileges in Workbench Users > User types > Edit type permissions 
> Set privileges (for Function = Integration):  

• Assessment – batch configuration – Edit: can edit the batch configuration when adding a req 
• Assessment – batch configuration – View: can view the batch configuration when adding a req 
• Assessment – manual entry: Run Assessment includes a “manual entry” option. Privilege is disabled 

until/unless “Assessment – run” is selected. 
• Assessment – run: user type can run assessments 
• Assessment – run optional assessments: can choose from the client’s full list of assessments in 

order to send invitations for assessments that are not specifically required for the requisition. 
• Assessment – run retake: can allow candidates to retake assessments 
• Assessment – view history: can access the Integration tab to view assessment history 

Additionally, when assessment batches are in use, you can set the following assessments privilege in 
Workbench Users > User types > Edit type permissions > Set privileges (for Function = Talent Gateway): 

Posting – select/deselect Assessment Batch: user type can select which Assessment Batch will be launched 
when candidates apply on a particular Talent Gateway.  

 

Cus tom Req  Fie lds  fo r Req  Forms  

You can add custom req fields for req forms as needed in Workbench Tools>Forms>Reqs>Req forms>Define 
custom req fields.   
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AttachAssessments – this field displays all client assessments. It is best suited for environments without 
complex rules, ideally when only a single assessment is required for a req and all candidates, both internal and 
external, are required to take the assessment 

AssessmentLanguage – this field determines whether the candidate must take the assessment in the locale of 
the gateway they’ve applied to (when the assessment is available in that locale) or if they will have the option to 
select the language of their choice. When the field is not present on the req, the system defaults to allowing 
candidates to select the language of their choice.  As part of this functionality, only English titles for 
assessments will be displayed in 2xB and attached to the requisition. KAS determines which version of 
assessment will be given to the candidate, based on the req setting. 

AssessmentPassScore (used only with AttachAssessments) – this field is used in tandem with the 
AttachAssessments field and Automation Manager Assessment trigger “Scoring Results.”  This is best when 
only one assessment is required for the req, or, if multiple assessments are required, they share a similar cut 
score. 

AssessmentPreferScore (used only with AttachAssessments) – same as above but candidate can be updated 
to a unique HR status based on having a preferred score rather than a passing score. 

AssessmentDaysRemind – This is available for both AttachAssessments and for batches, and uses 
Automation Manager – Assessments-> Reminder Email. Candidates who have not completed ALL required 
assessments in the #days set per Req are sent a reminder email. 

AssessmentDaysReject – Same as above. In this case the candidate is automatically updated to a new HR 
status if they do not complete all their assessments within the designated timeframe. 

AssessmentBatch1 (only) 
AssessmentBatch2 
AssessmentBatch3 
AssessmentBatch4 
AssessmentBatch5 
AssessmentBatch6 – If enabled for batches, up to 6 distinct batches can be attached to an individual 
requisition. This provides flexibility around launch methods. For example: Batch 1 may be the set of 
assessments required for external candidates when they apply on the TG, Batch 2 may be a different set that is 
required for internal candidates, Batch 3 may be for all candidates that move into a certain HR status.   

Best Practice: Determine each batch’s launch method/purpose and rename the field accordingly so the end 
user can easily identify which candidates will be taking the assessments and when. For example, instead of 
“AssessmentBatch1”, rename to “TG Assessments – Internal” 
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Configure  Candida te  Forms  

Two candidate forms are created for Kenexa Assessments; both are multiple/req/candidate. 

• KAS Results 
• KAS Overall Results (only with batches) 

To ensure each User Type has the appropriate privileges, you can set the form attributes in Workbench Tools > 
Forms > Candidate forms > Edit form attributes. Note that many of the attributes are system defined and are 
not modifiable 

 
Next determine which fields need to be visible to each User Type and update those that will appear in the Req 
grid to be outputable (Tools > Forms > Candidate forms > Administer form fields > Edit field attributes).  
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Click Save and continue to modify the field name to better suit the client’s environment. 
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Fields available on KAS Results: 

• Last Name 
• First Name 
• Requisition ID 
• Assessment Batch Name – may be helpful if using batches, more likely will view this directly on form or in 

integration tab 
• Assessment Code/ID – typically not meaningful to the 2xB user 
• Assessment Name – Important to have and should be outputable if displaying results in grid  
• AssessmentAdmin/RecruiterEmail 
• Date of Assessment 
• Elapsed Time 
• Questions Correct – may be desired, more likely the “Results” or “2xB Band” field will be displayed 
• Reporting Band – used for reporting, this contains the same custom banding text as “2xB Band” but is only 

in black/white so html tags are not included 
• 2xB Band – if configured for banding, this should be outputable 
• Results – can use this or simply display the band 
• Link to Assessment Summary Page  
• Numeric Results – mainly used for behind the scenes purposes 
• T Score – rarely used; check with test consultant 
• Z Score – rarely used; check with test consultant 
• Raw Score – rarely used; check with test consultant  
• Link to Assessment Report 2 – only for custom reports 
• Link to Assessment Report 3 – only for custom reports 
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Fields available on KAS Overall Results: 

• Date Created 
• Candidate Last Name 
• Candidate First Name 
• Assessment Batch Name – needed to identify the batch 
• Batch Band UI – this will only be populated when using the Overall Score feature, this text will appear in 

color on the UI if configured to do so 
• Batch Band reporting – this is for reporting purposes; it does not need to be displayed on the grid. This will 

have the same text as the Batch Band UI but will not have color. This field can be used with Automation 
Manager “RAM” triggers to automatically update the candidate’s HR status 

• Batch Score – this will display the system calculated overall score if desired 
• HR Status Update – This field will display “Yes” if the candidate gets a passing score for all tests in the 

batch; a “No” if any test is not passed. This field can be used with Automation Manager” triggers to 
automatically update the candidate’s HR status. 

Cus tomize  Talen t Gateway Text: Landing  logged  in  Tab 

Configure the assessments-related text for the Talent Gateways in Workbench Tools > Talent Gateways > 
Text customization > Edit. 

Configure the text for the link to the assessment page and the descriptive text provided for the link.  Each locale 
must have a default TG set, in the event a candidate without a TG profile needs to access an assessment page.  

 
• Assessment page link text field allows a maximum of 75 characters and does not support HTML. 
• Assessment page summary text field allows a maximum of 4000 characters and HTML is supported. 

The text entered on Landing logged in tab appears here: 
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Cus tomize  Talen t Gateway Text: Notifica tions  Tab  

Configure the assessments-related text for the Talent Gateways in Workbench Tools > Talent Gateways > 
Text customization > Edit. 
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• Assessment invitation message: this is the text that appears on the confirmation page when the 

candidate is required to take an assessment.  Note: if the assessment link needs to be displayed on the 
confirmation page, rather than launching via the Continue button, the following must be added where the 
link should appear: “[URL]” 

• Launch Assessment button: this field can be used to add custom text to the button on the confirmation 
screen; this can help make it clear to the candidate that they have not truly completed their application 
process yet. 

• Assessment page title: this field can be used to change the title of the TG-Assessment page (default title 
is Pending Assessments)    

• Assessment invitation email message: create text here if candidates should receive email invitations in 
addition to having the assessment provided via the TG. If there is no message entered an email will not be 
sent. 

• Assessment page text – with assessments pending: this is the instruction text that displays on the TG-
Assessment page.  Candidates see the outstanding assessments for all

• Assessment page text – no assessments pending: this is the same as above but displays when no 
assessments are required. The field allows a maximum of 4000 characters and HTML and tokens are 
supported. 

 requisitions they have applied to on 
this page.  This text displays when there are outstanding assessments. The field allows a maximum of 4000 
characters and HTML and tokens are supported. 

This figure shows where the first field displays: 
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This figure shows where the last two fields display: 

 

Ad d As s es s ment Widget to  Gateway Ques tionnaire (s ) 

You must add the assessment widget to the confirmation page of the GQ in order for assessments to be offered 
to the candidate (in Workbench Tools > Gateway Questionnaires > Administer sections/pages > 
Administer widgets > Add new widget). If the “Always launch assessments” TG Admin setting is not turned 
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on, then the GQ needs at least one scored question, and the minimum score to launch assessments must be 
entered on the site questions page. 

Insert a Text widget on confirmation page. Click Insert variable, select Assessment, and Save. 
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In tegra tions  – WOTC Firs t Advantage  
Kenexa has partnered with First Advantage to offer Work Opportunity Tax Credits services via a Web service 
integration with 2x BrassRing.  

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
þ Integrations  

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

¨ Automatic – see details below. 
¨ Specific conditions required – see details below. 
þ Configuration required – contact your CSC for implementation details. 

Feature Description 
This integration of Kenexa 2x BrassRing with First Advantage offers Work Opportunity Tax Credits (WOTC) 
services. WOTC is a US federal tax hiring incentive ((applicable to US only), heavily used in the high-volume 
hourly hiring process. The credits can be significant per hire, which represents great cost savings to companies.  

The integration provides your organization with the means to submit required paperwork within state and federal 
time constraints in order to receive the credits. The integration provides: 

• WOTC questionnaire – Candidates can be asked to complete a tax credits questionnaire as part of their 
application process. Questions are presented on the Talent Gateway or via Gateway Questionnaire for a 
seamless end user experience. 

• Initial Results – Basic eligibility results are received once the candidate has completed the questionnaire, 
and stored in 2xB.. 

• Hire process – Upon hire, our WOTC partner is notified of the hire and returns the required forms for the 
candidate’s signature. The forms are attached to their Talent Record, and the employer can then return the 
signed forms to our WOTC partner for processing. 

Primary users of the functionality are candidates who will participate in the WOTC survey as part of applying for 
a position. Secondary users are recruiters who enable WOTC via the req, review applicants’ eligibility as part of 
hiring decisions; and request paperwork be processed upon hire. 

Candidate Experience 
This section describes the candidate experience when applying for a position that requires a WOTC eligibility 
check. Two Talent Gateway workflows are possible: with and without a Gateway Questionnaire. Candidates will 
automatically be presented with the tax credits questionnaire when the following is true: 

• Talent Gateway has WOTC enabled 
• Requisition has WOTC set to “Yes”  
• If using a Gateway Questionnaire, the WOTC widget must also be presented 

For either workflow, a “Tax Credits” cookie crumb is added to the progress bar when tax credits questions are 
included. The candidate has the opportunity to “opt out” of the WOTC questionnaire. The WOTC vendor 
provides the questions to be asked of the candidate behind the scenes. The questions are presented as if they 
are part of the application process, and match the look and feel of other Talent Gateway pages.  

Candida te  Workflow  

When the integration is configured with no Gateway Questionnaire involved, the WOTC questionnaire is initiated 
just after the Attachments page on the Talent Gateway, and before the Additional Questions page. When a 
Gateway Questionnaire is used, the WOTC questionnaire is initiated where configured (by placement of a new 
widget). 
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A cookie crumbs display as “Tax Credits” in the progress bar at the top of the page, which includes the header 
“Tax Credits.” The initial Tax Credits page displasy the following instructional text: “The federal government 
offers tax credit programs when applicants meet program criteria and are hired.  Additional information is 
requested in the next step of the application to determine tax credit eligibility. This will only take between 45 
seconds and three minutes. It is completed through a secure method and kept confidential. Please provide valid 
data, such as SSN, to successfully determine eligibility for tax benefits based upon your potential employment.” 

The candidate is prompted to enter SSN and date of birth to initiate the questionnaire. These will be used solely 
for the WOTC questionnaire and will not be stored in the database. The SSN field is displayed twice, each field 
is masked.  If the fields do not match an error message will be displayed to the candidate: “SSN fields must 
match, please re-enter.” 

The candidate may also elect to opt out on this page. If the candidate opts out, he or she simply moves to the 
next page on the Talent Gateway or Gateway Questionnaire. 
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When the candidate chooses to participate, they are asked to verify their address. 

 
When they continue, they are asked a series of questions (defined by Kenexa’s WOTC partner to meet WOTC 
requirements). Generally several screens of questions are asked, with the candidate clicking Continue to 
proceed to the next screen. 
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Once all questions have been successfully answered, the candidate moves to the next page of the application.  

 
The WOTC partner returns details on whether the candidate is qualified for tax credits, both at the federal level 
and at the state level. These results are written to the WOTC candidate form. 

Notes 

• When the candidate is going through a multiple job apply process where more than one job requires the 
WOTC questionnaire, the candidate will only go through one WOTC questionnaire. The same results will be 
copied to each of the requisitions applied to. 

• If your organization has Save Draft enabled, the button will be hidden on the Tax Credits screen. 
• If, due to configuration, the WOTC page is also the Submit page, the Submit button will be disabled until the 

WOTC questionnaire is complete to ensure the candidate does not inadvertently submit their application 
before completing the questionnaire. 

• If the candidate has completed the WOTC questionnaire within the past 60 days, they will not be required to 
complete it again. Results already on file will be retrieved. 

2xB User Experience 
2xB users add the WOTC check to their reqs when creating them. They set the WOTC field on the requisition to 
“Yes” in order for the questionnaire to be launched when the req is posted and applied to.  It’s recommended 
that they also select a value for the WOTC location field. 

Once a candidate applies, the configured WOTC candidate form is attached to any candidate who was 
presented with the tax credits screen. The form indicates whether the candidate is eligible for Federal and/or 
State credits, or if they opted out of participating. You access the form from the Forms tab of the Talent Record. 
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WOTC Results form 

 
For candidates who are hired, the PDF file needed to claim the tax credits is returned as an attachment, 
accessed via the Attachments tab of the Talent Record. 

 
 

Limitations and Known Issues 
WOTC Tax Credit feature can not be used with jobless apply.  

How Do Clients Get this Feature? 
This feature is controlled by a new client setting. Please contact your CSC for more information about enabling 
this feature.  
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Workbench Self-Service Certified Users 
Once configured during the setup process, the WOTC Eligibility Check custom req field must be added to req 
templates so it can be selected when appropriate reqs are created. Additionally, your client-specific custom 
requisition field that indicates the job’s location in WOTC’s required format must also be added to the req 
template. 

Tools > Forms > Reqs > Req forms > Administer req fields [for selected template] > Select custom req 
fields 

Select the WOTC Eligibility Check and custom WOTC Location fields, and Save. 

• When these as set to “Yes”, and the checkbox for “Enable Search & Output” is selected and Saved, the 
fields have been mapped to Verity)

Special Configuration option) (this information is needed to initiate the WOTC questionnaire)

3. Create a maintenance ticket requesting assistance with the RAM WOTC trigger set up. (Please note: this 
will be the second maintenance ticket required; it is in addition to the one defined on  slide 20 above). 
Include the following information: 

• Client Name 

• Staging/Production 

• Name of trigger created for WOTC 

• Manifest name, Import Code, Source Code (used with attaching .pdf to attachments tab) 

• Field mapping for the following fields: 

o Hire Date (required) 

o Start Date (required) 

o Offer Date (optional) 

o Hourly Rate (optional)  
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For the recruiter experience in Kenexa 2x BrassRing (2xB), the following platforms are supported* 

 IE 6.0 IE 7.0 IE 8.0 Firefox 3.0 Safari 4.0  

Windows XP Yes Yes Yes Yes Yes 

Windows Vista No Yes Yes Yes Yes 

Windows 7 No Yes Yes Yes Yes 

MAC OSX 10.4.4 N/A N/A N/A Yes Yes 

MAC OSX 10.5 N/A N/A N/A Yes Yes 

 
For Talent Gateways and Agency Manager, the following platforms are supported: 

 IE 6.0 IE 7.0 IE8.0 Firefox 3.0 Safari 4.0 

Windows XP Yes Yes Yes Yes Yes** 

Windows Vista No Yes Yes Yes Yes** 

Windows 7 No Yes Yes Yes Yes** 

MAC OSX 10.4.4 N/A N/A N/A Yes Yes** 

MAC OSX 10.5 N/A N/A N/A Yes Yes** 

Please note **Limitation below for Safari browsers. 
All browsers listed in the support grids above will be supported in all 2xB-supported languages  

 
For Workbench, the following platforms are supported: 

 IE 6.0 IE 7.0 IE 8.0 

Windows XP Yes Yes Yes 

Windows Vista No Yes Yes 

Windows 7 No Yes Yes 

 
For eLinks, the following email clients are supported: 
Microsoft Outlook and Lotus Notes 
 
Kenexa 2x Mobile is not phone-specific; a range of mobile devices are supported, including: 
Smart phone (such as iPhone, Android, and Windows Mobile) with Javascript enabled 
Blackberry with BOS version 4.6 or higher that have JavaScript support enabled 
 
*These are the officially supported platforms, as of June 8, 2011. The listed browser/versions and operating 
systems/versions have been tested for use with our applications, but other combinations may work with our products.  
 
**Limitation with Safari browsers for clients using iframes to host Talent Gateways:  
by default, Safari prevents a web page from setting cookies if it is hosted in a frame with a domain different from the 
parent's (e.g., when frameset is from HR_Client.com and TG's frame is sjobs.BrassRing.com). One workaround to avoid 
the cookie restriction is to update your custom text on the TG landing page and request Safari/Mac users to click a link 
that will launch the TG in a separate window. 

Kenexa 2x BrassRing®  
Supported Browsers 

226 of 318



Language Country 2xB Agency Manager Talent Gateway
Azerbaijani Azerbaijan X
Chinese (Simplified) China X X X
Chinese (Traditional) Taiwan X
Croatian Croatia X
Czech Czech Republic X
Danish Denmark X
Dutch Netherlands X X X
Dutch (Informal) Netherlands X
Dutch Belgium
English United States X X X
English UK X X X
English - US Govt United States X X X
English Ireland
Finnish Finland X
French France X X X
French Canada X X X
French Belgium
German Germany X X X
German (Informal) Germany X
German Austria
German Switzerland
Greece Greek X
Hungarian Hungary X
Hungarian (Informal) Hungary X
Italian Italy X X X
Japanese Japan X X X
Korean Korea, South X
Norwegian Norway X
Polish Poland X
Portuguese Brazil X X X
Portuguese Portugal X
Russian Russian Federation X X
Serbian Serbia X X X
Slovak Slovakia X
Slovenian Slovenia X
Spanish Spain X X X
Spanish (Informal) Spain X
Swedish Sweden X X X
Turkish Turkey X
Total Locales 14 13 34
Total Languages 12 11 26

Languages Supported in Kenexa 2x BrassRing®

as of 21 July 2011
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New UI Enhancements  – Cus tom Subpanels  
Custom subpanels are specialized Candidate Results panels that organizations can design to guide process 
compliance by limiting the actions and filter options to what is needed and appropriate for their purpose.  

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Custom subpanels are specialized Candidate Results panels that are launched from the My Open Reqs or All 
Open Reqs panels. Like the Candidate Results panel, they display the candidates (or a subset of candidates) 
that are filed to a requisition folder. The subpanels, however, are designed to guide particular processes, so 
generally have limited actions and filter options. Your organization defines what information displays and what 
users can do in the panel. 

 
To better control and encourage process compliance for candidate processing and workflow, custom subpanels 
allow you to launch differently configured candidate results panels at different stages of the process. You can 
control aspects of the candidate results shown, such as access to certain candidates, actions, forms, and 
correspondence. 

• Candidates  
You can limit the candidates by Candidate Types or HR Statuses, similar to the way the [Candidate Type 
(standard)] Internal column launches a Candidate Results panel with a primary filter of all candidates with 
the Candidate type = Internal.  
The primary filter on a custom subpanel is candidates whose current status is selected in the Display 
candidates in the following HR statuses setting. For example, the subpanel can limit the candidates 
shown to those in all the HR statuses that make up the “Screening” stage of your hiring process, such as 0-
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Filed, Met Basic Qualifications, Met Preferred Qualifications, Resume Review, Initial screen, etc. As a 
candidate enters or leaves one of the HR statuses selected, they will appear or disappear from the panel 
upon refresh of the panel.  

• Actions 
You can limit the actions that can be taken from the subpanel, selecting a subset to present on the Actions 
menu. The actions chosen are specific to your process for candidates at a particular point in that process. 
For example, for a subpanel showing candidates in the screening stage, you might include actions such as 
adding notes or screening forms, and exclude actions such as creating an offer document.  

• Forms  
You can disallow forms altogether, or limit the forms available to only those that are appropriate for your 
subpanel’s process. Using the screening stage example, you may be excluding the creation of New Hire 
and Offer forms. 

You launch custom subpanels via an icon. They launch in the same position as the standard Candidate Results 
panel. 

The columns chosen should help further the purpose of the panel – for a screening process, they might be the 
key columns for quick consideration of what candidate to review: Candidate type, TG Score, City/State, HR 
Status info, Notes, Education and Employment info. These are columns that a screener may want to sort by or 
just review before deciding for which candidates to open their Talent Record and perhaps read their resume.  

Examples  

You can configure a custom subpanel designed to handle candidates in a certain phase. Users click the 
subpanel icon to launch it. 

  
Some ideas of how custom subpanels can be used might be to have specific Hiring Manager subpanels for 
reviewing and/or Interviewing candidates. These could be simplified panels so that the candidates presented, 
the actions to be taken, and the forms to be used are very straightforward and require little training. 

An Interview scheduler panel could include only candidates that are in the position to be scheduled for an 
interview. Output fields might include all the appropriate phone numbers and email addresses, perhaps with 
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some fields from the Talent Gateway with candidates’ preferred work location, method of being contacted, and 
so on.  

Other possible examples follow. 

• Hiring Manager Review 

Includes only candidates who have passed recruiter screening 

Output fields include experience and education 

Actions and forms are related to scheduling interviews 

• Hiring Manager Interviewing 

Includes candidates in interview stages 

Output fields include phone numbers, fields from HM review forms, phone screen forms 

Actions and forms are appropriate for interviewing 

• Interview Scheduler 

Includes candidates in interview scheduling statuses 

Output fields include phone numbers, fields from HM review forms, phone screen forms 

Actions and forms are appropriate for interviewing 

• Assessment Review 

Includes candidates in statuses around assessments 

Output fields include assessment info 

Actions and forms are appropriate for assessments 

• Event scheduling  

Includes candidates in statuses around Event Manager   

Output fields from Event results form  

Output fields from form(s) configured with ‘Event Manager internal event form’ and/or ‘Candidate facing 
registration form’ settings checked 

Actions (Send to Event Manager) and forms appropriate assessments 

• College recruiter 

Includes only candidates in College recruiting HR statuses 

Output fields include education 

Actions and forms appropriate for college recruiting 

Functionality for Fair Employment/Federal Contractors 
Organizations with stringent “fair employment” goals, such as US Federal contractors complying with OFCCP 
guidelines, have additional requirements when considering applicants for employment. BrassRing features such 
as custom subpanels can help ensure that equal consideration is given to Internet applicants. 

Fair Employment and OFCCP Compliance Tools 

Several tools are available in 2xB: 

• Job description and Talent Gateway questions  
Can be used to impartially screen out candidates that don’t meet the basic qualifications of a job, so a 
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recruiter never even looks at them. 2xB can put them automatically in an HR status indicating that they 
didn’t meet basic qualifications.  

• Data management techniques  
Can also be used to reduce the number of job seekers who must be contacted to discern interest in a 
position. 2xB now has several ways to do this. One way is the Candidate Tiering. The setting “Hide 
candidates in req folders for this user type in the following statuses” also provides a way to control 
which candidates have been considered and which have not. For example, you might want all candidates to 
be hidden until they’ve reached the ‘Initial screen’ HR status. You can configure the “Hide candidates in req 
folders…” setting to hide candidates in HR statuses prior to the ‘Initial Screen’ status.  All 2xB Classic views 
and New UI Candidate results panels already honor that setting. Restricted users can’t navigate to 
candidates in, for instance, a 0-filed or Met Basic Qualifications HR status. 

• Custom Subpanels  
Are yet another data management technique. Since custom subpanels can be configured so that only 
certain user types use them, this method also doesn’t force a data management technique on all user types 
within your organization. Custom subpanels provide for federal contractors a way to consider candidates in 
a controlled manner so that the consideration process can be accurately tracked. Clients using custom 
subpanels can also employ the following additional techniques. 

• View More Candidates Action 

The most stringent control is needed before and during the screening process. How can that be 
achieved? Use the View More Candidates to tightly control the number of candidates from the 
applicant pool that your recruiters actively consider. For example: 

o Let the system show small “batches” of candidates in a “pre-reviewed” HR status to federal contract 
recruiters, say, 10 at a time 

o Require that recruiters change candidates’ HR status once the candidates have been considered 

o Prevent recruiters from viewing the next “batch” of 10 applicants until they’ve updated the HR status 
update action on the current 10, and have moved each one of them forward or dispositioned them 
negatively. 

• Candidate Search Action 

o Searches for candidates not currently filed to the req folder 

o Files returned candidate(s) into req folder to be accurately tracked 

• Disable Talent Record and grid actions Setting  

o Allows users to see the candidates, but not take any, or many, actions regarding them.   

• EEOC Summary Report Panel 

o Provides the ability to get a point-in-time status of the diversity breakdown for a req 

View More  Candida te s   

The View More Candidates action helps clients manage high-volume applications and OFCCP/fair employment 
compliance. It allows 2xB users to review a manageable number of candidates at a time, bringing candidates 
currently filed to the Req folder into the panel.’ 

For example, clients may want to consider moving candidates in a “Met Basic Qualifications” HR status forward 
in the recruiting process. However, reviewing possibly hundreds of candidates who met the basic qualifications 
of a position is an enormous, time-consuming task. View More Candidates functionality can help recruiters 
consistently choose candidates from an “unreviewed” status in a more impartial manner. The candidates 
selected are automatically “promoted” to a configured HR status (such as “Active,” “To Be Reviewed,” or 
“Recruiter Review”) to document the fact that they were selected via the functionality. Thus, the candidates who 
remain as “Met Basic Qualifications” have, by definition and in practice, not yet been reviewed. This is an 
especially important point for those such as federal contractors who must adhere to impartial hiring standards.  
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Setup of the View More Candidates action includes a variety of settings for configuration of the source pool, 
the selection method, and the number of candidates to be promoted. For a panel configured with the View More 
Candidates functionality enabled: 

• Initial view of the panel may show ‘No Records Found’ and display no candidates, nor the grid or column 
headers, if the user already dispositioned all the candidates from the previous batch. 

• To view candidates, user must select View More Candidates from the Actions menu. 
View More Candidates action shows in parenthesis the number of candidates that will be selected, updated 
and promoted into the panel, as well as the number of candidate in the Source Pool. Knowing those 
numbers helps users decide if more sourcing for the requisition is needed. In the previous screen, 10 
candidates will be promoted, out of an applicant pool of 10.  

• View More Candidate action updates the selected candidates from their current HR status to the HR Status 
configured as the next step. (This action will ignore configured tracking logic. No other HR Status update 
action will be done, such as: showing optional pop-up forms, sending correspondence that is configured in 
Req template), kicking off integration exports, blocking HR Status update when selected forms are not 
attached/approved, etc. However, triggers will still be based on HR Status updates, including Automation 
Manager, Rules Automation Manager, and custom triggers.) 

• The 2xB user must update the status of all candidates in the group again, to disposition them positively 
(forward in the process) or negatively. Until this is done, the View More Candidates action remains disabled.  

Candida te  Sea rch   

The Candidate Search action: 

• Searches for candidates not currently filed to the req folder 
View More Candidates brings forward for consideration candidates currently filed into the requisition, in a 
controlled manner. Candidate Search searches candidates outside the requisition folder and brings them 
into the req folder for consideration, again, in a controlled manner. 
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• Files search results candidates into req folder to be accurately tracked 
When you search for candidates using the 2xB Candidate Search feature, you can configure the search 
results columns to show information that helps you “consider” the candidate even before you open the 
Talent Record and file them to a req.  Although the search criteria can be tracked against the req ID, the 
candidates that may have been considered in the search results are not tracked. However, the custom 
subpanel Candidate Search action searches the 2xB database and automatically files the candidates to the 
requisition so they can be tracked as being “considered.” 

 
For the Candidate Search action to be available: 

• Panel must be configured with the Candidate Search feature 
• User type must have access to search at least one candidate type 
• User type must have the Candidate Search menu item hidden (so the user types who use this don’t have 

an alternative way to search candidates and circumvent the tracked process).  

To use Candidate Search action: 

1. Click Candidate Search. The Search screen opens, with Save Search button, Candidates per screen field 
and Folders Exclude item hidden. 

2. Select criteria in the pop-up window. For clients with OFCCP enabled, the OFCCP Select Req is pre-
populated with the reqID. Users can edit search fields but they can’t save searches or edit output fields. The 
system first shows the number of candidates that met the criteria, so that users can: 

• Refine their search to get a more qualified set of results 

• View X number of candidates for consideration.   

 
3. Click View X candidates. The system automatically files the candidates to the req in the configured HR 

status and refreshes the custom subpanel where the search was initiated.   
4. As with View More Candidates, you must move the candidates forward or disposition them negatively.  

You cannot click the Candidate Search action again until you have updated each of the candidates just 
considered. When you do click Candidate Search again, your previous criteria will be there if it is within the 
same Internet browsing session. 
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Hiding  the  Candida te  Menu’s  Search  and  Saved  Searches  

To limit the searching done in 2xB to subpanel Candidate Search action, you can also hide, by user type, the 
candidates menu items Search and Saved Searches. A new user type privilege does this. 
Candidate | Search menu item hidden 

 

Dis ab le  Talen t Record  an d  Grid  Actions  

No matter how controlled your candidate reviewing process, there may be times when someone requires special 
consideration outside that process. So another feature that can be configured for custom subpanels allows you 
to select all HR statuses (even the ones that you wouldn’t be able to see through the classic menus). However, 
you can see only limited information on those candidates and can take only limited actions on them. The feature 
is the Disable Talent Record and grid actions. 

When this feature is checked, any typical hyperlinks that would show on the candidates list are disabled, even if 
the user type has the privilege to perform the action. For example, look at the custom subpanel configured as 
“All Candidates,” shown in the following figure. In the Name column, the candidate name is not hyperlinked to 
launch the Talent Record, the HR status does not have a triangle next to it for in-line updating, and the 
Candidate type is not hyperlinked to update.  
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Your organization should configure the Actions menu to be as limiting as possible to support the restrictions. 
The panel should be primarily for review and reference. It can help you handle situations like the phone call 
asking, “Did VIP’s hand-picked candidate apply to the job? Is he being considered?” This screen provides quick 
answers without invalidating the hiring process. 

As an example for handling exceptions, you might limit actions to Add Form, and further limit forms available to 
be added to something like “Direct Consider.”  You could also have a RAM trigger configured that updates the 
HR status to something like “Resume Review” when that form is added to the candidate. The candidate thus 
skips the View More Candidates process and appears in the Screening panel. What happens after that is either 
politics or good candidate processing, or both. Yet how the candidate got there is documented, and the 
exception process can be tracked (and perhaps minimized). 

EEOC Summary Report Panel 

Another feature for Federal contractors and diversity pro-active clients is the ability to get a point-in-time status 
of the diversity breakdown for a req. The EEOC summary report panel provides a summary report using 2xB 
database data (rather than data from the reporting or Data Insight database). The report is structured to 
minimize performance implications, having only one action available: Export to Excel. 

 
To launch the report subpanel, the user clicks the number link in the report subpanel column that’s been added 
to the My Open Reqs or All Open Reqs panel. 

• Users can see the data, regardless of user type access and form privileges, because it’s summarized and 
doesn’t give the opportunity to see individual candidate information. 

• Up to 10 HR Statuses and/or Candidate types can be configured on 1 axis (Vertical or Horizontal) 
• Up to 10 Candidate form field options can be configured onto the other axis. 
• The Total Candidates column and row automatically appear. For the Total Candidates row, Total 

Candidates column displays the total number of candidates filed to the req, of all candidate types and in all 
statuses. Note that this is not a calculation or a summation of the columns or rows, since not all candidate 
types or HR statuses may be selected for the report.  
For the remaining rows with selected types and statuses, the first column will give you the corresponding 
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total number of candidates of that type/status. Additional columns break down that number by 
corresponding form field option values. 
Since the panel always includes candidates from all HR statuses, the launching element is a number.  So, 
this number is truly all candidates filed to the requisition.  

• The panel summarizes data from forms, taking the current form data for single per candidate or single per 
candidate/req forms, and data from most recently added form for multiple per candidate or multiple per 
candidate/req forms (not the most recently updated/edited form) 

How Do Clients Get this Feature? 
For clients using the New UI, custom subpanels are available automatically for configuration. Please contact 
your CSC or Certified Workbench User for more information about configuring them, or your CSC for information 
about enabling the New UI. 

Workbench Self-Service Certified Users 
Custom Subpanels are a new panel type with no standard configuration. You configure them to meet the 
specific needs of your organization, and you can configure as many as desired. 

Tools> Settings > Panel Configuration > Administer configuration > Add new configuration  

 

Configuring Subpanels  
Whereas the only aspects to configure for the standard Candidate Results panel are columns defined and 
whether users can change the column configuration, for a custom subpanel, you configure:  

• Actions to be available 
• Candidate Search action 
• Filter Options 
• View More Candidates Settings 

You do not configure where a custom subpanel launches in the User Type Panel mapping – subpanels launch 
with the same placement as the Candidate Results panel. 
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To start configuring custom subpanels: 

1. In Workbench, select Tools > Settings > Panel configuration > Administer configuration icon [for 
Custom Subpanel panel]. 

2. Click Add new configuration. The Add panel configuration screen opens. 

 
 

3. Enter the Configuration name and Panel title. The Configuration name you enter will appear in the My/All 
Open Reqs configurations. Panel title will include the ReqID:req title (as Candidate Results panels do) and 
is translatable to all purchased locales. 

4. For Subpanel type, select Custom Candidate Results (you’ll select Report to add the EEO Summary 
Report). When Subpanel type is selected, the lower portion of the panel changes accordingly. 
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5. Click Panel attributes Edit button. The Panel attributes screen launches.  

 
The screen is quite similar to the Candidate Results panel configuration screen, but naturally does not have 
a setting to allow users to override the column configuration (since that would defeat the purpose of tightly 
controlling subpanel processes). Most of the sections are collapsed by default, since you only need to 
configure what is appropriate. 

 
The preceding screen shows the Candidate Actions section for a client that does not 
have all the client settings turned on for the existing options. Exact order of actions will 
vary if additional options are present. 

6. For Display candidates in the following HR Status(es), select one or more HR statuses of the candidates 
to be displayed in the subpanel  

7. In the Candidate Actions list (expand the section if necessary), leave checked only those actions to which 
you want users to have access in this subpanel. Your selections here do not override the user privilege; 
users without appropriate privileges to perform an action will not see the action on their panel. 
If Add Forms is checked, you can also select the forms that will appear for selection in the Add Forms 
secondary menu in the subpanel Actions. Again, this does not override the form privileges for the user type.  
Once the user opens the Talent Record from the panel, the user will once again see all the forms that they 
have the privilege to add. 

8. Check the Disable Talent Record and grid actions setting to allow users to see the candidates and 
column data with no actionable links (e.g., candidate name is plain text without link to open the Talent 
Record, columns in the grid such as HR Status, Notes, Forms, Communications, display with plain text 
substituted for link or icon without “clickability”).  

 
Actions selected in the custom subpanel’s Candidate Actions section will be 
displayed on the Actions menu (if the user has the appropriate privilege) even if 
Disable Talent Record and grid actions is checked. 
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Candida te  Sea rch  

Configure Candidate Search for searching the 2xB database for candidates not currently filed to the req:  

1. Check Enable database candidate searching and the other settings become enabled. 

 
2. Check Auto pass search by Req Code to have the REQID automatically inherited into the Search criteria 

REQ CODE field.  This is useful only for clients without Auto- file or Insta-file turned on. Otherwise, anyone 
with the reqcode is typically already in the req folder. 

3. In View Candidates settings (different from the View More Candidates setting at bottom of screen) controls 
the number of candidates returned (in the search) who will be filed to the req when the search is completed 
and the user is ready to view search results.  The results are returned in descending order of last date 
loaded. Based on that sorting, the first sequential X candidates will be selected and filed to the Req based 
on your Number selection. 

4. For File and update HR status to, select one HR status to which candidates selected from the search 
results will be filed. The selection must be one of the HR statuses selected in “Display candidates in the 
following HR status(es)” setting.  

Filte r Options  

Filter Options allows you to control what filtering can be displayed in the panel’s Filter menu.  

Check either HR Status, Candidate Type, or both options. If neither is checked, the Filter menu does not 
display.  

 

View More  Candida te s  Se ttings  

This action is configured in the Custom Subpanel by checking the box and configuring the necessary source 
pool and candidate options. 
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1. Check Enable “View More Candidates” Action. 

 
 

2. Select one or more HR statuses that will compose the Source Pool of candidates to retrieve from (such as 
“0-Filed” or “Met Basic Qualifications”). The HR statuses selected for Source Pool cannot be selected in the 
Display candidates in the following HR Status(es) setting at the top. 

3. Select how the candidates within the HR statuses will be sorted. You must choose a Primary sort 
(Secondary sort is optional) by TG Score or Date filed to folder. Select ascending or descending, as 
desired. For example, you could sort candidates with higher Talent Gateway scores are at the top, and rank 
those applying earlier within candidates of the same score.  

4. Configure the Number of candidates to be ‘promoted’ from the Source Pool to the custom subpanel, and 
the Selection method for choosing those candidates from the Source Pool (Sequential, or Every 5th, 10th, 
15th, 20th, or 25th candidate). For example, you can configure to promote 20 candidates, taking every 5th one.  
You would get the 1st, 5th, 10th and so on until the system has reached 20 candidates.  
If not enough candidates remain in the Source Pool to fully execute the configured Number of Candidates 
and Selection Method, then the system uses a sequential selection method to promote the top X number of 
candidates (according to the Source Pool sort configured). For example, if Number of Candidates = 10, 
Selection Method = Every 5th candidate, and number of candidates remaining in the Source Pool = 42, the 
system promotes the “top” (per sort) 10 candidates in the Source Pool. 
These configurable selection methods are acceptable to most clients and their litigation departments in 
terms of compliance for OFCCP “random sampling” guidelines. 

5. Select the HR status that the candidates will be ‘promoted’ or updated to via the View More Candidates 
action. It must be one of the HR Statuses selected in the Display candidates in the following HR 
Status(es) setting at the top of the page. 

6. Click Done when finished with the panel’s attributes, and OK on the confirmation. 

 
Because this functionality controls the number of candidates viewed at a particular 
time, when a custom subpanel has View More Candidates enabled, if Candidate 
tiering functionality is used for the requisition, the Candidate tiering will be suspended 
for the custom subpanel. 

Candida te  Grid  Configura tion  

This section is the same as for Candidate Results panel configuration.  
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1. Click Select Field to view and add at least one field row. The fields available for configuration are the same 

as for the Candidate Results panel. 
2. Click Save to save the custom subpanel configuration. 

Save  as  New 

Once you have created a custom subpanel, you can save time when creating a similar one by selecting the 
most similar and using Save as New. All of the settings and configuration of the selected panel should be 
brought over to the new configuration. 

Configuring  Report Cus to m Subpanel  

This is the configuration screen shown when Report is selected as the Subpanel type. 

 
This EEOC type summary panel is the only ‘report type’ to be configured. It is designed to let you see data on 
diversity recruiting during different points in the requisition cycle. 
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1. Enter Configuration name, Panel title, and click Report for Subpanel type. 
2. Select axis for HR Status or Candidate type: Vertical or Horizontal. The same value cannot be selected for 

both. The Candidate form fields will be adjusted accordingly. 
3. Select HR Statuses and Candidates types. At least one row must be configured. Labels can’t be edited for 

the report, but can be translated for your organization’s purchased languages. 
4. Select Candidate form fields, such as the ethnicity and gender fields from EEO or fair employment forms. At 

least one row must be configured. Candidate form fields that can be configured include: Single-Select, Multi-
Select, Checkbox, Radio Button. This includes those of the above type that may also have the following field 
attributes: Auto-fill, and pull from lists where pull options are from lists of options from other form fields ( but 
not from lists of: Active Managers, Active Recruiters, Active Enterprise Users, All active users, Specific 
codes, All open reqs, All pending reqs, All reqs, State, Country). 
Click View/Edit translations to edit these field labels, or to translate for your organization’s purchased 
languages. 

You can perform functions such as View, Preview, Inactivate, Delete for subpanels, either custom or report, just 
as you do for standard Candidate Results panels. 

Configuring  Subpanel fo r My Open  Reqs  o r All Open  Reqs  Panel 

To include a subpanel (either custom or report) on a My/All Open Reqs panel, simply choose it as one of the 
columns for the panel.  

Administer panel configuration > Edit icon [for selected My Open Reqs or All Open Reqs panel] 
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1. On Edit panel configuration screen, click Add row. You’ll repeat this step for the each subpanel you want to 
add. You can add as many subpanels as desired, but bear in mind that best practice is to add no more than 
25 columns per panel. 

2. Select a subpanel and click Submit. Custom subpanels will be categorized as ‘Custom subpanels’ in the 
‘Available’ column; the report will be listed categorized as ‘Report.’  
For My or All Open Reqs panels that are configured with the Allow users to edit panel display options 
setting checked, the 2xB users will be able to select only the custom subpanels that are selected in the 
master Workbench configuration of that My or All Open Reqs panel.  

3. Save the panel configuration once you have added all the subpanels. 

“Hide Search from Candidates menu” User Type Privilege 
To limit the searching done in 2xB to subpanel Candidate Search action, you can also hide, by user type, the 
candidates menu items Search and Saved Searches. The new Hide Search from Candidates menu user type 
privilege does this. 

Tools > Users > User types > Edit type permissions [for selected user type] > Search 

 
When Hide Search from Candidates menu is checked, the following privileges are unavailable for the user type 
e: 

Define - output fields  
Saved searches - create and maintain overnight searches  
Saved searches - create and maintain personal searches  
Saved searches - subscribe to other's overnight searches 
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New Us er In terface  – Enhancements  
Enhancements have been added to the 2x BrassRing New User Interface (New UI). They include: 

• Talent Record enhancements 
o automatically Enabled New Talent Record for all New UI users 
o Additional Ribbon elements  
o Enhanced Talent Record browsing 
o Additional actions in the Talent Record Actions menu 

• Additional Actions menu actions for Candidate Results 
• SmartApproval supported on All/My Reqs Pending Approval panels  
• Performance enhancements 
 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
Enhancements added to the New UI include: 

• Talent Record enhancements 

o Automatically-Enabled New Talent Record for New UI users 

o Additional Ribbon elements  

o Enhanced Talent Record browsing 

o Additional actions in the Talent Record Actions menu 

• Additional Actions menu actions for Candidate Results  

• SmartApproval support on All/My Reqs Pending Approval panels   

• Performance enhancements 

• Disabled Panel mapping and Screen display default for QuickStart User Type 

These enhancements are described in the following sections. 

 
In addition to the enhancements mentioned above, Custom Subpanels are being 
introduced with this release. Custom Subpanels are specialized Candidate Results 
panels that are launched from the My Open Reqs or All Open Reqs panels and display 
the candidates (or a subset of candidates) that are filed to a requisition folder. They are 
designed to guide particular processes, so may have limited actions and filter options. 
See New User Interface – Custom Subpanels in this Product Update Guide for 
complete information on defining and using Custom Subpanels.  

Talent Record Enhancements 
With Release 12.4 we introduced the redesigned Talent Record as part of our ongoing UI and usability updates. 
In order to facilitate the change with your users, we incorporated a temporary setting for activating the new 
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interface, to be available for approximately six months only. We have been working toward additional 
enhancements in the design and functionality, and are pleased to announce that this new design will be enabled 
automatically for all New UI user types as of Release 12.5 Build 0 (this release). Therefore, the setting to 
activate the New Talent Record is no longer available .  

• Only user types with the “New UI” enabled will see the New Talent Record. User types that are not using the 
new UI will continue to see the “classic” Talent Record.  

• The New Talent Record displays only for 2xB users who are logged in: eLinks are NOT AFFECTED. The 
move to the new Talent Record will have no impact on eLinks.  

Ad ditiona l Ribbon  Elements  

Additional fields available for configuration in the Ribbon section include:  

• Attachments 
• Candidate Tiers  
• Agency Referral and Employee Referral fields  
• Additional Applicant Master fields 
• CRM record (requires Kenexa 2x BrassRing Social Source™ candidate relationship management 

integration) 
• Candidate Form fields for active Candidate forms 

Attachments 

Candidate attachments are now part of the default Ribbon setup for both new users and existing users who are 
using the default configuration (that is, user types who don’t have “Screen Display Defaults” modified through 
Workbench). 
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Click the Attachments link to open the Attachments screen for viewing or uploading attachments. The 
attachments that appear, as well as the availability of the Upload New Attachment button, depend on your user 
privileges and any applicable “secure attachment” rules.  

Candidate Tiers 

If your organization uses the Candidate Tiering feature, the Candidate tier field is available for configuration. 
From within a Req folder, the value displayed is either the tier number or "Not Specified" if no tier is assigned for 
the current Req. For privileged users, the value is a link.  

If the candidate is being viewed from outside of a Req folder (for example, through search results or My 
Candidates panel where the candidate is in a working folder or inbox), only the View icon displays. 
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Click the field link to launch the classic "Update Candidate Tier" page. 

 
Click the View icon to launch the "View Tiers" page. 

 

Agency Referral Fields 

Several agency fields are available for configuration on the Ribbon if your organization uses Agency Manager: 

• Referral type 
• Agency name 
• Agency initial submission date 

Best practice is to use Referral type in combination with one or more of the Agency fields, so referral history is 
available. The other Agency fields are specific to the req (or Candidate if ownership is per candidate).  

Agency name displays if there is an active agency association at the candidate level, or at the req level for the 
req being viewed. “N/A” displays if there is no agency association (either by candidate or per req when that req 
isn't currently being viewed), or if the agency association has expired or been removed. 

The date of the initial Agency submission displays if there is an active agency association at the candidate level, 
or at the req level for the req being viewed. Otherwise, “N/A” displays. 
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To open the agency history, simply click the Agency link in the Referral type field. 

Employee Referral Fields 

Employee referral fields available for configuration on the Ribbon include: 

• Referral type 

• Employee referral status 

• Employee referral status date 

Best practice is to use Referral type in combination with one or more of the employee referral fields, so referral 
history is available. The other employee referral fields are specific to the req. Employee shows as the Referral 
type when the candidate has been submitted through an Employee Referral gateway for the Req from which the 
candidate is being viewed (and has any Referral status), or when the candidate is being viewed outside a Req 
and was submitted as a general submission. 

Employee referral status displays if the candidate has ever been submitted through an Employee Referral 
Gateway. If the candidate was submitted for the req being viewed, the most recently-updated status tied to the 
submission for that req displays. If the candidate was not submitted to the req being viewed, but had a general 
submission, then the most recent general submission status displays. If you are viewing from outside a req 
folder (for example, from working folders, inbox, or My Candidates) the general submission status also displays. 
If the candidate has never been submitted through an Employee Referral Gateway, then “N/A” displays. 

The date of the most recently-updated employee referral status tied to the submission for the Req being viewed 
displays if the candidate has ever been submitted through an Employee Referral Gateway. Otherwise, “N/A” 
displays. 
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To open the referral history, simply click the Employee link in the Referral type field. 

Additional Applicant Master Fields 

Additional Applicant Master fields available for configuration in the Ribbon include: 

• Country 
• Field of study 
• First name 
• Grad year 
• Language 
• Last name 
• Other phone 
• Work phone 

When configured for users with the Candidate Actions “Candidate profile - edit overview” privilege, editable 
Applicant Master fields display as hyperlinked text. If no data exists, “N/A” displays (First name, last name and 
language are never blank). The Language value is not editable. 

Value selected as “Most Recent” displays for Field of study and Grad year fields. The original information 
displays even if you or the candidate edits these fields. 
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To edit any of the Applicant Master fields, click the appropriate link. 

CRM Record 

This item requires that your organization has enabled the 2xB Social Source Candidate Relationship 
Management integration. See the Kenexa 2x BrassRing® and Kenexa 2x BrassRing Social Source™ 
Integration User Guide for full information on using the feature.  

 
To view a CRM record or add a candidate to CRM if a record does not yet exist, click the link (requires “CRM – 
copy candidate to CRM” privilege). 

Candidate Form Fields 

“Outputable” fields for all active Candidate forms are also available for configuration on the Ribbon for 
convenient viewing. Fields appear if they have been added for the user type in the location configured.  

The following figure shows an example of assessments form fields in the Ribbon (integrated Kenexa 
Assessments feature is enabled). 

 
Note that special characteristics of the fields will display: 

1. Text and color configured for a field display, as well as any HTML coding in the response that changes the 
text display. 

2. Response text with a hyperlink displays as the hyperlink. 
3. All other responses, text, and select options display as plain text. 
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4. A dash (–) displays if no data exists for the configured field (form is not filled out or the field has not been 
completed). 

You will see the value N/A when you don’t have required access to a form field. This can occur if the field has 
been configured for your user type but you fail to meet any of the following criteria: 

• User Privilege: Candidate Actions “Candidates - view forms” required 
• Form Privileges: Add/View/Modify My (and form has been added by you) OR View all privilege required 
• Field level attributes: "Hide by these user types" must not be selected 

If more than one occurrence of a configured form exists, the following rules apply to determine which response 
to display in the ribbon. 

• For multiple occurrences of a per-req form:  

• From within associated req – show most recently added (not edited) version for that req 
• From outside associated req but still in a req folder  – show ”-“ if no response for that req 

• From Search results (including “Filter Folder”, Quick search results, My candidates, Inbox, and Working 
folders – Show the most recent version for any reqFor multiple occurrences of a per-candidate form, 
show the most recent version in all views.  

Ribbon  Fie lds  Availab le  – Comple te  Lis ing   

• Candidate Reference Number • GPA • Notes 

• First name • Grad year • TG Score 

• Last Name • Employer • Last viewed (global) 

• Address 1 • Position Held • Last viewed (global) by 

• Location • Country • Viewed (this Req) 

• Home Phone • Language • Agency initial submission date 
(if Agency Manager is enabled) 

• Other phone • Candidate Type • Agency name (if Agency 
Manager is enabled) 

• Work phone  • Codes • Attachments 

• Email • Communications • Candidate tier (if enabled) 

• Original Date Loaded • Forms • CRM Record (if enabled) 

• How Received  • HR Status • Employee referral status 

• Educational Institute • HR Status Date • Employee referral status date 

• Field of study • HR Status updated by • Referral type 

• Degree • Unencrypted candidate form fields designated as "outputable" with 
the following field types: 
Date, email address, numeric, single select, radio button, text 
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Enhanced  Talen t Record  Brows ing  

A new “Speed Browse” mode for the Talent Record’s Resume/CV section lets you quickly review information for 
multiple candidates side-by-side.  

The Speed Browse action is available on the Candidate Results panel and Custom Candidate Results 
Subpanel (if configured). To launch this resume display, select one or more candidates and click Speed 
Browse in the Actions menu.  

 
The screen initially displays the Resume/CV tab contents for candidates currently being shown. You can change 
the “Showing” number to show up to five resumes at once. 
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Toggle between tabs to conveniently compare the selected candidate records you are browsing.  

 

Extended  Talen t Record  Action s  Menu   

Additional actions in the Talent Record Actions menu allow more flexibility, especially when browsing multiple 
candidates. In either “Browse Multiple Candidates” mode or the new “Speed Browse” Resume/CV mode, you 
can use these new actions: 

• Add Note – select one or more candidates to launch Add Notes pop-up (requires Candidate Actions “Notes 
– add private” or “Notes – add public” privilege) 

• Add Form – select one or more candidates to open the forms list from which to make selection of form to 
add (requires Candidate Actions “Candidates – view forms" AND "Add/View/Modify My" permission for at 
least one active candidate form). Usual form rules apply (e.g., for per-req forms, candidates must be in 
same req folder). 

• Update Status – select one or more candidates in the same HR Status to open the HR Status list and 
choose new status (requires Candidate Actions “HR status – add/update in my reqs/my folders/my inbox” or 
“HR status - add/update in all reqs/all folders/my inbox” privilege). 

• Remove from Folder – select candidates in a final or 0-filed HR Status. On confirmation, removes the 
candidate, closes the Talent Record, and reloads the Candidate Results panel or classic grid (requires 
Candidate Actions “Candidates - remove from folders (working/inbox)” privilege). Note that this action is also 
now available on the Candidate Results panel when launched from My Candidates. 

• Print Resume/CV – select up to candidates to print their most resent submission, which is not necessarily 
the version being viewed (requires Candidate Actions “CRM – copy candidate to CRM” privilege) 

• Prepare for Bulk Printing – select up to 100 candidates (requires "Candidate Actions 2 ”Bulk print - 
request/receive files” privilege) 
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Talent Record Actions 

 

For Speed Browse, the Actions menu presents actions designed for your reviewing workflow. In addition to the 
actions described above, privileged users also have these actions available: 

• Send eLink  • File to Folder  

• Send Candidate ad-hoc Email  • Send Interview Request  

• Send Candidate Communication  • Schedule Interview  

• File to Req  • Send to Event Manager 
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Speed Browse Actions 

 

Ad d to  Socia l Sou rce  Ac tion  

The Add to Social Source action is available to organizations that have enabled the Kenexa 2x BrassRIng 
Social Source candidate relationship management integration. You can select only one candidate to export the 
candidate data to Social Source for creation of a CRM record (requires “CRM – copy candidate to CRM” 
privilege).   

The following shows an example of the record that will be created. After creation, you can click the link in the 
candidate’s Talent Record to view it (if the CRM field has been configured for the Ribbon).  

  
The Add to Social Source action is also available on the Actions menu for the Candidate Results panel and 
Custom Candidate Results Subpanel. 
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See the Kenexa 2x BrassRing® and Kenexa 2x BrassRing Social Source™ Integration User Guide for full 
information on using the feature. 

Candidate Results and Custom Candidate Results Subpanel Actions Menu Updates 
Additional Actions menu items in the Candidate Results panel include: 

• Add Codes 
• Open Talent Comparison 
• Add to Social Source (requires Kenexa 2x BrassRing Social Source integration) 
• Prepare for Bulk Printing 
• Stack Duplicates 
• Erase 
• Speed Browse 
• Send to Event Manager 

 
These candidate actions are also available when designing Custom Subpanels in 
Workbench (described in the New User Interface – Custom Subpanels document). 

The following figures show examples of the pages launched when you select the actions from the menu. 

Add Codes – select up to 25 distinct candidates (requires Candidate Actions “Codes - add to candidate” 
privilege). 
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Open Talent Comparison – select between 2 and 5 candidates (requires Reports 2 “Talent Comparison 
Summary” privilege). This action is only available from the All/My Open Reqs panels. 

 
Add to Social Source action (previously described) requires Kenexa 2x BrassRing Social Source integration 
and the “CRM – copy candidate to CRM” privilege. You can select only one candidate. 
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Prepare for Bulk Printing – select up to 100 candidates (requires Candidate Actions 2 "Bulk print - 
request/receive files” privilege). 
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Stack Duplicates – select 2 candidates (requires Candidate Actions “Duplicates - stack” privilege). 
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Erase – select as many candidates as desired (requires Candidate Actions “Candidates - erase” privilege).  

 
Speed Browse (previously described) is a new action available on the Actions menu for quick side-by-side 
review of the Talent Record’s Resume/CV section for up to five candidates at once. Select one or more 
candidates.  
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Send to Event Manager – select up to 200 candidates (requires " Integration > Event Manager - enabled” 
privilege).  

 

 
The “Update same status” action from the interior candidate Actions Menu is no longer 
needed in the panels since the following other workflows are supported: 

• To update multiple selected candidates, select the candidates then either use the 
HR Status dropdown in the grid for any selected candidate to apply to all those 
selected OR use “Update HR Status” from the Actions Menu. 

• To update all candidates who are in a particular status: select the linked number 
for that status from the Open Reqs panel. If the status does not appear in the 
panel, it can be added by appropriately privileged users through Display menu > 
Edit Columns); use the checkbox at the top of the grid to select all; then update 
status as noted above. 

OR – click on any linked number from a Reqs panel; select the Filter menu > HR 
Status > [select desired status; then proceed as above]. 

 

SmartApproval Approvers in Req Panels 
All Reqs Pending Approval and My Reqs Pending Approval panels now display SmartApproval approvers in the 
Next Approver column, and will also have the actionable check mark in the Approve column when you are the 
next SmartApproval approver. 
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Clicking the check mark for a requisition follows the workflow for your approval method: 2xB sequential approval 
workflow or SmartApproval workflow. 
For 2xB - opens 2xB Approve/Decline window 
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For SmartApproval – opens req to select View approvals 

 
View approvals takes user to SmartApproval  
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Performance Enhancements – Welcome Page and Talent Record 
In order to decrease load time of the Welcome Page, Panels and Talent Record, a number of changes are being 
made with this and upcoming builds. In addition to the Talent Record, these changes affect the My/All Open 
Reqs Panels, the My/All Reqs Pending Approval panels, and the Candidate Results panel.  Most of these 
changes will not be noticed by users except for the fact that panels and pages will load more quickly.  

One exception that users may notice is listed below: 

Scroll-to-load-rows (this change will go into effect approximately 3 weeks after the 12.5 Release) 

When users scroll within a grid, the grid renders only the visible rows and the next one or two rows below the 
bottom of the panel. When users move the scroll bar handle, the next set of rows will load, and in some cases, 
the user may briefly see a “loading…” message on the screen.   

How Do Clients Get this Feature? 
Some of the features for the New UI require configuration or panel configuration in Workbench Self-Service. 
Please contact your CSC or Certified Workbench User for more information about enabling these features.  

Workbench Self-Service 
Who does this: Certified Workbench User, Tier 4 and above 

New Ribbon  Fie lds  

The configuration process for adding fields to the Ribbon display is unchanged. Follow the steps to add any of 
these new fields. 

• [Panel Standard] Attachments 
Value link launches Attachments screen for 
viewing or uploading. By default Attachments is 
the fourth item in Pane 3 

• [Applicant Master] Country 
Value link launches Edit page 

• [Panel Standard] Candidate tier 
Value link launches Update Candidate Tier page 

• [Applicant Master] Field of study 
Value link launches Edit page 

• [Panel Standard] Referral type (Agency) 
Value link launches Agency Contact Information 
page 

• [Applicant Master] First name 
Value link launches Edit page 

• [Panel Standard] Agency name • [Applicant Master] Grad year 
Value link launches Edit page 

• [Panel Standard] Agency initial submission date • [Applicant Master] Language 

• [Panel Standard] Referral type (Employee) 
Value link launches Referral history page 

• [Applicant Master] Last name 
Value link launches Edit page 

• [Panel Standard] Employee referral status • [Applicant Master] Other phone 
Value link launches Edit page 

• [Panel Standard] Employee referral status date • [Applicant Master] Work phone 
Value link launches Edit page 

• [Panel Standard] CRM Record 
Link launches View CRM record or Add (export 
to CRM). Requires 2xB Social Source 
integration.) 
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Also 

• Candidate Form fields, including all active 
Candidate forms that have one or more fields of 
the following type: 

Designated as "outputable" and Field types of: 
Date, email address, numeric, single select, 
radio button, text, and NOT encrypted. For 
single selection and radio button types, if the 
options are set for “query select”, these fields 
also are EXCLUDED from the list. 

Candidate form fields appear in the Search for 
field list in order by form name, then field name 
in the following format (shown at right):  
[Form name] Field label   

Response text with a hyperlink displays as the 
hyperlink 

To add fields to the Ribbon: 

1. Select Tools > Users > User Types > [Select User type] > Screen display defaults. 
2. For the Ribbon in the Talent Record section, locate the pane to which you want to add the fields – 

maximum of four per pane. (You can add panes as necessary for each desired field or set of new fields.) 
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Note: The new Attachments field appears in default Ribbon configurations for all existing user types that 
have not been modified, as the fourth item in Pane 3. You do not need to add it unless it has been removed 
or you want it in another pane location. 

3. Click Select field.  
4. Choose desired fields (up to four can be added to a pane, to be displayed top-to-bottom).  

 
 

5. Click Submit, then complete any other configuration changes/additions before saving. 

 
Best Practice Configuration Note: Although Workbench allows the configuration of 
up to 25 panes in the ribbon, with the additional of Candidate form fields and other 
panel standard fields as options, it is recommended that no more than 15 panes 
should be configured. As additional panes and fields are configured, the load time of 
the Talent Record and scrolling of the ribbon could become significantly delayed. 

 

SmartApp roval Approvers  

There is no functional change to configuration, but the setting ‘Show only reqs that require the user’s own 
approval in this panel’ for the ‘My Reqs Pending Approval’ and ‘All Reqs Pending Approval’ panels continues to 
apply. This is set in Tools > Settings > Panel Configurations > Administer Configuration [for either Reqs 
Pending Approval panel. 
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QuickStart User Type – Disabled Panel Mapping and Screen Display Defaults 
The "QuickStart" standard user type controls access and privileges for users who are not logged into 2xB. 
Previously Workbench allowed configuration of some New UI settings that were useful only for users logged into 
2xB (and thus ineffective for QuickStart users). This release no longer allows this.  

Thus the following actions are no longer available in Workbench.  

• User type panel mapping 
• Screen display defaults 

 
In Tools > Users > User types, if you select QuickStart user type and either of these actions, the message 
displayed is: “This action is not valid for the QuickStart user type.” 

As of this release, any active panel mappings in place for the QuickStart user type will be deleted. Note that 
QuickStart users will continue to see their usual eLinked Talent Record displays, not the redesigned Talent 
Record. 
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Pos ting  Reqs  – Broadbean  Enhancements  
Several updates to the integration enhance the user experience in posting reqs to Broadbean. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Integrations 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Enhancements to the integration of 2xB with Broadbean include: 

• New client setting removes the intermediate posting page.  
• Apply URL mapping support is provided by a new custom req field: Job apply URL. It is created 

automatically as a query select option when Broadbean is configured as a posting partner, 
• Location fields mapping is now allowed 
• Support for up to five custom fields/user defined fields has been added 
• Number of required fields has been reduced 
• Rules for the Job Apply URL Talent Gateway setting have been simplified 

Once Broadbean has been configured with these enhanced features, 2xB users can post reqs to Broadbean in 
the usual fashion (select a req > select Posting options > scroll down to Other posting options). 

 

Language  Support – 2xB Us er Exp erience  

Broadbean does not currently support multiple languages req posting on initial post. However, 2xB users can 
post reqs sequentially for each language. For example:  

1. When a user creates a req in multiple languages, 2xB sends all the selected req languages to Broadbean.  
Once on the Broadbean User Interface, the user is prompted to select one req language for the posting. If 
the user selects English, the req will be posted in English. In Broadbean’s system that req is considered the 
first req in that language(req 1) 

2. If the user goes back into 2xB and reposts the same req to Broadbean, then on the Broadbean User 
Interface the user will again be prompted to select a language. If the user selects French then the req will be 
posted in French, and will be req 2 in French. (Since it is the same req ID there should be no additional 
posting fee, but it is recommended you verify this with Broadbean).  

If a user edits the English version only, it updates that req in English only. 

If a user deletes (closing the req in 2xB) a req, the deletion applies to the all posted language versions of that 
req.  
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How Do Clients Get this Feature? 
This feature is controlled by new client settings, as well as by tools in Workbench and 2xB Admin . Please 
contact your CSC or Certified Workbench User for more information about enabling this feature.  

Workbench Self-Service Certified Users 
Workbench Self-Service users can perform a number of tasks related to setting up this feature. 

• Add JobApplyURL to req templates 
• Set Talent Gateway JobApply URLs (requires Level 5 certification) 
• 2xB Admin users add or edit posting partner information to allow users to post to Broadbean. 

Ad ding  J ob App lyURL to  Req  Templa tes  

The custom req field “JobApplyURL” (field name “Job Apply URL”) is automatically created as a query-select 
option when Broadbean is enabled for your account. You must manually add it to req form template(s) that will 
be used for posting to Broadbean.  

Do this in: 

Tools > Forms > Reqs > Req forms > Administer req fields > Select custom req fields 

Select JobApplyUrl, position it where desired, and Save the template. 

J ob  App ly URL- Exis ting  Workbench  Talen t Gateway S e tting  

This requires Workbench Self-Service Level 5 certification. 

Business rules for Tools > Talent Gateways > Admin > Add/Edit a Talent Gateway have changed 
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• On the Talent Gateway details page, “Intro URL” field is used to create the posting partner URL. 
• The page now includes the “Add as job apply URL option to Posting Partners” checkbox option, unchecked 

by default. Once checked and saved, it becomes “non-editable.”  

For 2xB posting partner functionality, checking this setting makes the Talent Gateway 

• available for selection in the req for the field mapped to “Job Apply URL” for the posting interface 
• available in the posting intermediary page, regardless of req mapping (though it may be restricted to req 

field selection(s) in case mapping is done).  

Language Support 

Ensure that at least 1 Job Apply URL has been set up for each req language needed for posting. Business rules 
for Job Apply URL handling by language (limited to those languages supported by both Kenexa and Broadbean) 
are:   

• Each language of req must have a single job apply URL (TG) selected.  
• If all languages of the req have either one TG selected, or only one TG exists for that language, then the 

“job apply URL selection” screen (shown when client has the setting to skip the full intermediate page) will 
not display.  

• Per language of req: 
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o If only single job apply URL exists (whether selected or not) 
--do not display the “job apply URL selection” screen  

o If multiple job apply URLs exist and none are selected 
--display on “job apply URL selection” screen with all options for this language 

 
o If multiple job apply URLs exist and only one is selected 

--do not display “job apply URL selection” screen 

o If multiple job apply URLs exist and 2 or more are selected 
--display on “job apply URL selection” screen with only selected options for this language. 

Example scenario: req exists in English-US, English-US-Govt and French-France: 

o User selects 2 English-US TGs and 3 French TGs, then “job apply URL selection” screen displays 
only those 2 selected English TGs for a English-US question and only the 3 selected French TGs 
for a French question.  

o User selects 1 English-US TG and no French TGs, then “job apply URL selection” screen displays 
ALL French TGs for the French questions (and English-US question would not display). 

o User selects 1 English-US TG and 1 French TG, then this page is skipped. 

Only TGs set as job apply URL option will display in these lists and only for the appropriate language. 

• If the client setting is configured to skip the intermediate page, then intermediate posting page will be 
skipped if the Req has a valid “Job Apply URL” mapped. For example, if the Req is created in 3 languages 
and only 2 languages have Job Apply URLs, then the req posts in 2 languages only. If the Req has 1 Job 
Apply URL selected for those 2 languages, the req mapping is considered valid for those 2 so the 
intermediate page is skipped. 

2x BrassRing Admin/Admin+ Users 
In 2xB, Admin users add or edit posting partner information for their profile or for other users, depending on their 
2xB user privileges. 

 For “Add new posting partner” function, 2xB will only list the posting partner vendors the client has 
selected in Workbench and which are not yet set up for this user. (Figure 5.) 

 It there are no posting partners available, clicking “Add new posting partner” will display a pop-up 
window: “No posting partner accounts are available at this time.” (Figure 6.) 
Note: this is a change to the text that currently displays when accounts have been sent up for all 
posting partners and no more exist.  In addition, this message will display if client has no posting 
partners set up in workbench. 
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3. Select Admin > Posting interface defaults > Edit my profile or Edit selected users 

 
4. Select Add new posting partner from Actions to add Broadbean as a posting partner. The add page 

appears with available vendors listed that are not yet set up for this user. (If your account was already using 
Broadbean, you can select the Edit icon.) 

 
 



 

 

Remote  Recru ite r – Candida te  S tacking  
Stacking logic can now be configured for Remote Recruiter.  (Remote Recruiter was formerly called Mobile 
Recruiter, but has been renamed to avoid confusion with the Kenexa 2x Mobile product.) 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Remote Recruiter 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Duplicate stacking logic can now be configured in Navigator and applied to Remote Recruiter, just as for 
candidates entering the system via Talent Gateways. With this change, Email and Home phone fields may not 
be required, since additional stacking field options are available for configuration for Remote Recruiter. 

Additionally, the Candidate stacking field is now allowed and supported for candidate upload via Remote 
Recruiter as well as for duplicate stacking logic configuration. Note that this is independent of stacking logic (i.e., 
if your organization has this stacking field enabled, then the candidate upload will allow it, regardless of stacking 
logic chosen. Previously, the Candidate stacking field would be rejected. 

Full stacking logic functionality also allows the use of the Candidate stacking field, for upload via Remote 
Recruiter as well as for stacking logic configuration, if your organization enables this field. Note that upload 
support for the Candidate stacking field is independent of stacking logic (i.e., if your organization has this 
stacking field enabled, then the candidate upload will allow it, regardless of stacking logic chosen. Previously, 
the Candidate stacking field would be rejected. 

 
Remote Recruiter is a standalone companion product that allows recruiters to 
download necessary candidate forms, access reqs, update forms, and synchronize all 
updated files into 2x BrassRing. All the screens, including the installer and exe 
filenames, are changed to “Remote Recruiter.” 

How Do Clients Get this Feature? 
This feature is controlled by a new client setting. Please contact your CSC for more information about enabling 
this feature.  



 

 

Reqs  – Removing  Expired  Pos tings  from Externa l Boards  
This feature provides automatic removal of job postings from external job boards when the posting on the 
associated 2x BrassRing Talent Gateway expires.  

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – see the Visible Changes document sent out for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Benefits 
Recruiters who have posted reqs to job boards no longer need to manually remove the expired posting from the 
external job board.  

Feature Description 
Reqs that are posted to external job boards will automatically be removed from those job boards when their 
associated 2x BrassRing Talent Gateway (TG) posting expires. 

Job postings expire in three ways: 

• Req closure – When a req closes, the job posting expires from all TGs and job boards. 
• Manual removal – When a user manually removes a job from a TG, the job posting expires. 
• Posting expiry – Jobs expire on a TG after the end date (specified at the time the user posts a job to the 

TG). 

2xB already removes the posting from external boards in the first two cases, and now also removes it in the third 
case, at posting expiration. Postings are removed from all 2xB posting partners, including: TalentBrew, 
Broadbean, Prospect, Arbita, FirstAdvantage, SmartPost, and eQuest.   

This feature also supports clients who have enabled the client setting Job Posting Removal Time &Time 
Zone. When a posting expires at a particular time, the associated job board postings are removed. 

The removal process: 

1. Finds all the jobs that expired “today” from all your TGs. 
2. Finds all your external job boards that are using the JobApplyURL of those TGs. 
3. Expires those jobs from each external job board as well, since they are already expired on TGs. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration, and affects all clients who post to external job 
boards. 



 

Reqs  – Requis ition  Notes  
This feature allows a control at the requisition template level for display of a new Notes tab in requisition View 
mode. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
This feature allows users to add notes for requisitions similar to the way they do for candidates. The notes 
appear on a Notes tab (different from the Notes field on the requisition form, which will still be available). 

A req form attribute must be set on the requisition template for the Notes tab to display when users are viewing 
a req or a req panel. In addition, users require privileges to: view/add, edit, or delete the notes. 
Panel and View Reqs with Notes Column 
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Privileged users in 2xB add or access the notes by clicking the add and view icons, or from View requisition. 
When the requisition is in view mode, there is another tab for Notes.   

Information shown for each note includes: 

• Added date 
• Added by 
• Note text 
• Edit / Delete icons for editing or deleting (requires privilege) 
Notes tab 

 
Screen shown after clicking Add/View icon 

 
To add a note: 

• Click + icon in Notes column in panel or view reqs grid 
• Click Add note in Add/View Req Notes pop-up screen 
• Click Add note in Notes tab on requisition view mode 
• Click Add note in Notes tab on reqs eLinked in View mode 
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Add Note pop-up  

 
Text can include HTML. Click Save after entering your text. 

The difference between req notes and candidate notes is that there are no reminders and no concept of public 
vs. private notes (although user type privileges are granted for “all” reqs or “my” reqs, conferring a limited 
degree of privacy). 

Edit and Delete 

To edit a note, users with My reqs – notes (Notes tab) – edit or All reqs – notes (Notes tab) – edit can click 
the Edit pencil icon, and make your changes on the resulting screen. Although the Updated date and the 
Updated by information is captured, the view of the note will continue to show the Added on Date and the Note 
creator. 

To delete, users with My reqs – notes (Notes tab) – delete or All reqs – notes (Notes tab) – delete can click 
the Delete trash can icon, and click OK to confirm. Once the note is deleted, it can not be retrieved. 

How Do Clients Get this Feature? 
This feature is controlled by a new requisition form attribute, new user type privileges, and by the addition of the 
new requisition notes column to requisition panels via panel configuration. Please contact your CSC or Certified 
Workbench User for more information. 

Workbench Self-Service Certified Users 
A new requisition form attribute and new user type privileges control this feature. 

Set Req  Fo rm Attribu te  

The new Display notes tab attribute allows appropriately privileged users to see a Notes tab on requisitions 
created with this template when the requisition is in view mode. 

In Tools > Forms > Reqs > Req Forms > Edit form attributes [for selected form], check the attribute and 
Save the form. 
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Set Us er Type  Privileges  

Set the privileges for user types in Tools > Users > User Types > Edit type permissions [for selected user 
type] >  

My Reqs > Set privileges (these privileges are conferred only where the user type has a “My reqs” relationship 
with the req) 

• My reqs – notes (Notes tab) – add/view 
• My reqs – notes (Notes tab) – delete 
• My reqs – notes (Notes tab) – edit 

–OR– 

Reqs 2 > Set privileges (Reqs 2 is a new category of privileges for user types with access to all requisitions, 
regardless of whether they have a ‘my’ relationship with the req. 

• All reqs – notes (Notes tab) – add/view 
• All reqs – notes (Notes tab) – delete 
• All reqs – notes (Notes tab) – edit 



   

 

 

Copyright Kenexa® 2011 Reqs – Requisition Notes | 5 

 

 
• All/My reqs – notes (Notes tab) – add/view 

Check to allow users to view and add notes on the Notes tab (for req forms configured to display a Notes 
tab) in requisition View mode. Users can also use [Panel Standard] Notes field in user-defined panel 
configurations.  
If either All/My reqs – notes (Notes tab) – delete or All/My reqs – notes (Notes tab) – edit privileges are 
checked, this privilege is automatically checked and uneditable. If either of those privileges is unchecked, 
this privilege remains checked but becomes editable. 

• Al/My reqs – notes (Notes tab) – delete 
Check to make the delete icon and Delete column visible and allow users to delete all notes in the 
requisition Notes tab 

• All/My reqs – notes (Notes tab) – edit 
Check to make the edit icon and Edit column visible and allow users to edit all notes in the requisition Notes 
tab. 

Configure  Panel 

Add the new requisition notes column to a requisition panel, or allow users to add the column via the Display 
menu 2xB New UI by configuring the panel with “Allow users to edit panel display options” checked. 

Panels for which you can add the Notes column include:  

• My Open Reqs  
• All Open Reqs  
• My Reqs Pending Approval  
• All Reqs Pending Approval 

Tools > Settings > Panel configuration > Administer panel configuration > Edit icon [for selected 
requisition panel] 

1. On Edit panel configuration screen, click Add row.  
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2. Select the [Panel standard] Notes field and click Submit.’  
For reqs panels that are configured with the Allow users to edit panel display options setting checked, 
the 2xB users will be able to select the Notes column only if it is selected in the master Workbench 
configuration of that panel.  

3. Save the panel configuration once you have added the column. 

2x BrassRing Users  
To add the requisition Notes column to your display: 

New UI 
 If a New UI panel is configured with the Allow users to edit panel display options, 2xB users can click the 
panel’s Display menu and select Edit columns to add the new Req Notes column. 

 
The column is available only if the user has user type privilege of either All reqs – notes (Notes tab) – 
add/view OR My reqs – notes (Notes tab) – add/view. 

Classic 2xB 
Select Reqs > My reqs> Edit output fields.  
No user privilege is associated with being able to see the new column in the Edit Output fields screen.  
However, if the user does not have either All reqs – notes (Notes tab) – add/view OR My reqs – notes 
(Notes tab) – add/view privileges, the column will remain blank for every row. 
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SSO – Redirec tion  on  Timeout 
This feature is for clients with access to 2xB via both the usual 2xB login page and via a link on an authenticated 
Portal site configured with Single Sign-On (SSO). Upon timeout within 2xB, users are redirected to the page 
from which they logged in. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
This feature is for clients with access to 2xB via both the usual 2xB login page and via a link on an authenticated 
Portal site configured with Single Sign-On (SSO). Upon timeout within 2xB, users are redirected to their point of 
entry, either the portal site or the login page.  

Clients can add customizable text to the warning pop-up window indicating the pending time out. The application 
remembers whether the user came from usual login or SSO login, and the session expiration warning popup 
window appends the appropriate configured text to the existing standard text. 

2xB Us er Exp erience  

Both portal users and users logging into 2xB via “normal” login follow their customary process for SSO 
authentication or login.  

If their session expires due to inactivity, they see the session expiry warning with the appropriate custom 
instruction text. When they click OK for the warning, they are redirected to their point of entry. 

If they log out, they will also be directed to their point of entry (without seeing the expiry warning, of course). 

How Do Clients Get this Feature? 
This feature is controlled by a client setting. Please contact your CSC for more information about enabling this 
feature. In addition, a new Workbench Self-Service Instruction menu item is available for customizing instruction 
text. 

Workbench Self-Service Certified Users 
A new menu item in Tools-> Settings-> Instructions-> Session expiry instructions opens the following page 
for entering custom instruction text. Separate custom text is configurable for SSO and standard login pages. 
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HTML is allowed. There is no default text. To preview your text, click Preview. 

The configured text (if any) will be appended to the existing standard text when the session expiration warning 
pops up. 
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Sys tem Support – Brows ers  and  Languages  
Browser/OS Support 

For continuously-updated information on supported platforms and browsers, please see the Browser/OS 
Support document on the User Resource Center. For your convenience, the information current as of the 12.5 
release in July 2011 is included in this document – “Kenexa 2x BrassRing™ Supported Browsers” PDF file.  

Language Support 

As of Release 12.5, 2x BrassRing has a Serbian language interface available. RDP458 

For the full list of supported languages that is continuously-updated, please see the Language Support 
document on the User Resource Center. For your convenience, the information current as of the 12.5 release in 
July 2011 is included in this document – “Kenexa 2x BrassRing Supported Languages” PDF file. 



 

Talen t Gateways  – Candida te  Pas s word Re-au then tica tion  
This feature introduces a new candidate e-signature validation process. When candidates accept offer letters via 
the candidate portal or when candidates submit gateway questionnaires (GQ), they are required to re-enter their 
Talent Gateway passwords to validate their e-signatures. After validation, candidates and 2xB users can view 
validation information including the candidate name and the date and time stamp when the validation was 
completed.  

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
This feature introduces a new candidate e-signature validation process for offer letters and GQ submissions. 
Configuration of this feature prompts candidates to re-enter their TG password when accepting offer letters via 
the candidate portal or when submitting GQs. 

When the TG document subsidiary form is enabled to require password re-entry, the offer letter response form 
displays a validation password re-entry dialog box when candidates submit e-signatures accepting offer letters. 
When the GQ widget requiring password re-entry is enabled, the GQ response form displays a GQ validation 
password re-entry dialog box when candidates submit GQs.  

When candidates re-enter and validate their passwords, the offer letter response form and the GQ response 
form display the candidate name, date, and time stamp for each e-signature validation. The default date and 
time display is in US EST and military time format (example:  22-Dec-2010 17:00). Both candidates and 2xB 
users can view the validation response forms. 

2x BrassRing Users - Offer Letter Response Form 
When the TG document subsidiary form requiring password re-entry is enabled, the offer letter response form  
displays a password re-entry dialog box when candidates submit e-signatures accepting offer letters. All 
passwords are case sensitive. When passwords are entered, the data is masked. If an incorrect password is 
entered, an error message in red displays to the right of the password entry text box. There is no limit to the 
number of times a candidate can re-enter their password. The offer letter e-signature validation dialog box only 
displays validation information and does not display the candidate’s passwords.  

• The following workflow outlines what occurs when a candidate submits their e-signature on an offer letter. 
The offer letter response form dialog box prompts the candidate to re-enter and validate their password as 
shown below. 
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• When the candidate enters the password and clicks Save, the offer letter e-signature validation displays 

with the date of the candidate’s form submittal and password re-entry verification. The candidate can 
choose to eLink, Edit, or Delete the form.  

 
If the candidate chooses to view the original submission, the candidate clicks the Click Here hyperlink. The 
Click Here hyperlink opens an HTML version of the form displaying the questions and selected answers at the 
time the candidate submitted the form. This is a read only version of the form displaying the candidate name 
and the date and time of their submission. The name and date format will match that configured for the 
associated TG via WB>Tools>Talent Gateways>Localization. Time will be in US EST time and displayed in 
military format. 
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• If the candidate chooses not to view the original offer letter validations, the candidate clicks Close. 

2x BrassRing Users - GQ Questionnaire 
When the GQ widget attribute requiring password re-entry is enabled, it displays a password  
re-entry dialog box when candidates submit GQs. Cndidates must re-enter their passwords in order to proceed 
with the GQ. All passwords are case sensitive. When passwords are entered, the data is masked. If an incorrect 
password is entered, an error message in red displays to the right of the password entry text box. There is no 
limit to the number of times a candidate can re-enter their password. 

When a candidate successfully submits the GQ and verifies their password, the GQ response form displays the 
e-signature validation showing the candidate’s name, the date, and the time stamp for each e-signature 
validation. The default date and time display is in US EST and military time format (example:  22-Dec-2010 
17:00). 

The GQ widget attribute can be enabled for multiple question widgets on a single gateway questionnaire.  

 

Note: If the GQ being accessed does not have login enabled, the password re-entry 
field does not display.  

The following workflow outlines what occurs when a candidate submits a GQ and the GQ widget attribute 
requiring password re-entry is enabled. 
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• When the candidate enters their password and clicks Submit, the GQ e-signature validation displays on the 

GQ. 
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• The candidate clicks Close. 

Limitations and Known Issues 
The e-signature validation name, date, and time stamp are not reportable by standard reporting processes.  

How Do Clients Get this Feature? 
A new TG administration setting configures the document subsidiary password re-entry box to display on the 
offer letter response form. The GQ response form requires the configuration of a new question attribute on the 
GQ widget. Please contact your CSC or Certified Workbench User for more information. 
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Workbench Self-Service Certified Users – Tier 5 
To configure the e-signature validation feature for offer response forms: 

1. In Tools > Talent Gateway > Admin, select a Talent Gateway.Select Edit Talent Gateway. The Talent 
Gateway Details screen displays. 

On the Special Configurations page select Enable Candidate portal and Require password re-entry for 
document subsidiary form via Candidate Portal on the Special Configurations section of the Talent 
Gateway Details. 

 
Both of these settings must be checked. 

3. Uncheck the No account creation/no log-in if it is checked. If this option is checked, it disables the new 
settings.  

4. Click Save. 

These configurations now display a password re-entry dialog box on the bottom of any document subsidiary 
forms posted to the candidate portal 

 

Note: The “Require password re-entry for document subsidiary form via Candidate 
Portal” setting will be at the member level for GTG and for full gateways only; this 
settings will not appear for basic gateways. 

GQ Widget 
To configure the new question attribute for the e-signature validation password re-entry box on the TG: 

1. In WB: Tools > Gateway Questionnaires > Administer Sections/Pages icon [for selected Gateway 
Questionnaire], create a new widget or select an existing widget and click the Administer Widget icon. 
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2. Select Add/Edit Widget.Select Question on the Widget properties dialog box. 

 
 
4. Select the checkboxes for Obscure Response? and Password Re-entry. 
5. Click Save. 

You can also view the Widget properties. Select the View Widget Properties icon to display the View widget 
properties screen. 

The Password Re-entry setting displays Yes indicating the feature is enabled. 

• The password re-entry checkbox will be disabled if either a question has not been selected or the question 
selected is not of type Text.  When the password re-entry checkbox is checked, both “Question source” and 
“Question” drop-down lists become disabled.  The user may un-check the Password re-entry checkbox to 
re-enable both of these dropdown lists.  

• When the password re-entry attribute is checked, the question widget will be set as required and obscure 
response will be checked; neither option will be changeable as long as password re-entry is checked (when 
un-checked, both will be re-enabled). 

• If the password re-entry attribute is enabled for any question widget but the GQ general properties setting: 
“Require log-in for candidates who haven't logged in” is not selected, the GQ will not render. The user will 
receive an error message: [When using the password re-entry attribute, the Gateway Questionnaire must 
require login.] 

• Note: All rendering errors will give the location of the widget(s) with password re-entry enabled (per normal 
functionality). 

• Also: all existing question rules, such as duplicate questions within the same path disallowed, will remain as 
per normal functionality (and cover any question with the password re-entry attribute enabled). 



 

Talen t Gateways  – Communica tion  His to ry Widget 
This feature allows candidates to access their communication history on the Talent Gateway. The feature also 
lets 2xB users optionally save email and letter communications to the candidate record for candidates with email 
addresses in their Talent Gateway profiles.. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
For organizations that choose to store communication history, this feature allows candidates to access their 
history on the Talent Gateway. Communications for which history is available include all communications 
created in 2xB via a communications template (Send Communication and mail sent by Automation Manager or 
Rules Automation Manager).  

Candida tes  with  No Email Add res s  

If no email address is on file for the candidate, communications created via templates can be saved to the 
candidate’s record, rather than being sent. In those cases, you see the following message when using the Send 
Communication action: 

“There is no email address associated with this candidate. This message will only be saved for future 
access, if the template is configured to save history.” 

On the candidate’s Talent Record, Saved appears in the communication history grid, rather than the standard 
Sent.  

When a form is completed via a link included in the communication body and the candidate does not have an 
email on file, then the “Completed By” field for the form will displays: Communication-
archive@brassring.com. 

mailto:Communication-archive@brassring.com�
mailto:Communication-archive@brassring.com�
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Ad-hoc email and eLinks communications are not included for candidates without an email address. 

2xB User Experience 
Users sending communications will see a few changes. 

1. Select one or more candidate and clicks Send Communication. After selecting template and clicking Go, 
you arrive at the Send Communication popup. 

If at least one of the candidates has no email address on file, you are prompted in the Candidate and Merge 
information box: “There is no email address associated with this candidate. This message will only be saved 
for future access, if the template is configured to save history.”  
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2. Click Send. The following confirmation message appears: “The email template [template name] has been 

sent to the following candidate(s).” If configured, you also receive an email confirmation. 

If a form was sent to a candidate and completed, you will optionally be sent an email confirmation of the form’s 
completion.  

When you view the Talent Record for each candidate without an email address, the saved correspondence 
displays a Status of “Saved” (instead of usual ‘Sent’) on the communications history tab. 

Candidate Experience 
When the communications page fields have been configured in Workbench for the Landing logged-in page, 
candidates see the new communications history link, as shown in the following figure. 
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The candidate clicks the link to go to the new history page. 

 
 

How Do Clients Get this Feature? 
This feature is controlled by a new client setting and additional text customization options on the Talent Gateway 
in Workbench Self-Service. Please contact your CSC for more information about enabling this feature.  

Workbench Self-Service Certified Users 
Configuration in Workbench Self-Service includes the following: 

• Landing logged in text customization: 2 new fields 
Communications page link text 
Communications page summary text 

• Text Customization: new Communications History tab 

Landing  Logged  in  Configura tion  

Two new fields on the existing Landing logged in text customization page define the communications page link 
and description. 

Tools->Talent Gateways->Text Customization->Edit [selected TG]->Landing logged in tab 



   

 

 

Copyright Kenexa® 2011 Talent Gateways - Communication History Widget | 5 

 

 
• Communications page link text can be up to 100 characters, no HTML. The field is required; default text 

is Communications 
• Communications page summary text can be up to 3000 characters, and does support HTML. The field is 

required; default text is Access your email/communications history here. 

Communica tions  His to ry Tab  Configura tion  

A new tab on Talent Gateway text customization page defines the communications history page. 

Tools->Talent Gateways->Text Customization->Edit [selected TG]-> Communications History tab 
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• Check Enable Communication History page to enable the page for logged in candidates. 
• Page Title can be up to 100 characters, no HTML. The field is required; default text is Communications 

History 
• Instruction Text can be up to 3000 characters, and does support HTML. The field is required; default text is 

Your communications history is displayed below. 
• Days of History to Display defaults to 30 days. Leave it blank to display the full history. 

The communication history page inherits the look and feel of the Talent Gateway (background color, text color, 
font, point size, logo, etc.). A table displays the candidate’s communication in the following format. Columns 
wrap as needed to fit the page, and all are sortable. 

 
• Status – displays New for communications that have not been viewed via the page before, or Viewed for 

communications that have been viewed 
• Date Sent – displays in accordance with the your TG configuration 
• ReqID - Job Title – displays the ReqID and Job Title. If using Custom ReqID, that is displayed. 
• Subject – displays the communication subject. The text is a hyperlink that, when clicked, displays the full 

text of the message 
• From – displays the sender in lastname, firstname format. If system name rather than user name, then 

displays in format matching 2xB. 
• Type – displays the communication type, Email, Ad-hoc, or Letter 
• Delete – displays a Delete hyperlink. When clicked, candidate is prompted via a pop-up window: “Are you 

sure you want to delete this communication? Yes/No.”  

o For Yes, the communication is marked as Archived in the database and no longer displays on the 
screen. The candidate is presented with a confirmation message: “Message has been deleted.” 
Clicking OK button returns to the communication history screen.  

o For No, candidate is returned to the communication history screen. 

The results set will include all Send Communication, RAM and Automation Manager correspondence (all use 
the communication templates), Letters and Ad-hoc emails.  eLinks are not included. Note: Ad-hoc emails will 
only be available for candidates with an email address on file. 

Twenty lines of history will be shown per page, 



 

Talen t Gateways  (Bas ic) – Dis p lay Codes  fo r Open  J ob 
Reqs  Only 
This feature provides the option to display only Job Req codes associated with reqs in an Open status on Basic 
Talent Gateways for candidates to choose when applying. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Basic Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
Your organization can set up Basic Talent Gateways (BTG) so that candidates must choose a Job Req when 
applying through the BTG. Previously, when the Job Req codes display option for reqs was used on a BTG, all 
active codes displayed. “Active” codes include codes for Open reqs, as well as Approved, Cancelled, and On 
Hold reqs that may not be available for accepting applications, yet candidates could choose from them. This 
feature provides the option to display only Job Req codes associated with reqs in an Open status for candidates 
to choose when applying through the BTG. 

 

How Do Clients Get this Feature? 
This feature is controlled by a new Basic Talent Gateway option. Please contact your CSC or Certified 
Workbench User (Tier 5) for more information. 
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Workbench Self-Service Certified Users 
The new Setting on Basic Talent Gateways is called “Display only Open req codes for code display question.” 
When selected, and the “Choose when applying” section for “Job Req” is set to “Display all – Yes,” then the Job 
Req code list that displays on the Gateway display only reqs that are in a status of Open.  

1. Select Tools > Talent Gateways > Admin > Add new [Basic] Talent Gateway | Edit [selected Basic 
Gateway]. (This requires Tier 5 Workbench Self-Service certification.) The Talent Gateway details page 
appears. 

 
 

2. Verify that in the “Choose when applying” section, Job Req is set to display, and “Select all” is set to Yes. 
Change the settings if necessary so that the List to display is Codes only, Descriptions only, or Both 
codes and descriptions (but not "Don't show"). 

3. Check Display only Open req codes for code display question and click Save. 



 

Talen t Gateways  – Global GQ Selec tion  Requirement 
A setting, new for Global Talent Gateways (GTGs), will enforce the selection of a Gateway Questionnaire before 
posting to a GTG.  

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
A setting, previously available only at the individual Talent Gateway (TG) level, has been added for Global 
Talent Gateways. The setting “globally” enforces the selection of a Gateway Questionnaire (GQ) before 2xB 
users can post a req to a GTG for which it is set. This setting, checked or unchecked, applies to all member TGs 
of the GTG.  

If the setting “Do not allow posting without GQ selected” is checked at the GTG level:  

• All member TGs of the GTG will have the option checked and uneditable  

AND  

• User must select a GQ when posting a req via the Posting options or Open req screens. 

If the setting is not checked at the GTG level,  

• All member TGs of the GTG will have the option unchecked and uneditable 

AND  

• It is optional for the user to select a GQ when posting a req via the Posting options or Open req 
screens. 

Previously this setting was available only at the TG level, for TGs that were members of a GTG as well as for 
non-member TGs. This caused problems if some member TGs had the option set while others did not. 

For non-member TGs (TGs that are not a member of a GTG), the existing setting and functionality remain the 
same and continue to apply. 

2xB Us er Exp erience  

When the setting is on for a GTG, users who are required to select a GQ when posting will see an error 
message if they attempt to post without selecting the GQ: 

“You must select a Gateway Questionnaire for the following Talent Gateway(s) [gateway names] before you can 
post. Please select a Gateway Questionnaire and select OK.” 
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How Do Clients Get this Feature? 
This feature is controlled by a new GTG setting. Please contact your CSC or Certified Workbench User for more 
information. 

Workbench Self-Service Certified Users 
The new option Do not allow posting without GQ selected is located in the Special configurations section of 
the Global Talent Gateway details page in: 

Tools > Talent Gateways > Global > Global admin > Add new | Edit [selected GTG] 

Check the option to enforce the selection of a GQ when posting to the GTG. 
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Talen t Gateways  – J ob  Board  Pos ting  Dependency 
A new “posting dependency” option can disallow the removal of a job posting from a Talent Gateway while the 
job is still posted to an external job board. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Posting dependencies can be set up for a Talent Gateway (TG) to require posting to that TG for any req being 
posted to an external job board. A new option can also disallow the “unposting” of a req from the TG while it is 
still posted to the external job board. 

With the new option set for a TG, when a 2xB user tries to update the posting for a req by un-checking that TG 
(on the Edit posting options page) and clicking either Update all postings or Update newly 
selected/unselected postings only, 2xB will check if any job board postings are active for the req. If there are, 
the req is not removed and the user sees the following error message: 

“This requisition can be un-posted from this Talent Gateway, only when it is un-posted from <comma-
separated external job board list>.” 

If the user is removing the posting from both the TG and also the “Other posting options” (job boards), the action 
is allowed. 

 
This “un-post” dependency does not apply to “Prospective Media,” since that job board 
does not allow postings to be removed. 

How Do Clients Get this Feature? 
This feature is controlled by a new TG posting dependency option. Please contact your CSC for more 
information about enabling this feature.  



 

Talen t Gateways  – Pre-Filling  J ob  Specific  Ques tions  
A new setting allows your organization the option to pre-fill or not pre-fill job specific questions (JSQs) with prior 
responses. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Previously, JSQs were automatically filled with prior responses when they were available, so that candidates did 
not have to answer the same question when it was asked for more than one job they were applying to (or had 
previously applied to). However, in some cases questions are time-sensitive or context-sensitive, and previous 
responses are not appropriate for new jobs. Therefore, a new setting allows your organization the option to pre-
fill or not pre-fill job specific questions (JSQs) with prior responses. 

Candidate Experience 
When the setting is checked for a Talent Gateway, candidates will be asked to respond again to any JSQs they 
have already answered. 

 

How Do Clients Get this Feature? 
This feature is controlled by a new Talent Gateway Admin setting. Please contact your CSC or Certified 
Workbench User for more information about enabling this feature.  

Workbench Self-Service Certified Users 
Level 5 Workbench Self-Service Certification. 

A checkbox setting at the Talent Gateway (TG) level disables JSQ widget pre-filled responses: 

Disable JSQ widget only pre-filled responses 

To set: 
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1. Select Tools > Talent Gateways > Admin > Add new TG | Edit [selected TG] (TG Admin requires Level 5 
certification). 

2. In the Special configurations section of the Talent Gateway Details screen, check Disable JSQ widget only 
pre-filled responses. 

3. Click Save. 

If the checkbox is checked, the JSQ widget does not pre-fill the prior answers for questions that have already 
been answered by the candidate. The response/answer will be blank. 

 



 

Talen t Gateways  – Referring  Employee  Profile  Data  
This feature allows referring employees to save profile info so they do not have to re-key the data for each 
referral submission through an Employee Referral Gateway. 

 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – requires specific conditions / configuration for visibility. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – contact your CSC for implementation details. 

Feature Description 
Profile information can be saved so that referring employees do not have to re-key the data for each referral 
they submit through an Employee Referral Gateway. Profile data that was previously entered can be pre-filled 
during subsequent submissions. 

Pre-filling is disabled by default for Employee Referral Gateways, via the configurable Talent Gateway attribute 
“Disable GQ pre-filled responses.” If pre-filling is desired, TG administrators can now uncheck that attribute for 
referral gateways.  

 
Previously this attribute/setting was unavailable for TGs enabled as Referral TGs 
(those with “Enable referral Talent Gateway” checked). Instead, any pre-filling to 
Gateway Questionnaire widgets was automatically disallowed for a referral gateway. 
Now organizations can control whether pre-filling should be disabled or not. 

With pre-filling allowed, all the fields that do NOT have a Question Source of “Candidate Information fields” will 
pre-populate with the responses from the previous submission.  

 
This could pre-fill some unintended fields, such as “What is your relationship with the 
candidate?” 

Limitations and Known Issues 
This feature is specific to GQ workflows of Referral TGs; Referral TG workflows that don’t use GQs are out of 
scope. 

How Do Clients Get this Feature? 
This feature is controlled by a Talent Gateway attribute. Please contact your CSC or Certified Workbench User 
for more information. 

Workbench Self-Service Certified Users 
Tier 5 Certified users can administer Talent Gateways 

By default, referral TGs (those with the “Enable referral Talent Gateway” setting checked) also have the “Disable 
GQ pre-filled responses” setting checked. To allow profile data for referring employees to pre-populate your 
employee referral form, uncheck the Disable GQ pre-filled responses setting for your referral gateways in:  

Tools > Talent Gateways > Admin > Add new Talent Gateway | Edit [selected TG] 
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GQ Fie lds  tha t P re -Fill 

All Gateway Questionnaire fields that have a Questions Source NOT EQUAL to “Candidate Information fields” 
will pre-populate with the most recent response that the user provided in a previous submission. You can look at 
your Gateway Questionnaires to see question source information for referring employee fields: 
Tools > Gateway Questionnaires > Administer sections/pages [selected referral GQ]  
Gateway Questionnaire – List of sections – Example: Employee Details highlighted 
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Gateway Questionnaire – Administer widgets for Employee Details 

 
 
Gateway Questionnaire – Widget properties – Question Source is Candidate form 

 
Gateway Questionnaire – Showing page highlighted that collects referred candidate information 
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Gateway Questionnaire – Administer widgets for referred candidate information 

 
 
Gateway Questionnaire – Widget properties – Question source is Contact information fields 

 
GQ Widgets with a Question Source of “Contact Information fields” will NOT be pre-filled even if the Talent 
Gateway has enabled pre-filling (this setting unchecked). 
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Gateway Questionnaire – section highlighted to collect relationship data between employee and referred candidate 

 
Gateway Questionnaire – Administer widgets – widgets to collect relationship data between employee and referred candidate 
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Gateway Questionnaire – Widget properties – Question source is also the candidate form 

 
The widgets collecting relationship data between employee and referred candidate also have Question Source 
of a Candidate form, so these questions will also pre-populate with previous data. 



 

Talen t Record  – Saving  Attachments  Enhancement 
You can now more conveniently save an attachment from the Talent Record without having to replace the 
default file name that may have been assigned during the download operation. 

Product 
 

 2x BrassRing 
 New UI 
 Workbench Self-Service 
 Talent Gateways 

 Agency Manager 
 Data Insight Tool 
 SmartApproval 
 Other 

Visible Changes  No – contact your CSC for implementation details. 
 Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

 Automatic – see details below. 
 Specific conditions required – see details below. 
 Configuration required – see details below. 

Feature Description 
When you save any attachment using the following new methods, you can save the Document Generator PDF 
locally with the identical name to what it has when stored in the Talent Record.  

The initial workflow is different for the Classic and New Talent Records, but the final steps are identical and 
follow the same business rules. 

Talen t Record  - Cla s s ic  UI 

On the “Attachments” tab, click the Save icon in the new column named “Save.” This launches the “File 
Download” window. 
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Talen t Record  – New UI 

In the Action Log, right-click anywhere in the attachment row. A new "Save Attachment" context menu item will 
appear.  Click Save Attachment to open the File Download window pop-up. 

 

File  Download  (with  2xB Clas s ic  o r New UI) 

1. In the File Download window, the document name is pre-populated in the Name field. Click Save to launch 
the “Save as” dialog box. You can navigate in your local environment to the desired folder. 

2. Click Save again to save the file. 

 
If the file name is longer than 40 characters, the File Download and Save as dialog 
boxes display the partial name with ellipses characters substituted for actual 
characters at the beginning of the file name.  

 
However, you can save the file locally with the full file name.  

Saving  b y Clicking  the  File  Name  Link 

This method of saving a local copy continues to work as before:  

1. Click the attachment link for the attachment (in the File column on the Attachments tab of the classic Talent 
Record, or in the Details column of the Action Log of the New UI). When clicked, the attachment opens in a 
browser window with a default file name shown in the top browser bar, for example, UserFile[1].pdf.  
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2. Select File > Save as on the browser, the file name also pre-populates with the name, for example, 
UserField[1].pdf. 

 
 

3. If the default name is different from the 2xB name, manually change the file name if desired.  
4. Click Save. 

Saving  a  File  Opened  fro m the  File  Download  Pop-up  

When you either click the Save icon (classic Talent Record) or right-click in the row for the attachment (new 
Talent Record) and click Save Attachment, the File Download dialog box pops up. You can elect to open the 
file at this point: 

 
As soon as you click Open, the program passes at least partial control to Adobe. The Document Generator file 
name is retained, except that Adobe substitutes the ‘%20’ characters for spaces in the Document Generator file 
name. 

If you then attempt to save the open file: 

• The Save icon along the top task bar is disabled. 
• You can click File > Save As to save the file. 
• Adobe might display the temp directory as the default ‘Save As’ location, OR it might display the last folder 

to which you saved a PDF file. 

How Do Clients Get this Feature? 
This feature is available automatically without configuration. 



 

 

XML Candida te  Imports  – Candida te  S tacking  Fie ld  
2xB now supports both Resumekey and Candidate Stacking Field value as unique identifiers for candidate 
import with update directive. 

 

Product 
 

þ 2x BrassRing 
¨ New UI 
¨ Workbench Self-Service 
¨ Talent Gateways 

¨ Agency Manager 
¨ Data Insight Tool 
¨ SmartApproval 
þ XML Imports 

Visible Changes þ No – requires specific conditions / configuration for visibility. 
¨ Yes – details in Visible Changes document sent for each release build.  

How do I get this 
feature? 
 

þ Automatic – see details below. 
¨ Specific conditions required – see details below. 
¨ Configuration required – contact your CSC for implementation details. 

Feature Description 
2xB now supports both Resumekey and Candidate Stacking Field value as unique identifiers for candidate 
import while updating candidate information through the ‘XML candidate import’ program.  

A candidate record in 2xB is usually identified uniquely using the resume key. This key is unique for all 
candidate records, and is usually used to identify the candidate while importing and updating existing candidates 
with third party integration tools.  

Now Candidate Stacking Field (CSF) value can be used as the unique identifier for the candidate while 
updating existing candidates with the ‘XML candidate import’ program. CSF can be used only when the 
program is updating the existing candidates and not for creating/importing new candidates.  

The program will pick the CSF as unique identifier if the UID attribute is present for the CandidateStackingField 
node in UserArea, and if its value is “yes” in the XML code. (UID is a new optional attribute.)  

• If UID attribute is “yes” and the candidate record is not found based on the CSF, then the candidate record 
is updated based on the existing stacking field logic. 

• If UID attribute is “no”, then the candidate record is also updated based on the existing stacking field logic. 

Error situations: 

• If UID attribute is “yes” and ID is specified in <CandidateRecordInfo> node, then the system throws an error. 
Only one of these is allowed. In other words, you cannot specify both CandidateId and 
CandidateStackingField as unique identifiers for update input XML. 

• In the InputXML, if a CandidateStackingField value was already stacked with another value, then the system 
throws an error. This is the same as current behavior when a ResumeKey value was stacked. 

• If the UID attribute present in case of INSERT, the system throws an error. 

If  

• All the other rules associated for candidate import will be unaltered. 
• The CSF will be used as the unique identifier even when it is encrypted 
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Sample  XML Node  
<UserArea> 

  <BRpartner:CandidateStackingField UID = “yes”>0126557</BRpartner:CandidateStackingField> 

  <BRpartner:codes> 

   <BRpartner:code>PSHRMS</BRpartner:code> 

   <BRpartner:code>Import-Internal</BRpartner:code> 

  </BRpartner:codes> 

  <BRpartner:candidatetype>Internal</BRpartner:candidatetype> 

  <BRpartner:coverletter/> 

  <BRpartner:resume/> 

 </UserArea> 

Limitations and Known Issues 
CSF as unique ID is applicable for candidate import “Update” and “UpdateSkipProfile” actions only. 

How Do Clients Get this Feature? 
This feature is available automatically for XML imports. There are no Workbench settings. 
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